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CHAPTER 1

How TIBCO EBX® works

This chapter contains the following topics:

1. Product overview

2. EBX® architecture

1.1 Product overview

Master Data Management (MDM) is a way to model, manage and ultimately govern shared data.
When data needs to be shared by various IT systems, as well as different business teams, having a
single governed version of master data is crucial.

With EBX®, business and IT users can collaborate on a single, unified solution in order to design
data models and manage master data content.

EBX® is an MDM software that allows modeling any type of master data and implementing
governance using the rich features included, such as collaborative workflows, data authoring,
hierarchy management, version control, and role-based security.

An MDM project using EBX® starts with the creation of a data model. This is where tables, fields,
links and business rules related to the master data are defined. Examples of modeled data include
product catalogs, financial hierarchies, lists of suppliers or simple reference tables.

The data model can then be published to make it available to datasets, which store the actual master
data based on the structure defined in the data model. Datasets are organized and contained within
dataspaces, containers that isolate updates from one another. Dataspaces allow working on parallel
versions of data without the modifications impacting other versions.

Workflows are an invaluable feature for performing controlled change management or data approval.
They provide the ability to model a step-by-step process involving multiple users, both human and
automated.

Workflow models detail the tasks to be performed, as well as the parties associated with the tasks. Once
a workflow model is published, it can be executed as data workflows. Data workflows can notify users
of relevant events and outstanding work in a collaborative context.
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Data services help integrate EBX® with third-party systems (middleware), by allowing external
systems to access data in the repository, or to manage dataspaces and workflows through web services.

-

Repaository

Data Waorkflow

"Vodel (=
Model Publish ]
Users via
Web User Interface

Data I Data Set Data Space

al
Maodel Publish
) Systems
Child <:| via DataServices
Data Set | bsta Space

See also

Data modeling [p 28]
Datasets [p 30]

Dataspaces [p 32]
Workflow modeling [p 33]

Data workflows [p 34]

Data services [p 35]
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1.2 EBX® architecture

The following diagram illustrates the EBX® architecture.

User-friendly web tool with
automatic GUI generation

Rich data models
based on XML Schema

Data configuration and
validation, lifecycle and
permissions management

Integration with 3" party
systems through data
services and import &
export services

Data Integration

Custom

Applications RDBMS Data Warehouse ERP/CRM
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CHAPTER 2

Using the user interface

This chapter contains the following topics:
1. Overview

Advanced perspective

Perspectives

User pane
User interface features

Where to find EBX® help

O e

2.1 Overview

The general layout of TIBCO EBX® workspaces is entirely customizable by a perspective
administrator.

If several customized perspectives have been created, the tiles icon 'Select perspective' allows the user
to switch between available perspectives.

The advanced perspective is accessible by default.

See also UI administration [p 629]

2.2 Advanced perspective

By default, the EBX® advanced perspective is available to all users, but its access can be restricted
to selected profiles. The view is separated into several general areas, referred to as the following in
the documentation:

Note

The advanced perspective is still accessible to users through explicit selection (for
example through a Web component). Unlike other perspectives, it can only be "hidden"
in the user interface so that users cannot apply it themselves.

+ Header: Displays the avatar of the user currently logged in and the perspective selector. Clicking
on the user's avatar gives access to the user pane.

+ Menu bar: The functional categories accessible to the current user.
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» Navigation pane: Displays context-dependent navigation options. For example: selecting a table
in a dataset, or a work item in a workflow.

«  Workspace: Main context-dependent work area of the interface. For example, the table selected
in the navigation pane is displayed in the workspace, or the current work item is executed in the
workspace.

The following functional areas are displayed according to the permissions of the current user: Data,
Dataspaces, Modeling, Data Workflow, Data Services, and Administration.

| Menu bar | [Header | ?

<, Current section | | Context-sensitive help |

Workspace

Navigation pane

2.3 Perspectives

The EBX® perspectives are highly configurable views with a target audience. Perspectives offer a
simplified user interface to business users and can be assigned to one or more profiles. This view is
split into several general areas, referred to as the following in the documentation:

» Header: Displays the avatar of the user currently logged in and the perspective selector (when
more than one perspective is available). Clicking on the user's avatar gives access to the user pane.

» Navigation pane: Displays the hierarchical menu as configured by the perspective administrator.
It can be expanded or collapsed to access relevant entities and services related to the user's activity.

+ Workspace: Main context-dependent work area of the interface.

Perspectives are configured by authorized users. For more information on how to configure a
perspective, see perspective administration [p 630].
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Example of a hierarchical menu:

Restricted access 4 Reference documentation ?
Governance + Actions =
1-100 of 1,006 ~ T View v b 3
all  Dashboard

[5 Information governance

& Business glossary
Workflow

& & Inbox
«d Launcher

[l Supervision

Reference data

¥ Reference documentation

Perspective modes
It’s possible now to choose between two modes of perspective.

According to the mode chosen by the user, the last visited perspective or the favorite one will be
applied at connection.

Last used perspective:
This option allows the user to get the last selected perspective and it will be applied in the next log in.

If the user chooses this mode, the stars next to the perspective name will disappear.

Public access
?

Restricted access

¥ Advanced perspective

v Last used perspective Automatic selection  »

Fawvorite perspective
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Favorite perspectives:

When more than one perspective is available to a user, it is possible to define one as their favorite
perspective so that, when logging in, this perspective will be applied by default. To do so, an icon is
available in the perspective selector next to each perspective:

A full star indicates the favorite perspective. A click on it will remove the favorite perspective.

« An empty star indicates that the associated perspective is not the favorite one. A click on it will
set this perspective as the favorite one.

Public access
Restricted access *
v Advanced perspective w¥

Last used perspective Automatic selection  »

v Favorite perspective

See also Recommended perspectives [p 642]

2.4 User pane

General EBX® features are grouped in the user pane. It can be accessed by clicking on the avatar (or
user's initials) in the upper right corner of any page.

The user pane is then displayed with the user avatar and gives access to the profile configuration
(according to the user's rights), language selection, density selection and online documentation.

Attention
The logout button is located on the user pane.

Avatar

An avatar can be defined for each user. The avatar consists in a picture, defined using a URL path;
or in two letters (the user's initials by default). The background color is set automatically and cannot
be modified. Regarding the image that will be used, it has to be a square format but there is no size
limitation.

Note

Avatars appear in the user pane, history and workflow interfaces.

1

The feature is also available through the Java method uiComponentwriter.adduserAvatar™.

The avatar layout can be customized in the 'Ergonomics and layout' section of the 'Administration’
area. It is possible to choose between the display of the avatar only, user name only, or to display both.
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Density

Users can choose their display density mode between 'Compact’ and 'Comfortable'. The display mode
can be modified from the user pane.

2.5 User interface features

Resetting the navigation pane width

After having resized the width of the navigation pane, you can restore it to the default width by
hovering over the border and double-clicking.

D-5593 - Book store ?

Book store -

Actions ~

Titles
Publishers
Authors
Royalties
<+
Contracts

2.6 Where to find EBX® help

In addition to the full standalone product documentation accessible via the user pane [p 24], help is
accessible in various forms within the interface.

Context-sensitive help

When browsing any workspace in EBX®, context-specific help is available by clicking on the question
mark located to the right side of the second header. The corresponding chapter from the product
documentation will be displayed.
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Contextual help on elements

When you hover over an element for which contextual help has been defined, a question mark appears.
Clicking on the question mark opens a panel with information on the element.

Titles (ﬂ}3

Titleﬁs 4
Publi
Book titles
Authi
Table
Royal
History Profile: ebx-allBranches
Contr Database table name: EBX_HG_TITLES
Information Display is limited to 200 columns
Data path froot/Titles

When a permalink to the element is available, a link button appears in the upper right corner of the
panel.

Permalink to Titles
hitp:/localhost:8080/ebx/?xpath=%2Froot%2 GF 4%

Close
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CHAPTER 3

Glossary

This chapter contains the following topics:
1. Governance

Data modeling

Datasets

Data management life cycle

History
Workflow modeling

Data workflows

Data services

£ LN e WD

Cross-domain

3.1 Governance

repository
A back-end storage entity containing all the data managed by TIBCO EBX®. The repository is
organized into dataspaces.

See also dataspace [p 32].

profile

The generic term for a user or a role. Profiles are used in data workflows and for defining permission
rules.

See also user [p 271, role [p 28].
Related Java API Profile™.

user

An entity created in the repository in order for physical users or external systems to authenticate and
access EBX®. Users may be assigned roles and have other account information associated with them.

See also user and roles directory [p 28], profile [p 271.

Related concept User and roles directory [p 661].
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1

Related Java API userReference™.

role

A user classification, used for permission rules and data workflows, which can be assigned to users.
Each user may belong to multiple roles.

Whenever a role profile is specified in EBX®, the behavior resulting from that designation is applied
to all users that are members of that role. For example, in a workflow model, a role may be specified
when defining to whom work items are offered. As a result, all users belonging to that role can receive
the same work item offer.

See also user and roles directory [p 28], profile [p 271.

Related concept User and roles directory [p 661].
Related Java API Role™.

administrator

A predefined role that has access to the technical administration and configuration of EBX®.

user and roles directory

A directory defining the methods available for authentication when accessing the repository, all
available roles, and the users authorized to access the repository with their role assignments.

See also user [p 271, role [p 28].

Related concept User and roles directory [p 661].

1

Related Java API birectory™, DirectoryHandler™.

user session

A repository access context that is associated with a user after being authenticated against the user
and roles directory.

Related concept User and roles directory [p 661].

Related Java API session™.

3.2 Data modeling

Main documentation section Data models [p 38]

data model

A structural definition of the data to be managed in the EBX® repository. A data model includes
detailed descriptions of all included data, in terms of organization, data types, and semantic
relationships. The purpose of data models is to define the structure and characteristics of datasets,
which are instances of data models that contain the data being managed by the repository.

See also dataset [p 30].

Related concept Data models [p 38].

TIBCO EBX® Product Documentation 6.2.0 28



Documentation > User Guide > Introduction > Glossary

field

A data model element that is defined with a name and a simple datatype. A field can be included in the
data model directly or as a column of a table. In EBX®), fields can be assigned basic constraints, such
as length and size, as well as more complex validation rules involving computations. Automated value
assignment using field inheritance or computations based on other data can also be defined for fields.
Aggregated lists can be created by setting the cardinality of a field to allow multiple values in the
same record. Fields can be arranged into groups to facilitate structural organization in the data model.

By default, fields are denoted by the icon =.

See also record [p 30], group [p 29], table (in data model) [p 29], validation rule [p 30],
inheritance [p 31].

Related concepts Structure elements properties [p 55], Controls on data fields [p 69].

Related Java API schemaNode™.

The former name (prior to version 5) of "field" was "attribute".

primary key
A field or a composition of multiple fields used to uniquely identify the records in a table.

Primary keys are denoted by the icon &=,

Related concept Tables definition [p 853].

foreign key

A field or a composition of multiple fields in one table whose field values correspond to the primary
keys of another table. Foreign keys are used to reference records in one table from another table.

Foreign keys are denoted by the icon ==,

See also primary key [p 29].
Related concept Foreign key [p 859].

table (in data model)

A data model element that is composed of fields and/or groups of fields. Every table must define at
least one field to act as the unique identifier, or primary key, of records. A table in a data model can
be used to create a reusable type based on the table's structure, which can then be used to create other
elements of the same structure in the data model.

Tables are represented by the icon :=:]
See also record [p 301, primary key [p 29], reusable type [p 30].

group

A classification entity used to facilitate the organization of a data model. A group can be used to
collect fields, other groups, and tables. If a group contains tables, the group cannot be included within
another table, as the constraint that tables cannot be nested must be respected. A group can be used to
create a reusable type based on the group's structure, which can then be used to create other elements
of the same structure in the data model.

Groups are represented by the icon [,
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See also reusable type [p 30].
Related Java API schemaNode™.

reusable type

A shared simple or complex type definition that can be used to define other elements in the data model.

validation rule

An acceptance criterion defined on a field or a table. Data is considered invalid if it does not comply
with all imposed validation rules.

The former name (prior to version 5) of "validation rule" was "constraint".

data model assistant (DMA)

The EBX® user interface includes a tool that aids the implementation of data models. It allows
defining the structure of data models, creating and editing elements, as well as configuring and
publishing data models.

See also Data models [p 38].

3.3 Datasets

Main documentation section Datasets [p 116]

record

A set of field values in a table, uniquely identified by a primary key. A record is a row in the table.
Each record follows the data structure defined in the data model. The data model drives the data types
and cardinality of the fields found in records.

See also table (in dataset) [p 301, primary key [p 29].

The former name (prior to version 5) of "record" was "occurrence".

table (in dataset)

A set of records (rows) of the same structure containing data. Each record is uniquely identified by
its primary key.

Tables are represented by the icon .
See also record [p 30], primary key [p 29].

dataset

A data-containing instance of a data model. The structure and behavior of a dataset are based upon
the definitions provided by the data model that it is implementing. Depending on its data model, a
dataset contains data in the form of tables, groups, and fields.

Datasets are represented by the icon .

See also table (in dataset) [p 301, field [p 29], group [p 291, views [p 311.

Related concept Datasets [p 116].

The former name (prior to version 5) of "dataset" was "adaptation instance".
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inheritance

A mechanism by which data can be acquired by default by one entity from another entity. In EBX®,
there are two types of inheritance: dataset inheritance and field inheritance.

When enabled, dataset inheritance allows a child dataset to acquire default data values from its parent
dataset. This feature can be useful when designing a data model where data declared in a parent scope
will be used with the same value by default in nested child scopes. Values that are inherited from the
parent can be overridden by the child. By default, dataset inheritance is disabled. It can be enabled
during the data model definition.

Inheritance from the parent dataset is represented by the icon “a.

Field inheritance is defined in the data model to automatically fetch a field value from a record in
another table.

Inherited fields are represented by the icon .

Related concept Inheritance and value resolution [p 470].

views

A customizable display configuration that may be applied to viewing tables. A view can be defined
for a given user or role, in order to specify whether records are displayed in a tabular, hierarchical or
tile format, as well as to set record filtering criteria.

The hierarchical view type offers a tree-based representation of the data in a table. Nodes in the tree can
represent either field values or records. A hierarchical view can be useful for showing the relationships
between the model data. When creating a view that uses the hierarchical format, dimensions can
be selected to determine the structural representation of data. In a hierarchical view, it is possible
to navigate through recursive relationships, as well as between multiple tables using foreign key
relationships.

See also

Views [p 127]

Hierarchies [p 128]

recommended view

A recommended view can be defined by the dataset owner for each target profile. When a user logs
in with no view specified, their recommended view (if any) is applied. Otherwise, the default view
is applied.

The "Manage recommended views' action allows defining assignment rules for recommended views
depending on users and roles.

Related concept Recommended views [p 137].

favorite view

When displaying a table, the user can choose to define the current as their favorite view through the
"View' menu toolbar.

Once it has been set as the favorite, the view will be automatically applied each time this user accesses
the table.

Related concept 'View' menu toolbar [p 138].
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3.4 Data management life cycle

Main documentation section Dataspaces [p 98]

dataspace

A container entity composed of datasets. It is used to isolate different versions of datasets or to organize
them.

Child dataspaces may be created based on a given parent dataspace, initialized with the state of the
parent. Datasets can then be modified in the child dataspaces in isolation from their parent dataspace
as well as each other. The child dataspaces can later be merged back into their parent dataspace or
compared against other dataspaces.

See also inheritance [p 31], repository [p 27], dataspace merge [p 32].

Related concept Dataspaces [p 98].

The former name (prior to version 5) of "dataspace" was "branch" or "snapshot".

reference dataspace

The root ancestor dataspace of all dataspaces in the EBX® repository. As every dataspace merge must
consist of a child merging into its parent, the reference dataspace is never eligible to be merged into
another dataspace.

See also dataspace [p 321, dataspace merge [p 32], repository [p 27].

dataspace merge

The integration of the changes made in a child dataspace since its creation into its parent dataspace.
The child dataspace is closed after the merge has completed successfully. To perform a merge, all the
differences identified between the source dataspace and the target dataspace must be reviewed, and
conflicts must be resolved. For example, if an element has been modified in both the parent and child
dataspace since the creation of the child dataspace, the conflict must be resolved manually by deciding
which version of the element should be kept as the result of the merge.

Related concept Merge [p 106].

snapshot

A static copy of a dataspace that captures its state and all of its content at a given point in time for
reference purposes. A snapshot may be viewed, exported, and compared to other dataspaces, but it
can never be modified directly.

Snapshots are represented by the icon 8,
Related concept Snapshot [p 111]

The former name (prior to version 5) of "snapshot" was "version" or "home".

3.5 History

Main documentation section History [p 451]
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historization

A mechanism that can be enabled at the table level to track modifications in the repository. Two history
views are available when historization is activated: table history view and transaction history view.
In all history views, most standard features for tables, such as export, comparison, and filtering, are
available.

Activation of historization requires the configuration of a history profile. The historization of tables
is not enabled by default.

See also table history view [p 33], transaction history view [p 33], history profile [p 33].

history profile

A set of preferences that specify which dataspaces should have their modifications recorded in the
table history, and whether transactions should fail if historization is unavailable.

See also history profile [p 33].

table history view

A view containing a trace of all modifications that are made in a given table, including record creations,
updates, and deletions. Each entry includes transactional information, such as a timestamp and the
user performing the action, as well as the data at the conclusion of the transaction. This information
can also be consulted at a record or dataset level.

Related technical reference History [p 451].

transaction history view

A view displaying the technical and authentication data of transactions, either globally at the repository
level, or at the dataspace level. As a single transaction can perform multiple actions and affect multiple
tables in one or more datasets, this view shows all the modifications that have occurred across the
given scope for each transaction.

Related technical reference History [p 451].

3.6 Workflow modeling

Main documentation section Workflow models [p 184]

workflow model

A procedural definition of operations to be performed on data. A workflow model describes the
complete path that the data must follow in order to be processed, including its states and associated
actions to be taken by human users and automated scripts.

Related concept Workflow models [p 184].

The former name (prior to version 5) of "workflow model" was "workflow definition".

Workflow models are represented by the icon T3,
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script task

A data workflow task performed by an automated process, with no human intervention. Common
script tasks include dataspace creation, dataspace merges, and snapshot creation.

Script tasks are represented by the icon .

See also workflow model [p 33].

user task

A data workflow task that is made up of one or more work items performed concurrently by human
users. User task work items are offered or assigned to users, depending on the workflow model. The
progression of a data workflow beyond a user task depends on the satisfaction of the task termination
criteria defined in the workflow model.

User tasks are represented by the icon &,

See also workflow model [p 33].

workflow condition

A decision step in a data workflow. A data workflow condition describes the criteria used to decide
which step will be executed next.

Workflow conditions are represented by the icon Q.

sub-workflow invocation

A step in a data workflow that pauses the current data workflow and launches one or more other data
workflows. If multiple sub-workflows are invoked by the same sub-workflow invocation step, they
will be executed concurrently, in parallel.

wait task

A step in a data workflow that pauses the current workflow and waits for a specific event. When the
event is received, the workflow is resumed and automatically goes to the next step.

data context

A set of data that may be shared between steps throughout a data workflow to ensure continuity
between steps.

3.7 Data workflows
Main documentation section Data workflows [p 214]

workflow publication

An instance of a workflow model that has been made available for execution to users with the
appropriate permissions.

The former name (prior to version 5) of "workflow publication" was "workflow".
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data workflow

An executed instance of a workflow model, which runs the data processing steps that are defined in
the model, including user tasks, script tasks, and conditions.

See also workflow model [p 33].

Related concept Data workflows [p 214].

The former name (prior to version 5) of "data workflow" was "workflow instance".

work list

A list of all published data workflows that the current user has the permissions to view. Users with
the permissions to launch data workflows do so from their "Work List'. All outstanding work items
requiring action from the user appear under their published workflows in the work list. Additionally,
if the user is the administrator of data workflows, they are able to view the state of execution of those
data workflows in their "Work List', and may intervene if necessary.

work item

An action that must be performed by a human user as a part of a user task.

Allocated work items are represented by the icon &,

See also user task [p 34].

token

Tokens are used during data workflow management, and are visible to repository administrators.

3.8 Data services

Main documentation section Data services [p 234]

data service

EBX® shares master data according to the Service-oriented architecture (SOA) by using XML web
services. Since all data services are generated directly from models or built-in services they can be
used to access part of the features available from the user interface.

Data services offer:

+ a WSDL model-driven and built-in generator to build a communication interface. It can be
produced through the user interface or the HTTP(S) connector for a client application. XML
messages are communicated to the EBX® entry point.

» a SOAP connector or entry point component for SOAP messages which allows external systems
interacting with the EBX® repository. This connector responds to requests coming from the
WSDL produced by EBX®. This component accepts all SOAP XML messages corresponding
to the EBX® WSDL generator.

+ A RESTful connector, or entry point for the select operations, allows external systems
interrogating the EBX® repository. After authenticating, it accepts the request defined in the URL
and executes it according to the permissions of the authenticated user.
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lineage

A mechanism by which access rights profiles are implemented for data services. Access rights profiles
are then used to access data via WSDL interfaces.

Related concept: Generating a WSDL for lineage [p 239].

3.9 Cross-domain

node

A node is an element of a tree view or a graph. In EBX®, 'Node' can carry several meanings depending
on the context of use:

In the workflow model [p 33] context, a node is a workflow step or condition.

In the data model [p 28] context, a node is a group, a table or a field.
In the hierarchy [p 31] context, a node represents a value of a dimension.
In an adaptation tree [p 31], a node is a dataset.

In a dataset [p 30], a node is the node of the data model evaluated in the context of the dataset
or the record.

TIBCO EBX® Product Documentation 6.2.0 36



Documentation > User Guide

Data models

TIBCO EBX® Product Documentation 6.2.0 37



Documentation > User Guide > Data models > Introduction to data models

CHAPTER 4

Introduction to data models

This chapter contains the following topics:
1. Overview

2. Using the Data Models area user interface

4.1 Overview

What is a data model?

The first step towards managing data in TIBCO EBX® is to develop a data model. The purpose of
a data model is to provide the detailed structural definition of the data that will be managed in the
repository, in terms of organization, data types, and semantic relationships.

In order to implement a data model in the repository, you will first create a new data model, then
define the details of the structure of its component table, field, and group elements, as well as their
behavior and properties. When you have completed the entry or import of your data model structure in
the repository, you will publish it to make it available for use by datasets. Once you have a publication
of your data model, you and other users can create datasets based upon it to contain the data that is
managed by the EBX® repository.

Basic concepts used in data modeling
A basic understanding of the following terms is necessary to proceed with the creation of data models:
« field [p29]
» primary key [p29]
» foreign key [p 29]
« table (in data model) [p 29]
« group [p29]
« reusable type [p 30]

« validation rule [p 30]
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4.2 Using the Data Models area user interface

Navigating within the Data Model Assistant

Data models can be created, edited or imported, and published in the Data Models area of the user
interface. The EBX® data model assistant (DMA) facilitates the development of data models.

Note

This area is available only to authorized users in the 'Advanced perspective'.

80 &€

Data models : = Actions menu | ?

Book Store  ~ _ﬁ Data model selector |

- Configuration

+ Data structure
= [ Books publications
v BEH Titles
v B Publishers Workspace
v B Authors
» B Royaltes
v EH Contracts

Simple data types

Navigation pane
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The navigation pane is organized into the following sections:

Configuration

The technical configuration of the data model.

Global properties

Defines the global properties of the data model.

Included data models

Defines the data models included in the current model. All
types defined in included data models can be reused in the
current model.

Component library

Defines the Java components available in the model. These
provide programmatic features that will be available for the
model, such as programmatic constraints, functions, and Ul
beans.

Add-ons

Specifies which add-ons are used by the data model.
These add-ons will have the capacity to enrich the current
data model after the publication by adding properties and
constraints to the elements of the data model.

Data structure

The structure of the data model. Defines the relationship
between the elements of the data model and provides access
to the definition of each element.

Simple data types

Simple reusable types defined in the current data model.

Complex data types

Complex reusable types defined in the current data model.

Included simple data types

Simple reusable types defined in an included external data
model.

Included complex data types

Complex reusable types defined in an included external data
model.

Extensions

Extensions available in the current data model.

Toolbars

The toolbars available to use in the data model.

User services

Declares the user services using the API available before
release 5.8.0. From release 5.8.0, it is advised to use the
new UserService API (these services are directly registered
through the Java API, hence no declaration is required for
them in the data model assistant)..
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Entity mappings Specifies entity names for the tables in the data model.
These names are used as aliases in SQL requests or as
suffixes in WSDL operations. This allows to refer to a table
in SQL requests and data service operations using a unique
name instead of its path.

Replications This table defines the replication units of the data model. A
replication unit allows the replication of a source table in
the relational database, so that external systems can access
this data by means of plain SQL requests and views.

Ajax components Defines the available Ajax components in the model.

Java bindings The bindings specify what Java types have to be generated
from the model.

See also

Implementing the data model structure [p 49]

Configuring the data model [p 45]

Reusable types [p 51]
Data model extensions [p 77]

Data model element icons
= field p29]
€= primary key [p 29]

= foreign key [p 29]
B2 table [p 29]

O3 group [p 291

Related concepts

Dataspaces [p 98]
Datasets [p 116]
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CHAPTER B

Creating a data model

This chapter contains the following topics:

1. Creating a new data model

5.1 Creating a new data model

To create a new data model, click the Create button in the pop-up, and follow through the wizard.
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CHAPTER O

Configuring the data model

This chapter contains the following topics:

1.

Information associated with a data model

2. Permissions

3. Data model properties

4,

5. Add-ons used by the data model

Included data models

6.1 Information associated with a data model

To view and edit the owner and documentation of your data model, select 'Tnformation' from the data
model 'Actions' [p39] menu for your data model in the navigation pane.

Note

This area is available only to authorized users in the 'Advanced perspective'.

Unique name The unique name of the data model. This name cannot be

modified once the data model has been created.

Owner Specifies the data model owner, who will have permission to

edit the data model's information and define its permissions.

Localized documentation Localized labels and descriptions for the data model.

6.2 Permissions

To define the user permissions on your data model, select 'Permissions' from the data model 'Actions'
[p 391 menu for your data model in the navigation pane.

The configuration of the permissions of a data model are identical to the options for the permissions
of a dataset, as explained in Permissions [p 155].
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6.3 Data model properties

In the navigation pane, under Configuration > Data model properties, you can access the following

technical properties:

Module name

Defines the module that contains the resources that will be
used by this data model. This is also the target module used
by the data model publication if publishing to a module.

Module path

Physical location of the module on the server's file system.

Sources location

The source path used when configuring Java components
in the 'Component library'. If this path is relative, it will be
resolved using the 'Module path' as the base path.

Publication mode

Whether to publish the data model as an XML Schema
Document within a module or as a publication completely
embedded in the TIBCO EBX® repository. Embedded data
models offer additional functionality such as versioning and
rollback of publications.

See Publication modes [p 93] for more information.

Model path in module: Defines the target file for the data
model generation. It must start with '/'.

Dataset inheritance

Specifies whether dataset inheritance is enabled for this data
model. Dataset inheritance is disabled by default.

See Dataset inheritance [p 159] for more information.

Documentation

Documentation of the data model defined by a Java class.
This Java class can programmatically specify labels and
descriptions for the elements of the data model. The labels
and descriptions defined in this Java class are displayed in
associated datasets in preference to the ones defined locally
on an element.

See Dynamic labels and descriptions [p 896] for more
information.

Special extensions

Access permissions defined by programmatic rules in a Java
class.

Disable auto-increment checks

Specifies whether to disable if the check of an auto-
incremented field value in associated datasets regarding to
the "max value" found in the table being updated.

See Auto-incremented values [p 893] for more information.
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Enable user services (old API) Specifies if user services using the API available before
release 5.8.0 can be declared. If 'No', the section
'Configuration > User services' is not displayed (except if
at least service has been already declared in this section).
From release 5.8.0, it is advised to use the new UserService
Java API (these services are directly registered through the
Java API, hence no declaration is required in the data model
assistant).

APT

See UserServiceDeclaration™ for more information.

6.4 Included data models

You can use data types in the current model that are defined in another data model by adding an entry
for the other data model in the table under Configuration > Included data models.

When you access the record of an included model in this table, you will find technical information
about the model under the Information tab. As an included data model could eventually have
validation errors, for example, due to deleted Java resources, this view will provide information
regarding those issues.

It is only possible to include data models that have no validation errors and have been defined and
published as an embedded data model or packaged in a module.

The names of data types must be unique across both locally defined and included type definitions.
That is, included data types must not have names that coincide with those of data types defined in the
current data model or other included data models.

See also Including external data models [p 851]

6.5 Add-ons used by the data model

On any data model, it is possible to specify the add-ons used by the current data model. These add-
ons will have the capacity to enrich the current data model after the publication by adding properties
and constraints to the data model elements.

To define an add-on to be used by the data model through the user interface, create a new record in
the 'Add-ons' table under the data model configuration in the navigation pane. A record of this table
defines the following properties:

Name Add-on public name.
Version Add-on version.
Activated Indicates if the add-on is activated. The add-on must be

activated in order to be used.
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CHAPTER 7

Implementing the data model
structure

To work with the structural definition of your data model, select the data model you are working with
in the navigation pane.

You can then access the structure of your data model in the navigation pane under 'Data structure', to
define the structure of fields, groups, and tables.

This chapter contains the following topics:

1. Common actions and properties

2. Reusable types
3. Data model element creation details

4. Modifying existing elements

7.1 Common actions and properties

Adding elements to the data model

The following elements are available to describe the structure of your data model:

fields

groups
tables
primary keys
foreign keys

associations

Add a new element relative to any existing element in the data structure by clicking the down arrow ™
to the right of the existing entry, and selecting an element creation option from the menu. Depending
on whether the existing element is a field, group, or table, you have the choice of creating the new
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element as a child of the existing element, or before or after the existing element at the same level.
You can then follow the element creation wizard to create the new element.

Note

The element root is always added upon data model creation. If this element must be
renamed, it can be deleted and recreated with a new name.

Names, labels, descriptions, and information

Whenever you create a new element in your data model, you must provide a name for the field 'Name'
that is unique in its level of the data structure. This name is assigned once the element is created and
cannot be changed subsequently.

You have the option to provide localized user-friendly labels to be displayed in the user interface
instead of the unique name of the element, as well as brief localized descriptions of the element.
Unlike the unique name, the labels and descriptions are modifiable after creation. According to the
language preference of each user, TIBCO EBX® will display the corresponding localized label and
description of the element.

Deleting elements of the data model

Any element can be deleted from the data structure using the down arrow ~ corresponding to its
entry.

When deleting a group or table that is not using a reusable type, the deletion is performed recursively,
removing all its nested elements.

Duplicating existing elements

To duplicate an element, click the down arrow ~ corresponding to its entry. You must provide a
name for the duplicated element that is unique at its level of the data structure. All other properties
are copied from the source element.

The duplicated element is added to the data model at the same level as the element from which it was
copied, appended after the existing elements. If you are duplicating a table or group containing other
elements, all nested elements are copied with their original names.

Note

If you duplicate a primary key field, the properties of the field are maintained, but the
new field is not automatically added to the primary key.

Moving elements

-

To reorder an element within its current level of the data structure, click the down arrow
corresponding to its entry and select 'Move'. Then, select the left-arrow button corresponding to the
field before which you want to move the current element.

Note

It is not possible to move an element to a position outside of its level in the data structure.
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7.2 Reusable types

Reusable types are shared element definitions that are created once and can be reused in different
places in the data model.

Note

If you modify the definition of a reusable type in the 'Simple data types' or 'Complex
data types' section, you will modify the structure of all elements based on that reusable
type. The structure of a groups or table using a reusable type is shown as read-only. To
edit the structure of the associated reusable type, you have to access the type from the
'Simple data types' or 'Complex data types' section.

Defining a reusable type

From the down arrow ~ menu of 'Simple data types' and 'Complex data types' in the navigation pane,
you can define simple and complex reusable types that will be available for creating more elements
which share the same structural definition and properties. Alternatively, you can convert existing tables

and groups into reusable types using their corresponding down arrow T menus.

It is possible to see the elements that are using a reusable type by selecting 'References to this type' on
the specific page of each data type, under 'Simple data types' and 'Complex data types' in the navigation
pane. A table then displays all elements that are based on this type. If a data type is not used by any

elements, you can select the 'Delete type' from its down arrow ™ menu to delete the reusable type.

Using a reusable type

The structure of new elements can be defined using reusable types. To do so, select an existing reusable
type in the element creation form. The created element will then share the type definition of the
reusable type.

Including data types defined in other data models

You can also share reusable types between multiple data models. By configuring the inclusion of an
external data model, you can use the data types defined in that data model to create new elements in
the data structure the same way as using locally defined reusable types.

Note

As the names of data types must be unique across all locally defined as well as all included
types, you cannot create new reusable types with the same name as a data type in an
included data model. Similarly, you cannot include an external data model that defines a
data type with the same name as a locally defined reusable type or a data type in another
included data model.

Included data types appear in the sections 'Included simple data types' and 'Included complex data
types' in the navigation panel. You can view the details of these included reusable types; however,
they can only be edited locally in their original data models.

See Included data models [p 471 for more information.
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7.3 Data model element creation details

Creating fields

When creating a new field, you must select its data type, which will define the data type of the values
based upon this field. The data type of the field cannot be changed once the field has been created.

While creating a field, it is also possible to designate it as a foreign key, a mandatory field, and, if
created under a table, a primary key.

Creating tables

While creating a table, you have the option to create the new table based on an existing reusable type.
See Reusable types [p 51] for more information.

Every table requires specifying at least one primary key field, which you can create as a child element
of the table from the navigation pane.

Creating groups

While creating a group, you have the option to create the new group based on an existing reusable
type. See Reusable types [p 511 for more information.

Creating primary key fields

At least one primary key is required for every table. You can create a primary key field for a table by
creating it as a child element under the table's entry in the 'Data structure' tree.

Besides creating a new field directly as a primary key, you can add any existing child field of a table
to the definition of its primary key on the 'Primary key' tab of the table's 'Advanced properties'.

Creating or defining foreign key fields

Foreign key fields have the data type 'String'. You can create a foreign key field for a table by creating
it as a child element under the table's entry in the 'Data structure' tree. You can also convert an existing
field of type 'String' into a foreign key. To convert an existing field of type 'String' into a foreign key,
enable 'Foreign key constraint' in the field's 'Advanced controls' and define the associated parameters.

Whether creating a foreign key directly or from an existing field, you must define the table that
contains the records to be referenced.

Creating associations

An association allows defining semantic links between tables. You can create an association by
creating it as a child element under the table's entry in the 'Data structure' tree and by selecting
'association' in the form for creating a new element. An association can only be defined inside a table.
It is not possible to convert an existing field to an association.

When creating an association, you must specify the type of association. Several options are available:

« Inverse relationship of a foreign key. In this case, the association element is defined in a source
table and refers to a target table. It is the counterpart of the foreign key field, which is defined in
the target table and refers back the source table. You must define the foreign key that references
the parent table of the association.
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Over a link table. In this case, the association element is defined in a source table and refers
to a target table that is inferred from a link table. This link table defines two foreign keys: one
referring to the source table and another one referring to the target table. The primary key of the
link table must also refer to auto-incremented fields and/or the foreign key to the source or target
table of the association. You must define the link table and these two foreign keys.

Using an XPath predicate. In this case, the association element is defined in a source table and
refers to a target table that is specified using a path. An XPath expression is also defined to specify
the criteria used to associate a record of the current table to records of the target table. You must
define the target table and an XPath expression.

In all types of association, we call associated records the records in the target table that are
semantically linked to records in the source table.

Once you have created an association, you can specify additional properties. For an association, it is
then possible to:

Filter associated records by specifying an additional XPath filter. It is only possible to use fields
from the source and the target table when defining an XPath filter. That is, if it is an association
other a link table it is not possible to use fields of the link table in the XPath filter. You can use
the available wizard to select the fields that you want to use in your XPath filter.

Configure a tabular view to define the fields that must be displayed in the associated table. It is
not possible to configure or modify an existing tabular view if the target table of the association
does not exist. If a tabular view is not defined, all columns that a user is allowed to view according
to the granted access rights are displayed.

Define how associated records are to be rendered in forms. You can specify that associated records
are to be rendered either directly in the form or in a specific tab. By default, associated records
are rendered in the form at the same position of the association in the parent table.

Hide/show associated records in data service 'select' operation. By default associated records are
hidden in data service 'select' operation.

Specify the minimum and maximum numbers of associated records that are required. In associated
datasets, a validation message of the specified severity is added if an association does not comply
with the required minimum or the maximum numbers of associated records. By default, the
required minimum and the maximum numbers of associated records are not restricted.

Add validation constraints using XPath predicates to restrict associated records. It is only possible
to use fields from the source and the target table when defining an XPath predicate. That is, if
it is an association over a link table it is not possible to use fields of the link table in the XPath
predicate. You can use the available wizard to select the fields that you want to use in your XPath
predicate. In associated datasets, a validation message of the specified severity is added when an
associated record does not comply with the specified constraint.

7.4 Modifying existing elements

Removing a field from the primary key

Any field that belongs to the primary key can be removed from the primary key on the 'Primary key'
tab of the table's 'Advanced properties'.

See primary key [p 29] in the glossary.
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CHAPTER 8

Properties of data model elements

After the initial creation of an element, you can set additional properties in order to complete its
definition.

See also Data validation controls on elements [p 69]

This chapter contains the following topics:

1. Basic element properties

2. Advanced element properties
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8.1 Basic element properties

Common basic properties

The following basic properties are shared by several types of elements:

Information

Additional non-internationalized information associated
with the element.

Minimum number of values

Minimum number of values for an element.

As primary keys cannot be multi-valued, they must have this
property set to '1' or 'undefined'. The minimum number of
values is automatically set to '0' when defining the field as
a selection node.

Maximum number of values

Maximum number of values for an element. When set to a
value greater than 'l’, the element becomes multi-valued.

As primary keys cannot be multi-valued, they must have this
property set to '1' or 'undefined'.

For tables, the maximum number of values is automatically
set to 'unbounded' upon creation. The maximum number of
values is automatically set to '0' when defining the field as
a selection node.

Validation rules

This property is available for tables and fields in tables
except Password fields, reusable types, fields in complex
reusable types, and selection nodes. Used to define powerful
and complex validation rules with the help of the provided
XPath 1.0 criteria editor.

See Criteria editor [p 497] for more information.

This can be useful if the validation of the value depends on
complex criteria or on the value of other fields.

It is also possible to indicate that a rule defines a verification
for a value that is mandatory under certain circumstances. In
this case a value is mandatory if the rule is not satisfied. See
Constraint on null' values [p 883] for more information.

Using the associated wizard, you can define localized labels
for the validation rule, as well as define a localized message
with severity to be displayed if the criteria is not met.

When defining the severity of the validation message it is
possible to indicate whether an input that would violate a
validation rule will be rejected or not when submitting a
form. The error management policy is only available on
validation rules defined on a field and when the severity is
set to 'error'. If the validation rule must remain valid, then
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any input that would violate the rule will be rejected and the
values will remain unchanged. If errors are allowed, then
any input that would violate the rule will be accepted and
the values will change. If not specified, the validation rule
always blocks errors upon the form submission by default.

If a validation rule is defined on a table, it will be considered
as a 'constraint on table' and each record of the table will be
evaluated against it at runtime. See Constraints on table [p
884] for more information.

Basic properties for fields

The following basic properties are specific to fields:

Default value

Default value assigned to this field. In new data creation
forms, the default value appears automatically in the user
input field. The default value must comply with the defined
type of the field.

See Default value [p 901] for more information.

Conversion error message

Internationalized messages to display to users when they
enter a value that is invalid for the data type of this field.

Computation rule

This property is available for fields in tables, except in
reusable types. Defines a rule for computing the value of the
field using the provided XPath 1.0 editor.

See criteria editor [p 497]

This can be useful if the value depends on other values
in the same record, but does not require a programmatic
computation.

The following limitations exist for computation rules:

« Computation rules can only be defined on simple fields
inside a table.

« Computation rules cannot be defined on fields of type
OResource Or Password.

« Computation rules cannot be defined on selection nodes
and primary key fields.

« Computation rules cannot be defined when accessing
an element from the validation report.

TIBCO EBX® Product Documentation 6.2.0

57



Documentation > User Guide > Data models > Implementing data models > Properties of data model elements

8.2 Advanced element properties

Common advanced properties

The following advanced properties are shared by several types of elements:

Default view and tools >
Visibility

Specifies whether or not this element is shown in the default
view of a dataset, in the text search of a dataset or in the data

service "select" operation.

Model-driven view

Specifies whether or not the current element is shown
in the default tabular view of a table, the default record
form of a table, and in the default view of a dataset
if the current element is a table. Default dataset view,
tabular view and default record form generated from
the structure of the data model. If the current element
is inside a table, then setting the property to 'Hidden'
will hide the element from the default tabular view and
default record form of the table without having to define
specific access permissions. Current element will still
be displayed in the view configuration wizard to be able
to create a custom view that displays this element. If
the current element is a table, then setting the property
to 'Hidden' will hide the table from the default view
of a dataset without having to define specific access
permissions. This property is ignored if it is set on an
element that is neither a table nor in a table.

All views

Specifies whether or not the current element is shown
in all views of a table in a dataset. Setting the property
to 'Hidden in all views' will hide the element in all
views of the table, whether tabular (default tabular
view included) or hierarchical, without having to define
specific access permissions. The current element will
also be hidden in the view configuration wizard. That
is, it won't be possible to create a custom view that will
display this element. This property is ignored if it is
set on an element that is not in a table. This property
is not applied on forms. That is, setting the property
to 'Hidden in all views' will not hide the element in a
record form but only in views.

Structured search tool

Specifies whether or not the current element is shown
in a dataset structured search tool. Setting the property
to 'Hidden in structured search' will hide the element
in the structured search tool of a dataset. The element
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will remain searchable in the quick search tool. This
property is ignored if it is set on an element that is not
in a table.

e Quick search

Specifies whether or not the current element is included
in the quick search tool. Setting the property to
'Excluded from Quick search' will exclude the element
in the quick search tool of a dataset. The element will
remain searchable in the structured search tool. This
property is ignored if it is set on an element that is not
in a table.

« Data services

Specifies whether or not the current element is shown
in the data service select operation. Setting the property
to 'Excluded from Data Services' will hide the element
in the data service "select" operation. This property is
ignored if it is set on an element that is not in a table.

See Default view [p 903] in the Developer Guide.

Default view and tools > Widget

Defines the widget to be used. A widget is an input
component that is displayed in forms in associated datasets.
If undefined, a default widget is displayed in associated
datasets according to the type and properties of the current
element. It is possible to use a built-in widget or a custom
widget. A custom widget is defined using a Java API to
allow the development of rich user interface components
for fields or groups. Built-in and custom widgets cannot be
defined on a table or an association. It is forbidden to define
both a custom widget and a Ul bean. It is forbidden to define
on a foreign key field both a custom widget and a combo-
box selector.

API

See uTwidgetFactory™ for more information.

Default view and tools > Combo-
box selector

Specifies the name of the published view that will be used
in the combo-box selection of the foreign key. A selection
button will be displayed at the bottom right corner of the
drop-down list. When defining a foreign key, this feature
allows accessing an advanced selection view through the
'Selector’ button that opens the advanced selection view,
from where sorting and searching options can be used. If no
published view is defined, the advanced selection view will
be disabled. If the path of the referenced table is absolute
then only the published views corresponding to this table
will be displayed. If the path of the referenced table is
relative then all the published views associated with the data
model containing the target table will be displayed. This
property can only be set if no custom widget is defined.
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See Defining a view for the combo box selector of a foreign
key [p 905] in the Developer Guide.

UI bean

Attention

From version TIBCO EBX® 5.8.0, it is recommended
to use widgets instead of UI Beans. Widgets provide
more features than UI Beans, and no further evolution
will be made on UI beans. See widget [p 591 for more
information.

This property is available for all elements except tables and
associations. Specifies a Java class to customize the user
interface associated with this element in a dataset. A Ul bean
can display the element differently and/or modify its value
by extending the uIBeanteditor™” class in the Java API.

Transformation on export

This property is available for fields and for groups that
are terminal nodes. Specifies a Java class that defines
transformation operations to be performed when exporting
an associated dataset as an archive. The input of the
transformation is the value of this element.

See NodeDataTransformer™ for more information.

Access properties

Defines the access mode for the current element, that is, if
its data can be read and/or written.

« 'Read & Write' corresponds to the mode Rw in the data
model XSD.

+ 'Read only' corresponds to the mode R- in the data
model XSD.

« 'Not a dataset node' corresponds to the mode cc in the
data model XSD.

« 'Non-terminal node' corresponds to the mode - - in the
data model XSD.

See Access properties [p 901] in the Developer Guide.

Comparison mode

Defines the comparison mode associated with the element,
which controls how its differences are detected in a dataset.

+ 'Default' means the element is visible when comparing
associated data.

«+ 'Ignored’ implies that no changes will be detected when
comparing two versions of modified content (records
or datasets).

During a merge, the data values of ignored elements
are not merged even if the content has been modified.
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However, values of ignored data sets or records being
created during the operation are merged.

During an archive import, values of ignored elements
are not imported when the content has been modified.
However, values of ignored datasets or records being
created during the operation are imported.

See Comparison mode [p 906] in the Developer Guide.

Apply last modifications policy

Defines if this element must be excluded from the service
allowing to apply the last modifications that have been
performed on a record to the other records of the same table.

o 'Default' means that the last modification on this
element can be applied to other records.

« 'Ignored' implies that the last modification on this
element cannot be applied to other records. This
element will not be visible in the apply last
modifications service.

See Apply last modifications policy [p 906] in the
Developer Guide.

Node category

Defines a category for this element. Categories allow
controlling the visibility of data in a dataset to users. A node
with the category 'Hidden' is hidden by default. Restriction:
category specifications other than 'Hidden' do not apply to
table record nodes.

See Categories [p 907] in the Developer Guide.

Advanced properties for fields

The following advanced properties are specific to fields.

Check null input

Implements the property osd: checkNullInput. This property is used to activate and check a constraint

on null at user input time.

By default, in order to allow for temporarily incomplete input, the check for mandatory elements is not
performed upon user input, but only upon dataset validation. If a mandatory element must be checked
immediately upon user input, set this property to 'true'.

Note

A value is considered mandatory if the 'Minimum number of values' property is set to
'1" or greater. For terminal elements, mandatory values are only checked in activated
datasets. For non-terminal elements, the values are checked regardless of whether the

dataset is activated.

See Constraints, triggers and functions [p 888] in the Developer Guide.
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Trim whitespaces
Trim white spaces

Implements the property osd:trim. This property is used to indicate whether leading and trailing white
spaces must be trimmed upon user input. If this property is not set, leading and trailing white spaces
are removed upon user input.

See Whitespace handling upon user input [p 889] in the Developer Guide.

Ul bean

See Common advanced properties [p 60].

Function (computed value)

This property is available for non-primary key fields. Specifies a Java class that computes the value
of this field programmatically. This can be useful if the value of the field depends on other values in
the repository, or if the computation of the value needs to retrieve data from a third-party system.

A function can be created by implementing the valueFunction™ interface.

Disable validation

Specifies if the constraints defined on the field must be disabled. This property can only be defined
on function fields. If true, cardinalities, simple and advanced constraints defined on the field won't be
checked when validating associated datasets.

Transformation on export

See Common advanced properties [p 60].

Access properties

See Common advanced properties [p 60].

Auto-increment

This property is only available for fields of type 'Integer' that are contained in a table. When set, the
value of the field is automatically calculated when a new record is created. This can be useful for
primary keys, as it generates a unique identifier for each record. Two attributes can be specified:

Start value Value with which to begin the auto-increment. If this
attribute is not specified, the default value is '1'.

Increment step Amount the value is incremented based on the previous
value of the auto-increment. If this attribute is not specified,
the default is value is '1".

Disable auto-increment checks Specifies whether to disable the check of the auto-
incremented field value in associated datasets against the
maximum value in the table being updated.

Auto-incremented values have the following behavior:
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+ The computation and allocation of the field value are performed whenever a new record is inserted
and the field value is yet undefined.

+ No allocation is performed if a programmatic insertion already specifies a non-null value.
Consequently, the allocation is not performed for a record insertion in occulting or overwriting
modes.

« [If an archive import specifies the value, the imported value takes precedence.
« Whenever possible, the newly allocated value is unique in the scope of the repository.

That is, the uniqueness of the allocation spans over all datasets based upon this data model, in any
dataspace in the repository. The uniqueness across different dataspaces facilitates the merging of
child dataspaces parent dataspaces while reasonably avoiding conflicts when a record's primary
key includes the auto-incremented value.

Despite this policy, a specific limitation exists when a mass update transaction assigning specific
values is performed concurrently with a transaction that allocates an auto-incremented value on
the same field. It is possible that the latter transaction will allocate a value that has already been
set in the former transaction, as there is no locking between different dataspaces.

See Auto-incremented values [p 893] in the Developer Guide.

Default view

See Common advanced properties [p 58].

Node category

See Common advanced properties [p 61].

Inherited field

Defines a relationship from the current field to a field in another table in order to automatically fetch
its field value.

Source record A foreign key or white space-separated sequence of foreign
keys that leads from the current element to the record from
which to inherit this field's value. If this property is not
specified, the current record is used as the source record for
the inheritance.

Source element XPath of the element in the source record from which
to inherit this field's value. The source element must be
terminal, belong to the record described by 'Source record',
and its type must match the type of this field. This property
is mandatory when using field inheritance.

See inheritance [p 31] in the glossary.

For more information, see also Inherited fields [p 472].

Advanced properties for tables

The following advanced properties are specific to tables.
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Table

Primary key

A list of fields in the table that compose the table's primary
key. You can add or remove primary key fields here, as in
the 'Data structure' view.

Each primary key field is denoted by its absolute XPath
notation that starts under the table's root element.

If there are several elements in the primary key, the list is
white-space delimited. For example, "/name /startDate".

Presentation

Specifies how records are displayed in the user interface of
this table in a dataset.

Presentation > Record labeling

Defines the fields to provide the default and localized labels
for records in the table.

Can also specify a Java class to set the label
programmatically, or set the label in a hierarchy. This
Java class must implement either the uILabelRenderer™
interface or the uILabelRendererForHierarchy™ interface.

Attention: Access rights defined on associated datasets
are not applied when displaying record labels. Fields that
are usually hidden due to access rights restrictions will be
displayed in labels.

Presentation > Default rendering
for groups in forms

Specifies the default display rendering mode of the groups
contained in this table. If nothing is defined here, the default
policy set in the Administration area will be used to display
groups.

See Record form: rendering mode for nodes [p 636] in the
Administration Guide.

Enabled rendering for groups

Specifies a display rendering mode to be enabled for
groups in the table in addition to the modes 'expanded'
and 'collapsed’, which are always available. Tabs must be
enabled on the table to have the option to display groups as
tabs. Similarly, links must be enabled to have the option to
display groups as links.

Default rendering for groups

Specifies the default display rendering mode to use for the
groups contained in this table. If a group does not specify
a default mode then the default mode defined for this table
will be used. Links must be enabled to define the default
rendering mode as 'Link'. Select a rendering mode according
to network and browser performance. Link mode is lighter

TIBCO EBX® Product Documentation 6.2.0

64



Documentation > User Guide > Data models > Implementing data models > Properties of data model elements

as its content is not displayed on the same page, whereas the
expanded and collapsed modes are heavier.

Note: When the tabs view is enabled on a table, any groups
that would otherwise have used links are automatically
converted to collapsed mode. This is done to avoid the
inherent display layout complexities that would arise from
links and tabs coexisting in the same user interface.

Presentation > Specific
rendering of forms

Defines a specific rendering for customizing the record form
in a dataset.

T

See urlForm™ and UserServiceRecordFormFactory” for
more information.

Toolbars Defines the toolbars to use in this table.
Toolbars can be edited in the Configuration > Toolbars
section.
Tabular view top: Defines the toolbar to use on top of the
default table view.
Tabular view row: Defines the toolbar to use on each row
of the default table view.
Tile view item: Defines the toolbar to use on each item of
the tile view.
Record top: Defines the toolbar to use in the record form.
Hierarchy top: Defines the toolbar to use in the default
hierarchy view of the table.
See Toolbars [p 80] for more information.

History Specifies when historization is to be performed, and the

level of guarantee requested. The available history profiles
can be edited in Administration > History and logs.

See History configuration in the repository [p 451] for more
information.

Specific filters

Defines record display filters on the table.

Actions

Specifies the actions that are allowed on the table in
associated datasets. By default, all actions are allowed
unless specific access rights are defined in a dataset.

Uniqueness constraints

Indicates which fields or set of fields must be unique across the table.
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Triggers

Specifies Java classes that defines methods to be automatically executed when modifications are
performed on the table, such as record creation, updates, deletion, etc.

A built-in trigger for starting data workflows is included by default.
A built-in trigger to define a script for a trigger is also included by default.

See Triggers [p 892] in the Developer Guide.

Access properties

See Common advanced properties [p 60].

Default view

See Common advanced properties [p 58].

Node category

See Common advanced properties [p 61].

Advanced properties for groups

The following advanced properties are specific to groups.

Value container class (JavaBean)

Specifies a Java class to hold the values of the children of this group. The Java class must conform
to the JavaBean standard protocol. That is, each child of the group must correspond to a JavaBean
property in the class, and all properties must have getter and setter accessors defined.

Ul bean

See Common advanced properties [p 60].

Transformation on export

See Common advanced properties [p 60].

Access properties

See Common advanced properties [p 60].
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Default view

Visibility See Common advanced properties [p 58].

Rendering in forms Defines the rendering mode of this group. If this property
is not set, then the default view for groups specified by the
container table will be used. 'Tab' and 'Link' are each only
available when the container table enables it.

Tab position

This attribute specifies the position of the tab with respect
to all the tabs defined in the model. This position is used for
determining tab order. If a position is not specified, the tab
will be displayed according to the position of the group in
the data model.

Node category

See Common advanced properties [p 611.

Related concepts Data validation controls on elements [p 69]
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CHAPTER 9

Data validation controls on elements

After the initial creation of an element, you can set additional controls in order to complete its
definition.

See also Properties of data model elements [p 55]

This chapter contains the following topics:

1. Simple content validation

2. Advanced content validation

TIBCO EBX® Product Documentation 6.2.0 69



Documentation > User Guide > Data models > Implementing data models > Data validation controls on elements

9.1 Simple content validation

Using the following static controls on a field, you can establish simple validation rules on its content.
The controls available for a given field are dependent on its data type.

Fixed length

The exact number of characters required for this field.

Minimum length

The minimum number of characters allowed for this field.

Maximum length

The maximum number of characters allowed for this field.

Pattern

A regular expression pattern that the value of the field must
match. It is not possible to simultaneously define a pattern
for both a field and its data type.

Decimal places

The maximum number of decimal places allowed for this
field.

Maximum number of digits

The maximum total number of digits allowed for this integer
or decimal field.

Enumeration

Defines a list of predefined possible values for this field. If
enumerations are defined in both a field and its type, then the
enumeration of this field in associated datasets is replaced
by the intersection of these two enumerations.

Greater than [constant]

Defines the minimum value allowed for this field.

Less than [constant]

Defines the maximum value allowed for this field.

See XML schema supported facets [p 875].

9.2 Advanced content validation

Using the following dynamic and contextual controls on an element, you can establish advanced
validation rules of its content. The controls available for a given element are dependent on the type
of element and its data type, if it has one.
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See also Dynamic constraints [p 879]

Foreign key constraint

Table

Defines the table referenced by the foreign key. A foreign
key references a table in the same dataset by default. It
can also reference a table in another dataset in the same
dataspace, or a dataset in a different dataspace.

Mode

Location of the table referenced by the foreign key.
'Default': current data model.
'Other dataset': different dataset, in the same dataspace.

'Other dataspace': dataset in a different dataspace.

Referenced table

XPath expression describing the location of the table. For
example, /root/MyTable.

Referenced dataset

Required if the table is located in another dataset. The
unique name of the dataset containing the referenced table.

Referenced dataspace

Required if the table is located in another dataspace. The
unique name of the dataspace containing the referenced
table.

Label

Defines fields to provide the default and localized labels for
records in the table. Allows as well to customize the display
of the specified label in breadcrumb.

Can also specify a Java class to set the label
programmatically if 'XPath expression' is set to 'No'. This
Java class must implement the TableRefDisplay™” interface
of the Java API.

Attention: Access rights defined on associated datasets
are not applied when displaying record labels. Fields that
are usually hidden due to access rights restrictions will be
displayed in labels.

Filter

Defines a foreign key filter using an XPath expression.

Can also specify a Java class that implements the
TableRefFilter™ interface of the Java API.

Greater than [dynamic]

Defines a field to provide the minimum value allowed for
this field.
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Less than [dynamic]

Defines a field to provide the maximum value allowed for
this field.

Fixed length [dynamic]

Defines a field to provide the exact number of characters
required for this field.

Minimum length [dynamic]

Defines a field to provide the minimum number of
characters allowed for this field.

Maximum length [dynamic]

Defines a field to provide the maximum number of
characters allowed for this field.

Excluded values

Defines a list of values that are not allowed for this field.

Excluded segment

Defines an inclusive range of values that are not allowed for
this field.

Minimum excluded value: Lowest value not allowed for
this field.

Maximum excluded value: Highest value not allowed for
this field.

Specific constraint (component)

Specifies one or more Java classes that implement the
Constraint™ interface of the Java API. See Programmatic
constraints [p 883] for more information.

Specific enumeration
(component)

Specifies a Java class to define an enumeration. The class
must define an ordered list of values by implementing the
ConstraintEnumeration™ interface of the Java API.

Enumeration filled by another
node

Defines the possible values of this enumeration using a
reference to another list or enumeration element.

Dataspace set configuration

Define the dataspaces that can be referenced by a field
of the type Dataspace identifier (osd:dataspaceKey). If a
configuration is not set, then only opened branches can be
referenced by this field by default.

« Includes

Specifies the dataspaces that can be referenced by this
field.

Pattern: Specifies a pattern that filters dataspaces. The
pattern is checked against the name of the dataspaces.

Type: Specifies the type of dataspaces that can be
referenced by this field. If not defined, this restriction
is applied to branches.
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Include descendants: Specifies if children or
descendants of the dataspaces that match the specified
pattern are included in the set. If not defined, this
restriction is not applied to child dataspaces. If "None"
then neither children nor descendants of the dataspaces
that match the specified pattern are included. If "All
descendants" then all descendants of the dataspaces
that match the specified pattern are included. If "All
descendant branches" then all descendant branches
of the dataspaces that match the specified pattern
are included. If "All descendant snapshots" then all
descendant snapshots of the dataspaces that match the
specified pattern are included. If "Child branches" then
only direct branches of the dataspaces that match the
specified pattern are included. If the current dataspace
is a version, includes the branches that are the direct
children of this version; if the current dataspace is
a branch, includes the branches that are the direct
children of the versions which are children of this
branch. If "Child snapshots" then only direct snapshots
of the dataspaces that match the specified pattern are
included. If the current dataspace is a branch, includes
the snapshots that are the direct children of this branch;
if the current dataspace is a version, includes the
versions that are the direct children of the branches
which are children of this version.

« Excludes

Specifies the dataspaces that cannot be referenced by
this field. Excludes are ignored if no includes are
defined.

Pattern: Specifies a pattern that filters dataspaces. The
pattern is checked against the name of the dataspaces.

Type: Specifies the type of dataspaces that can be
referenced by this field. If not defined, this restriction
is applied to branches.

Include descendants: Specifies if children or
descendants of the dataspaces that match the specified
pattern are included in the set. If not defined, this
restriction is not applied to child dataspaces. If "None"
then neither children nor descendants of the dataspaces
that match the specified pattern are included. If "All
descendants" then all descendants of the dataspaces
that match the specified pattern are included. If "All
descendant branches" then all descendant branches
of the dataspaces that match the specified pattern
are included. If "All descendant snapshots" then all
descendant snapshots of the dataspaces that match the
specified pattern are included. If "Child branches" then
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only direct branches of the dataspaces that match the
specified pattern are included. If the current dataspace
is a version, includes the branches that are the direct
children of this version; if the current dataspace is
a branch, includes the branches that are the direct
children of the versions which are children of this
branch. If "Child snapshots" then only direct snapshots
of the dataspaces that match the specified pattern are
included. If the current dataspace is a branch, includes
the snapshots that are the direct children of this branch;
if the current dataspace is a version, includes the
versions that are the direct children of the branches
which are children of this version.

Dataspace filter

Specifies a filter to accept or reject dataspaces in the
context of a dataset or a record. This filter is only used
in the dedicated input component that is associated to
this field. That is, this filter is not used when validating
this field. A specific constraint can be used to perform
specific controls on this field. A filter is defined by a
Java class that implements the DataspaceSetFilter™
interface of the Java API.

Dataset set configuration

Define the datasets that can be referenced by a field of the

type Dataset identifier (osd:datasetName).

Includes

Specifies the datasets that can be referenced by this
field.

Pattern:Specifies a pattern that filters datasets. The
pattern is checked against the name of the datasets.

Include descendants: Specifies if children or
descendants of the datasets that match the specified
pattern are included in the set.

Excludes

Specifies the datasets that cannot be referenced by this
field. Excludes are ignored if no includes are defined.

Pattern: Specifies a pattern that filters datasets. The
pattern is checked against the name of the datasets.

Include descendants: Specifies if children or
descendants of the datasets that match the specified
pattern are included in the set.

Filter

Specifies a filter to accept or reject datasets in the
context of a dataset or record. This filter is only used
in the dedicated input component that is associated to
this field. That is, this filter is not used when validating
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this field. A specific constraint can be used to perform
specific controls on this field. A filter is defined by
a Java class that implements the DatasetSetFilter™
interface of the Java API.

Validation properties

Each constraint not using a specific Java class can define localized validation messages with a severity

using the following properties:

Validation

Defines a localized validation message with a user-defined
severity level.

Severity

Defines the severity level of the validation message.
Possible values are 'Error', "'Warning', and 'Information'.

Error management
policy

Specifies the behavior of the constraint when validation
errors occur. It is possible to specify that the constraint
must always remain valid after an operation (dataset update,
record creation, update or deletion), or when a user submits
a form. In this case, any input or operation that would
violate the constraint will be rejected and the values will
remain unchanged. If not specified, the constraint only
blocks errors upon form submission by default, except for
foreign key constraints in relational data models where
errors are prevented for all operations by default. This
option is only available upon static controls, exclude values,
exclude segment and foreign key constraints. On foreign
key constraints the error management policy does not
concern filters. That is, a foreign key constraint is not
blocking if a referenced record exists but does not satisfy
a foreign key filter. In this case updates are not rejected
and a validation error occurs. It is not possible to specify
an error management policy on structural constraints that
are defined in relational data models, when table history or
replication is activated. That is, setting this property on fixed
length, maximum length, maximum number of digits and
decimal place constraints will raise an error at data model
compilation because of the underlying RDBMS blocking
constraints validation policy. This property is ineffective
when importing archives. That is, all blocking constraints,
excepted structural constraints, are always disabled when
importing archives.

Message

Defines the message to display if the value of this field in
a dataset does not comply with this constraint. If specifying
a custom message, you may optionally provide localized
variants.
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Related concepts Properties of data model elements [p 55]
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cHAPTER 10

Data model extensions

This chapter contains the following topics:

1. Extensions used by the data model

Indexing and search strategies

Business objects

Toolbars

Entity mappings

Replication of data to relational tables

N ok DN

Node confidentiality

10.1 Extensions used by the data model

On any data model, it is possible to specify some extensions to be used. These extensions will have
the capacity to define additional features around the data model and to enrich the current data model
after the publication by adding properties and constraints to the data model elements. Data model
extensions are displayed in the navigation pane under the section 'Extensions'.

The following extensions are automatically enabled on new data models:
« Toolbars [p 80]
« Entity mappings [p 86]

» Replications [p 86]
- Indexing and search strategies [p 78]

- Business objects [p 78]

o Custom forms [p913]

» Scripts [p 1256]
o Record permissions [p 1239]

« Node confidentiality [p 871
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Some extensions are optional and defined in dedicated datasets. These extensions can be disabled or
enabled through the user interface.

Optional data model extension can be disabled by selecting the action 'Disable extension' from the

menu to the left of extension to disable.

Note

When disabling an extension its dedicated dataset is also deleted and it is not possible
to recover it after its deletion

From the menu  to the left of 'Extensions' entry in the navigation pane, you can enable an extension
by selecting the action 'Enable an extension'. This option is only displayed if some extensions are
available. When selecting this action a form displays the available data model extensions.

Once a data model extension is activated then it is displayed under the entry 'Extensions' in the
navigation pane and can be edited as a regular dataset. That is, the configuration of an extension is
embedded in a dedicated dataset that benefits of all EBX® features available on datasets.

10.2 Indexing and search strategies

This feature is documented in the chapter Search [p 4991.

10.3 Business objects

A business object is an abstract layer that allows manipulating records from several tables within the
same data model. The definition of business objects, named business object model, can be performed
in the data model via the 'Extensions' section. A business object model is defined on a main table and
contains child entities that are defined using the relationships from this main table.

Create a business object model from the Business objects > Definitions section of the navigation pane,

by clicking on the menu  located to the left of Business Objects, then selecting the Create Business
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Object option. Follow the creation wizard to create a business object model. A business object model

defines the following information:

Business object name

Business object model's name. The name must be unique in
the context of the data model since it is used to uniquely
identify the business object model. That is, it is not allowed
to create several business objects with the same name.

Label and description

Internationalized labels and descriptions to be displayed to
end users.

Main table

Defines the main table of this business object model.
Specified path must be absolute (must start with "/"). The
main table of this business object model cannot be used if
it is already a part of another business object model. That
is, the main table cannot be used if it is already defined as
the main table or as a child entity of another business object
model.

Defining the structure of a business object model

A business object model is composed of a main table and child entities. Child entities are defined
using the relationships contained in the main table.

Add a child entity under a business object model by clicking on the menu located to the left
the existing business object, and by selecting the Add child entity option. Then, follow the creation
wizard to create a child entity. The following information must be set:

of

Relationship to table

This field defines the relationship to the table to add
as a child entity. The path to the relationship must be
absolute (must start with "/"). Only foreign key constraints
and associations by inverse foreign key are supported.
Also these relationships must comply with the following
constraints: Foreign key constraints cannot be a list or under
a list. The field that defines the foreign key constraint
must be declared as unique. That is, it must either define
a uniqueness constraint with a blocking validation mode
or be the only primary key field of its container table.
Associations by inverse foreign key must refer to a foreign
key field that cannot be a list or under a list. Also, the target
table of the relationship cannot refer to a table that is already
used by this business object model or another one. That is,
the target table cannot be used if it is already defined as the
main table or as a child entity of a business object model.
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10.4Toolbars

A toolbar allows to customize the buttons and menus that are displayed when viewing tables or records
in a dataset. The customization of toolbars can be performed in the data model via the 'Extensions'
section.

Add a toolbar from the Toolbars section of the navigation pane, by clicking on the menu located
to the left of [ All elements ], then selecting the Create toolbar option. Follow the creation wizard to
create a toolbar. A toolbar defines the following information:

Name Toolbar's name. The name of the toolbar must be unique in
the context of the data model. That is, it is not allowed to
create several toolbars with the same name.

Label and description Internationalized labels and descriptions to be displayed to
end users.

Default template Allows to create a toolbar with the structure of a default
toolbar.

Locations Specifies the locations where the toolbar can be used in

associated datasets.

Tabular view top: Defines the toolbar to use on top of the
default table view.

Tabular view row: Defines the toolbar to use on each row
of the default table view.

Tile view item: Defines the toolbar to use on each item of
the tile view.

Record top: Defines the toolbar to use in the record form.

Hierarchy top: Defines the toolbar to use in the default
hierarchy view of the table.

Known limitations

A toolbar defined to be used as "Tile view item" cannot have
more than six items and it can only define action items. The
display of those action buttons are always in mode "Icon
only".

Defining the structure of a toolbar
A toolbar can define the following elements:
« Action button [p 81]

« Menu button [p 82]

» Separator [p 82]
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« Menu group [p 83]

« Action menu item [p 84]

o Sub menu item [p 84]

Add one of these elements under a toolbar or to an existing element by clicking on the menu
located to the left of the existing element, and by selecting a creation option in the menu. Then, follow
the creation wizard to create an element.

Action button

This type of element allows to associate an action to a button in a toolbar. The action will be triggered
when the user clicks on the associated button in one of the toolbars. A Action button type element
defines the following information:

Service Defines the service that will be executed when the user
clicks on the button. It is possible to select a built-in service,
or a user service defined in a module or in the current data
model. If the "'Web component' target is selected, the service
will have to be declared as available as a web component
for toolbars.

Label and description Internationalized labels and descriptions to be displayed to
end users.
Layout Defines how this element will be displayed in datasets using

the toolbar. It is possible to display: the icon only, the text
only, text with the icon to the left or text with the icon to
the right.

Icon Icon to display. It is possible to use an icon to choose from
a set of suggested icons, or to refer to an icon using a URL.

Relief Defines how this button will display. The button can be
displayed as embossed or flat.

Is highlighted Indicates if the button should be highlighted by default.

Note

A Action button type element can only be created under a toolbar type element.
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Menu button

This type of element allows to define a menu that will be displayed when the user clicks on the
associated button in a toolbar. An element of the Menu button type defines the following information:

Label and description Internationalized labels and descriptions to be displayed to
end users.
Layout Defines how this element will be displayed in datasets using

the toolbar. It is possible to display: the icon only, the text
only, text with the icon to the left or text with the icon to
the right.

Icon Icon to display. It is possible to use an icon to choose from
a set of suggested icons, or to refer to an icon using a URL.

Relief Defines how this button will display. The button can be
displayed as embossed or flat.

Is highlighted Indicates if the button should be highlighted by default.

Note

An element of the Menu button type can only be created under an element of the toolbar
type.

Separator

This type of element allows to insert a separator in the form of spacing between two elements of a
toolbar.

Note

An element of the Separator type can only be created under an element of the toolbar
type.
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Menu group

This type of element allows to define a group of elements in a menu. An element of the Menu group
type defines the following information:

Label and description

Internationalized labels and descriptions to be displayed to
end users.

Group type

Specifies the type of menu group to create: - 'Local' allows
to create an empty fully customizable menu group. - 'Service
group' allows to assign an existing service group to this
menu group. - 'Menu builder' allows to assign a predefined
menu content to this menu group. Once created, it is not
possible to change the type of this menu group.

Service group name

Specifies an existing group of services to reuse. A group
is declared in a module and can include other groups
of services. All services contained in this group will be
displayed to end users in associated datasets.

Menu builder name

Specifies the predefined menu content to assign to this menu
group: - 'Default menu "Actions" has the same content as
the default toolbar 'Actions' menu. Standard and custom
services are displayed without distinction. - 'Default menu
"Actions" (with separator)' has the same menu content as
above, but displays differently since standard and custom
services are separated (standard services first, then custom
services).

Excluded services

Indicates the services to exclude from the group of reused
services. These services will not be displayed to end users
in associated datasets.

Excluded service groups

Indicates the groups to exclude from the group of services
to reuse. Services in excluded groups will not be displayed
to end users in associated datasets.

Filtering policy

In case of "Smart filtering", services that are configured in
direct access, i.e. via an action button or an action menu
item, will be removed from the automatic generation of this

group.

Note

An element of the Menu group type can only be created under the following elements:

« Menu button

TIBCO EBX® Product Documentation 6.2.0

83



Documentation > User Guide > Data models > Implementing data models > Data model extensions

« Sub menu item

Action menu item

This type of element allows to associate an action to a menu item in a toolbar. The action will be
triggered when the user clicks on the corresponding item in a menu. An element of the Action menu
item type defines the following information:

Label and description Internationalized labels and descriptions to be displayed to
end users.
Service Defines the service that will be executed when the user

clicks on the button. It is possible to select a built-in service,
or a user service defined in a module or in the current data
model. If the "'Web component' target is selected, the service
will have to be declared as available as a web component
for toolbars.

Note

An element of the Action menu item type can only be created under a Menu group type
element.

Sub menu item

This type of element allows to add a sub menu to a toolbar menu. Un Sub menu item defines the
following information:

Label and description Internationalized labels and descriptions to be displayed to
end users.

Note

An element of the Sub menu item type can only be created under an element of the Menu
group type.

Deleting elements

All the elements of a toolbar can be deleted from it by using the menu located to the left of the
element to be deleted.

If an element containing other elements is deleted, then the deletion is recursively performed on all
elements located below the deleted element.
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Duplicating existing elements

To duplicate an element, click on the menu  located to the left of the element to duplicate. Specify
the name and properties of the duplicated element. All the source element properties are duplicated.

The duplicated element is added on the same level than the original element, in the final position.
When an element containing other elements is duplicated, all the sub-elements are duplicated with
their properties.

Moving elements

In order to move an element, click on the menu  and select the moving option to be used.

Associate with existing tables

To associate a toolbar with existing tables, click on the menu located to the left of the toolbar and
select the option Associate to tables. This service allows to set the toolbar has the default toolbar of
several tables in one shot. To do so, specify the target locations of the toolbar and select the tables or
complex data types, that define table properties, to be associated with the toolbar.

Exporting the toolbars

It is possible to export the toolbars defined in the model into an XML document. To do so, select
the XML export option available in the Actions menu of the "Toolbars' section. Follow the wizard to
export the toolbars.

Note

A selection of toolbars can be exported by selecting in the "Toolbars' section the toolbars
to be exported and then by selecting the XML export option available in the Actions menu.
The toolbars can also be exported by using the data model export service. It can be found
in the Data model 'Actions' [p 39] menu in the navigation pane.

See also Data model import and export [p 89]

Importing toolbars

It is possible to import existing toolbars from an XML document. To do so, select the XML import
option available in the Actions menu of the "Toolbars' section. Then follow the wizard to import the
toolbars.

Note

The toolbars can also be imported by using the data model import service accessible via
the Data model 'Actions’ [p 39] menu in the navigation pane.

See also Data model import and export [p 89]
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See also Use of toolbars [p 65]

10.5Entity mappings

You can refer to tables in SQL requests and data service operations using unique names instead of
their paths. To accomplish this, you must define entity mappings to create an association between a
table path and a name. When referencing a table you then use this name as a WSDL suffix in data
service operations and an alias in SQL requests.

Note

EBX® automatically creates an entity name for the tables defined in a data model. The
last step of the table's path is used as the default entity name. Since entity names must be
unique in a data model, an error is now raised during compilation if the model contains
tables with the same name. To prevent an error in this case, you must explicitly set the
entity names.

To define an entity mapping through the user interface, in the navigation pane when viewing a
data model, navigate to Extensions > Entity mappings and create a new record. You can define the
following properties:

Table path Specifies the path of the table in the current data model that
is to be referred by this name in SQL requests or WSDL
operations.

Entity name This name is used to suffix all WSDL operation names

of the concerned table and as an alias in SQL requests. If
undefined for a given table, the last element of the table path
is used instead. This name must be unique in the context of
this data model.

See also Data services [p 909]

10.6 Replication of data to relational tables

In any data model, it is possible to define replication units for data in the repository to be mirrored
to dedicated tables in the relational database. These tables then enable direct access to the data by
SQL requests and views.

To define a replication unit through the user interface, create a new record in the 'Replications' table
under the extensions' section in the navigation pane. Each replication unit record is associated with a
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particular dataset in a given dataspace. A single replication unit can cover multiple tables, as long as
they are in the same dataset. A replication unit defines the following information:

Name Name of the replication unit. This name identifies a
replication unit in the current data model. It must be unique.

Dataspace Specifies the dataspace relevant to this replication unit. It
cannot be a snapshot.

Dataset Specifies the dataset relevant to this replication unit.

Refresh policy Specifies the data synchronization policy. The possible
policies are:

« On commit: The replicated table content in the
database is always up to date with respect to its source
table. Every transaction that updates the EBX® source
table triggers the corresponding insert, update, and
delete statements on the replicated table.

« On demand: The replicated table in the database is
only updated when an explicit refresh operation is
performed.

Tables Specifies the tables in the data model to be replicated in the
database.

Table path: Specifies the path of the table in the current
data model that is to be replicated to the database.

Table name in database: Specifies the name of the table in
the database to which the data will be replicated. This name
must be unique amongst all replications units.

Aggregated lists Specifies the properties of the aggregated lists in the table
that are replicated in the database.

Path: Specifies the path of the aggregated list in the table
that is to be replicated to the database.

Table name in database: Specifies the name of the table
in the database to which the data of the aggregated list
will be replicated. This name must be unique amongst all
replications units.

See also Replication [p 459]

10.7 Node confidentiality

The confidentiality of a node defines whether or not it can be used in a Query or in a Request when
hidden for a specific user. By default, all nodes are confidential.
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This can be configured in the DMA, by using the "Extensions" tab in the node form editor. It is possible
to define the confidentiality at several levels:

« at a data model level (root node): defines the default confidentiality for the data model terminal
nodes, unless a more specific definition is set (that is on the table or the node itself).

 atatable level (table node): defines the default confidentiality for the table terminal nodes, unless
a more specific definition is set (that is on the node itself).

« at a terminal node level: defines the confidentiality of the node.

For more information, see Defining confidentiality [p 480]
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cHAPTER 11

Working with an existing data model

Once your data model has been created, you can perform a number of actions that are available from
the data model 'Actions’ [p 39] menu in the workspace.

This chapter contains the following topics:

1. Validating a data model

2. Data model import and export

3. Duplicating a data model

4. Deleting a data model

11.1 Validating a data model

To validate a data model at any time, select Actions > Validate from the navigation pane. The
generated report provides the results of the validation. From the validation report, you have the option
to update the reported validation status by clicking the Revalidate button, or to click the Reinitialize
validation report button to clear the current validation report associated with the data model in order
to be able to rerun a full validation from scratch.

Note

The validation process checks basic data model integrity, but more complex checks are
only performed at publication time. More messages may be reported when you try to
publish your data model.

See Validation [p 587] for detailed information on incremental data validation.

11.2 Data model import and export

TIBCO EBX® includes built-in data model services to import from and export to XML Schema
Document (XSD) files or to archive files (zip). Imports and exports can be performed from the data
model 'Actions’ [p 39] menu of the target data model in the navigation pane. An import or export is
always performed in the context of a single data model. That is, during imports, the structure of the
target data model is completely replaced with the content of the imported data model (XSD or archive).
Similarly, during exports, the entire data model is included in the XSD or archive file.

When importing a data model, the corresponding XSD file must be well-formed and must comply
with EBX® validation rules.
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If this document declares resources that are located in a module, the module must also be declared
in the configuration of the data model. If the module has not been declared, you will not be able to
import the data model. See Data model properties [p 46] for more information on declaring modules.

To perform an import select Tmport data model' from the data model 'Actions’ [p 391 menu of the data
model into which you are importing.

You can import an XML Schema Document (XSD) or an archive (zip file) from the local file system.
To do so, click the 'From a local document' button in the import wizard and follow the next step:

« Document name: path on the local file system of the XSD or archive file to import.

Note

When importing an archive it must contain only one XML Schema Document (XSD)
at its root. XML documents related to data model extensions must also be located
at the root of the archive. These XML documents are automatically imported if they
comply with the naming of the extensions supported and registered in EBX®.

You can also import a data model in an XSD that is packaged in a module. The import of a data model
in XSD format from a module uses the following properties:

Module Module in which the data model is packaged.

Module path Path to the module containing the data model.

Source path Path to Java source used to configure business objects and
rules.

This property is required if the data model being imported
defines programmatic elements.

Model The data model in the module to import.

Note
Imported XSD files must be encoded in 'UTF-8'. Exported XSD files are always encoded
in 'UTF-8'.

To perform an export select 'Export data model' from the data model 'Actions’ [p 391 menu of the data
model you want to export.

11.3 Duplicating a data model

To duplicate a data model, select 'Duplicate' from the data model 'Actions’ [p 39] menu for that data
model. You must give the new data model a name that is unique in the repository.

11.4 Deleting a data model

To delete a data model, select 'Delete' from the data model 'Actions’ [p 39] menu for that data model.
When you delete a data model, all of its existing publications will remain and continue to be accessible
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to their associated datasets. If you recreate a new data model with the same name as one that was
previously deleted, the new data model will be reassociated with all the existing publications in the
repository. At publication time of the new data model, you will have the opportunity to confirm the
replacement of an existing publication.

Note

Only an administrator can clean up the publications of deleted data models in the
'Administration' area.

See Publishing data models [p 93] for more information on the publication process.
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CHAPTER 12

Publishing a data model

This chapter contains the following topics:

1. About publications

2. Publication modes

3. Embedded publication mode

12.1 About publications

Each dataset based on an embedded data model in the TIBCO EBX® repository is associated with
a publication of a data model, rather than directly to the data model itself. The first time you publish
a data model using the Publish button in the navigation pane, a publication is created. Once the
publication exists, datasets can be created based upon it.

Note

The Publish button is only displayed to users who have permission to publish the data
model. See Data model permissions [p 45] for more information.

As datasets are based on publications, any modifications you make to a data model will only take effect
on existing datasets when you republish to the publication associated with those datasets. When you
republish a data model to an existing publication, all existing datasets associated with that particular
publication are updated.

12.2 Publication modes

You can publish a data model using either 'Embedded' mode or 'In module' mode. The 'Embedded’
publication mode generates a publication that is managed and persisted within the EBX® repository
and thus has associated versioning and rollback functionality. The 'Tn module' publication mode creates
an XML Schema Document contained in a module that is not managed or versioned within the
repository.

Depending on the configuration of the data model, EBX® automatically determines the publication
process to use when you click the Publish button in the navigation pane. When a data model specifies
the publication mode 'In module' and provides a target XSD to be generated, the publication process
generates an XSD file contained in the module defined in the configuration.

TIBCO EBX® Product Documentation 6.2.0 93



Documentation > User Guide > Data models > Publishing and versioning data models > Publishing a data model

12.3 Embedded publication mode

The first time you publish a given embedded data model, a new publication with the same name as
your data model is automatically created in the repository. If more than one publication has already
been created for this model, you will need to select a target publication for this process.

See Viewing and creating publications [p 94] for more information on the use of different
publications.

During the publication process, you have the opportunity to review the structural differences being
introduced by the current publication in a side-by-side comparison view, if the data model has
previously been published.

The publication process also offers the option to create a read-only snapshot of the current state of
the data model for reference purposes. This snapshot can be useful if the data model ever needs to be
rolled back to the current state after other modifications have been made.

Note

Snapshots, which are static archives of the state of the data model, must not be confused
with data model versions, which act instead as parallel evolving branches of the data
model. See Versioning embedded data models [p 951 for more information on data
model versions.

Viewing and creating publications

To access the publications that exist for the current data model, select "Manage publications' from its
data model 'Actions’ [p 39] menu in the navigation pane. From there, you can view the details of the
publications and create new publications.

In certain cases, it may be necessary to employ several publications of the same data model, in order
to allow datasets to be based on different states of that data model. Multiple publications must be
handled carefully, as users will be asked to select an available publications to target when publishing
if more than one exists. The action to create a new publication is only available to users who belong
to the 'Administrator’ role.

To create a new publication, select 'Manage publications' from the data model 'Actions’ [p 39] menu
of the data model in the navigation pane, then click the Create publication button. The name you
give to the publication must unique in the repository.
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CHAPTER 13

Versioning an embedded data model

This chapter contains the following topics:
1. About versions

2. Accessing versions

3. Working with versions

4. Known limitations on data model versioning

13.1 About versions

You can create versions for data models that evolve in parallel. Versions are not to be confused with
data model snapshots, which are taken at publication time and kept strictly for historical read-only
reference.

13.2 Accessing versions

To see the existing versions of your data model, select 'Manage versions' from the data model
'Actions’ [p 39] menu of the data model.

The existing versions are represented in a tree format according to their parent-child relationships.
Every data model has a root version by default, with the same name as the data model.
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13.3 Working with versions

In the workspace, using the down arrow ™ menu next to each version, you can perform the following
actions:

Access data model version Go to the corresponding version of the data model.

Create version Creates a new version based on the contents of the selected
version. The new version is added as a child of the selected
version, though its contents bear no relation to those of its
parent version after creation.

Set as default version Sets the selected version as the default version opened when
users access the data model.

Export archive Exports the selected data model version to an archive
containing the version's content, including its permissions
and information. The exported archive is located in
the archives directory, which is accessible to repository
administrators. Exporting to an existing archive name will
overwrite the existing file.

See Archives directory [p 622] for more information.

Import archive Imports the content of an archive into the selected version.
The archive to import must contain a data model with the
same name as the data model associated with the version.

A version can be deleted by clicking the X button to the right of its entry. A version cannot be deleted
if it is linked to a publication or if it has child versions. The root version of a data model also cannot
be deleted.

Two versions of the same data model can be compared in the workspace by selecting their checkboxes,
then selecting Actions > Compare selected versions. The side-by-side comparison shows structural
differences between the version of the data model, with the older version on the left and the newer
version on the right.

13.4 Known limitations on data model versioning

+ It is not possible to merge two versions of a data model.
« The comparison interface does not display updates on fields, only additions and deletions.
 Versioning of data models packaged in modules is not supported.

« Resources packaged in a module that are used by an embedded data model are not versioned when
a version is created. That is, only the reference of the resources are saved during the creation of
a version, and it is the responsibility of developers to ensure that the content of the referenced
resources are compatible with any versions that may be using them.
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CHAPTER 14

Introduction to dataspaces

This chapter contains the following topics:
1. Overview

2. Using the Dataspaces area user interface

14.1 Overview

What is a dataspace?

The life cycle of data can be complex. It may be necessary to manage a current version of data while
working on several concurrent updates that will be integrated in the future, including keeping a trace
of various states along the way. In TIBCO EBX®, this is made possible through the use of dataspaces
and snapshots.

A dataspace is a container that isolates different versions of datasets and organizes them. A dataspace
can be branched by creating a child dataspace, which is automatically initialized with the state of
its parent. Thus, modifications can be made in isolation in the child dataspace without impacting its
parent or any other dataspaces. Once modifications in a child dataspace are complete, that dataspace
can be compared with and merged back into the parent dataspace.
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Snapshots, which are static, read-only captures of the state of a dataspace at a given point in time,
can be taken for reference purposes. Snapshots can be used to revert the content of a dataspace later,

if needed.
Snapshot Snapshot
DataSpace 2
[ Compare
— & Merge
' Snapshot
— o
Master Data Reference DataSpace
Repository -
N Snapshot Compare
& Merge
DataSpace 1
Compare

& Merge

DataSpace 1.1

Basic concepts related to dataspaces
A basic understanding of the following terms is beneficial when working with dataspaces:
« dataspace [p 32]

« snapshot [p 32]
« dataset [p 30]

» dataspace merge [p 32]

« reference dataspace [p 32]

14.2 Using the Dataspaces area user interface

Dataspaces can be created, accessed and modified in the Dataspaces area.

Note

This area is available only to authorized users in the 'Advanced perspective'.
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The navigation pane displays all existing dataspaces, while the workspace displays information about
the selected dataspace and lists its snapshots.

Dataspace D-5593 ?
» Master Data - Reference
Create a dataspace Actions -
¥ Samples
s :
» Workflow dentifier Tutorial
Dynamic data hierarchy Type Dataspace
Dynarmic data hierarchy - res Creation on 07/10/2013 at 12:32:34 by Doc. Adn
Status Open
History purge Marked for history purge by Doc. Admini
Owner Doc. Administrator (admin)
Loading strategy On-demand loading and unloading
Child merge policy Allows validation errors in result
Child dataspace sort policy By creation date (asc) .
1 »
See also

Creating a dataspace [p 101]

Snapshots [p 111]

Related concepts Datasets [p 116]
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CHAPTER 15

Creating a dataspace

This chapter contains the following topics:

1. Overview

2. Properties

15.1 Overview

To create a new dataspace, select an existing dataspace on which to base it, then click the Create a
dataspace button in the workspace.
Note
This area is available only to authorized users in the 'Advanced perspective'.
The new dataspace will be a child dataspace of the one from which it was created. It will be initialized

with all the content of the parent at the time of creation, and an initial snapshot will be taken of this
state.

Aside from the reference dataspace, which is the root of all dataspaces in the repository, dataspaces
are always a child of another dataspace.

15.2 Properties

The following information is required at the creation of a new dataspace:

Identifier Unique identifier for the dataspace.

Owner Owner of the dataspace, who is, by default, allowed to
modify its information and permissions. The owner does not
necessarily have to be the creator of the dataspace.

Label Localized label and description associated with the
dataspace.
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CHAPTER 16

Working with existing dataspaces

This chapter contains the following topics:

1. Dataspace information

Dataspace permissions

Merging a dataspace
Comparing a dataspace

Validating a dataspace

Dataspace archives

N ok DN

Closing a dataspace
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16.1 Dataspace information

Certain properties associated with a dataspace can be modified by selecting Actions > Information
from the navigation panel in the Dataspaces area.

Documentation Localized labels and descriptions associated with the
dataspace.
Child merge policy This merge policy only applies to user-initiated merge

processes; it does not apply to programmatic merges, for
example, those performed by workflow script tasks.

The available merge policies are:

« Allows validation errors in result: Child dataspaces
can be merged regardless of the validation result. This
is the default policy.

« Pre-validating merge: A child dataspace can only be
merged if the result would be valid.

Current Owner Owner of the dataspace, who is, by default, allowed to
modify its information and permissions. The owner does not
necessarily have to be the creator of the dataspace.

Child dataspace sort policy Defines the display order of child dataspaces in dataspace
trees. If not defined, the policy of the parent dataspace is
applied. Default is 'by label'.

Change owner Whether the current owner of the dataspace is allowed
to give ownership to another profile by modifying its
'Current owner' property. If the value is 'Forbidden', only an
administrator can modify the owner.

Change permissions Whether the current owner of the dataspace is allowed to
modify its permissions. If the value is 'Forbidden', only an
administrator can modify the permissions of the dataspace.
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16.2 Dataspace permissions

General permissions
Dataspace id The dataspace to which the permissions will apply.
Profile selection The profile to which the rule applies.
Restriction policy Whether these permissions restrict the permissions assigned
to a given user through policies defined for other profiles.
See Restriction policy [p 489].
Dataspace access The global access permission on the dataspace.

Read-only

« (Can see the dataspace and its snapshots, as well as child
dataspaces, according to their permissions.

« Can see the contents of the dataspace depending on
their permissions; cannot make modifications.

Write

« Can see the dataspace and its snapshots, as well as child
dataspaces, according to their permissions.

« Can modify the contents of the dataspace depending on
their permissions.

Hidden
« Cannot see the dataspace nor its snapshots directly.

« From a child dataspace, the current dataspace can be
seen but not selected.

« Cannot access the contents of the dataspace.

« Cannot perform any actions on the dataspace.
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Allowable actions

Users can be allowed to perform the following actions:

Create a child dataspace Whether the profile can create child dataspaces.

Create a snapshot Whether the profile can create snapshots from the
dataspace.

Initiate merge Whether the profile can merge the dataspace with its parent.

Export archive Whether the profile can perform exports.

Import archive Whether the profile can perform imports.

Close dataspace Whether the profile can close the dataspace.

Close snapshot Whether the profile can close snapshots of the dataspace.

Rights on services Specifies the access permissions for services.

Permissions of child dataspaces  Specifies the default access permissions for child dataspaces
when created that are created from the current dataspace.

16.3 Merging a dataspace

When the work in a given dataspace is complete, you can perform a one-way merge of the dataspace
back into the dataspace from which it was created. The merge process is as follows:

1. Both the parent and child dataspaces are locked to all users, except the user who initiated the
merge and administrator users. These locks remain for the duration of the merge operation. When
locked, the contents of a dataspace can be read, but they cannot be modified in any way.

Note: This restriction on the parent dataspace means that, in addition to blocking direct
modifications, other child dataspaces cannot be merged until the merge in progress is finished.

2. Changes that were made in the child dataspace since its creation are integrated into its parent
dataspace.

3. The child dataspace is closed.

4. The parent dataspace is unlocked.

Initiating a merge
To merge a dataspace into its parent dataspace:
1. Select that dataspace in the navigation pane of the Dataspaces area.

2. In the workspace, select Merge dataspace from the Actions menu.
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Reviewing and accepting changes

After initiating a dataspace merge, you must review the changes that have been made in the child
(source) dataspace since its creation, to decide which of those changes to apply to the parent (target)
dataspace.

Note

This change set review and acceptance stage is bypassed when performing merges
using data services or programmatically. For automated merges, all changes in the child
dataspace override the data in the parent dataspace.

The change acceptance process uses a side-by-side comparison interface that recapitulates the changes
that require review. Two change set columns are obtained by taking the relevant changes from the
following dataspace state comparisons:

+ The current child dataspace compared to its initial snapshot.
» The parent dataspace compared to the initial snapshot of the child dataspace.

By default, all detected changes are selected to be merged. You may deselect any changes that you
want to omit from the merge. You can view the changes relevant to different scopes in your data model
by selecting elements in the navigation pane.

In order to detect conflicts, the merge involves the current dataspace, its initial snapshot and the parent
dataspace, because data is likely to be modified both in the current dataspace and its parent.

The merge process also handles modifications to permissions on tables in the dataspace. As with other
changes, access control changes must be reviewed for inclusion in the merge.

When you have decided which changes to merge for a given scope, you must click the button Mark
difference(s) as reviewed to indicate that you have reviewed all the changes in that scope. All changes
must be reviewed in order to proceed with the merge.

Types of modifications

The merge process considers the following changes as modifications to be reviewed:
» Record and dataset creations
» Any changes to existing data
« Record, dataset, or value deletions

» Any changes to table permissions

Types of conflicts

This review interface also shows conflicts that have been detected. Conflicts may arise when the same
scope contains modifications in both the source and target dataspaces.

Conflicts are categorized as follows:
« A record or a dataset creation conflict
« An entity modification conflict
« A record or dataset deletion conflict

« All other conflicts
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Finalizing a merge

Once you have reviewed all changes and decided which to include in the merge result, click on the
Merge >> button in the navigation pane.

Depending on the child merge policy that is configured on the parent dataspace in your merge, the
subsequent process may differ. By default, merges are finalized even if the result would contain
validation errors. The administrator of the parent dataspace in your merge can set its child merge policy
so that merges of its children are only finalized if the result would not contain any validation errors.

If, however, the administrator of the parent dataspace has set its child merge policy to 'Pre-validating
merge', a dedicated dataspace is first created to hold the result of the merge. When the result is valid,
this dedicated dataspace containing the merge result is automatically merged into the parent dataspace,
and no further action is required.

In the case where validation errors are detected in the dedicated merge dataspace, you only have access
to the original parent dataspace and the dataspace containing the merge result, named "[merge] <
name of child dataspace >". The following options are available to you from the Actions > Merge
in progress menu in the workspace:

« Cancel, which abandons the merge and recuperates the child dataspace in its pre-merge state.

« Continue, which you can use to reattempt the merge after you have made the necessary
corrections to the dedicated merge dataspace.

Setting the child merge policy of a dataspace

As the administrator of a dataspace, you can block the finalization of merges of its child dataspaces
through the user interface when the merges would result in a dataspace with validation errors. To do
so, select Actions > Information from the workspace of the parent dataspace. On the dataspace's
information page, set the Child merge policy to Pre-validating merge. This policy will then be
applied to the merges of all child dataspaces into this parent dataspace.

Note

When the merge is performed through a Web Component, the behavior of the child
merge policy is the same as described; the policy defined in the parent dataspace is
automatically applied when merging a child dataspace. However, this setting is ignored
during programmatic merge, which includes script tasks in data workflows.

See also Child merge policy [p 108]

Abandoning a merge

Merges are performed in the context of a user session, and must be completed in a single operation.
If you decide not to proceed with a merge that you have initiated, you can click the Cancel button
to abandon the operation.

If you navigate to another page after initiating a merge, the merge will be abandoned, but the locks
on the parent and child dataspaces will remain until you unlock them in the Dataspaces area.

You may unlock a dataspace by selecting it in the navigation pane, and clicking the Unlock button
in the workspace. Performing the unlock from the child dataspace unlocks both the child and parent
dataspaces. Performing the unlock from the parent dataspace only unlocks the parent dataspace, thus
you need to unlock the child dataspace separately.
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16.4 Comparing a dataspace

You can compare the contents of a dataspace to those of another dataspace or snapshot in the repository.
To perform a comparison, select the dataspace in the navigation pane, then select Actions > Compare
from the workspace.

The comparison wizard prompts you to select the dataspace or snapshot with which to compare the
current dataspace.

For a faster comparison that ignores fields with inherited and computed values, select the filter
'Persisted values only'.

See also Compare contents [p 427]

16.5 Validating a dataspace

To perform a global validation of the contents of a dataspace, select that dataspace in the navigation
panel, then select Actions > Validate in the workspace.

Note

This service is only available in the user interface if you have permission to validate
every dataset contained in the current dataspace.

16.6 Dataspace archives

The content of a dataspace can be exported to an archive or imported from an archive.

Exporting

To export a dataspace to an archive, select that dataspace in the navigation panel, then select Actions
> Export in the workspace. Once exported, the archive file is saved to the file system of the server,
where only an administrator can retrieve the file.

Note

See Archives directory [p 622] in the Administration Guide for more information.
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In order to export an archive, the following information must be specified:

Name of the archive to create

The name of the exported archive.

Export policy

Required.

The default export policy is 'The whole content of the
dataspace', which exports all selected data to the archive.

It may be useful to export only the differences between the
dataspace and its initial snapshot using a change set. There
are two different export options that include a change set:
'"The updates with their whole content' and 'The updates
only'. The first option exports all current data and a change
set containing differences between the current state and the
initial snapshot. The second option only exports the change
set. Both options lead to a comparison page, where you
can select the differences to include in this change set.
Differences are detected at the table level.

Datasets to export

The datasets to export from this dataspace. For each
dataset, you can export its data values, permissions, and/or
information.

Importing

To import content into a dataspace from an archive, select that dataspace in the navigation panel, then

select Actions > Import in the workspace.

If the selected archive does not include a change set, the current state of the dataspace will be replaced

with the content of the archive.

If the selected archive includes the whole content as well as a change set, you can choose to apply the

change set in order to merge the change set differences with the current state. Applying the change

set leads to a comparison screen, where you can then select the change set differences to merge.

If the selected archive only includes a change set, you can select the change set differences to merge

ona comparison screein.

16.7 Closing a dataspace

If a dataspace is no longer needed, it can be closed. Once it is closed, a dataspace no longer appears
in the Dataspaces area of the user interface, nor can it be accessed.

An administrator can reopen a closed dataspace as long as it has not been cleaned from the repository.

To close a dataspace, select Actions > Close this dataspace .

See also Closing unused dataspaces and snapshots [p 625]

TIBCO EBX® Product Documentation 6.2.0 110



Documentation > User Guide > Dataspaces > Snapshots

CHAPTER 17

Snapshots

This chapter contains the following topics:

1. Overview of snapshots

Creating a snapshot

Viewing snapshot contents

Snapshot information

Comparing a snapshot

Validating a snapshot

Export
Closing a snapshot

©® N ek~ N

17.1 Overview of snapshots

A snapshot is a read-only copy of a dataspace. Snapshots exist as a record of the state and contents
of a dataspace at a given point in time.

See also Snapshot [p 32]

17.2 Creating a snapshot

A snapshot can be created from a dataspace by selecting that dataspace in the navigation pane of the
Dataspaces area, then selecting Actions > Create a Snapshot in the workspace.

The following information is required:

Identifier Unique identifier for the snapshot.
Label Localized labels and descriptions associated with the
snapshot.
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17.3 Viewing snapshot contents

To view the contents of a snapshot, select the snapshot, then select Actions > View datasets from
the workspace.

17.4 Snapshot information

You can modify the information associated with a snapshot by selecting Actions > Information.

Documentation Localized labels and descriptions associated with the
snapshot.
Current Owner Owner of the snapshot, who is, by default, allowed to

modify its information and permissions. The owner does not
necessarily have to be the creator of the snapshot.

Change owner Whether the current owner of the snapshot is allowed
to give ownership to another profile by modifying its
'Current owner' property. If the value is 'Forbidden', only an
administrator can modify the owner.

17.5 Comparing a snapshot
You can compare the contents of a snapshot to those of another snapshot or dataspace in the repository.
To perform a comparison, select the snapshot, then select Actions > Compare from the workspace.

The comparison wizard prompts you to select the dataspace or snapshot with which to compare the
current snapshot.

For a faster comparison that ignores fields with inherited and computed values, select the filter
'Persisted values only'.

See also Compare contents [p 427]

17.6 Validating a snapshot

To perform a global validation of the contents of a snapshot, select Actions > Validate in the
workspace.

Note

In order to use this service, you must have permission to validate every dataset contained
in the snapshot.
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17.7 Export

To export a snapshot to an archive, open that snapshot, then select Actions > Export in the workspace.
Once exported, only an administrator can retrieve the archive.

Note

See Archives directory [p 622] in the Administration Guide for more information.

In order to export an archive, the following information must be specified:

Name of the archive to create The name of the exported archive.

Datasets to export The datasets to export from this snapshot. For each
dataset, you can choose whether to export its data values,
permissions, and information.

17.8 Closing a shapshot

If a snapshot is no longer needed, it can be closed. Once it is closed, a snapshot no longer appears
under its associated dataspace in the Dataspaces area, nor can it be accessed.

An administrator can reopen a closed dataspace as long as it has not been cleaned from the repository.

To close a snapshot, select Actions > Close this snapshot.

See also Closing unused dataspaces and snapshots [p 625]
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CHAPTER 18

Introduction to datasets

This chapter contains the following topics:
1. Overview

2. Using the Data user interface

18.1 Overview

What is a dataset?

A dataset is a container for data that is based on the structural definition provided by its underlying data
model. When a data model has been published, it is possible to create datasets based on its definition. If
that data model is later modified and republished, all its associated datasets are automatically updated
to match.

In a dataset, you can consult actual data values and work with them. The views applied to tables allow
representing data in a way that is most suitable to the nature of the data and how it needs to be accessed.
Searches and filters can also be used to narrow down and find data.

Different permissions can also be accorded to different roles to control access at the dataset level.
Thus, using customized permissions, it would be possible to allow certain users to view and modify
a piece of data, while hiding it from others.

Basic concepts related to datasets
A basic understanding of the following terms is beneficial when working with datasets:
« dataspace [p 32]
« dataset [p 30]
« record [p30]
« fieldp29]
» primary key [p29]
« foreign key [p29]
« table (in dataset) [p 30]

e group [p29]
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18.2 Using the Data user interface

Datasets can be created, accessed and modified in the Data area using the Advanced perspective [p 21]
or from a specifically configured perspective. Only authorized users can access these interfaces.

D-S 593 - -;-:‘: Dataspace selector | ?

F 5

Book store __ Dataset selector ‘_.|

N Y
Actions ~ [ Dataset actions &
7| services menu

Titles
Publishers
Authors
Royalties
Workspace

Contracts

Navigation pane

Select or create a dataset using the 'Select dataset' menu in the navigation pane. The data structure of
the dataset is then displayed in the navigation pane, while record forms and table views are displayed
in the workspace.

When viewing a table of the dataset in the workspace, the button Q displays searches and filters that
can be applied to narrow down the records that are displayed.

Operations at the dataset level are located in the Actions menu in the navigation pane (services are
available at the bottom of the list).

See also

Creating a dataset [p 119]

Quick Search [p 122]

Working with records in the user interface [p 141]

Inheritance [p 31]

Related concepts

Data model [p 38]

Dataspace [p 98]
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CHAPTER 19

Creating a dataset

This chapter contains the following topics:

1. Creating a root dataset

2. Creating an inheriting child dataset

19.1 Creating a root dataset

To create a new root dataset, that is, one that does not inherit from a parent dataset, select the 'Select

dataset[p117] T menu in the navigation pane, click the 'Create a dataset' button in the pop-up, and
follow through the wizard.

Note

This area is available only to authorized users in the 'Advanced perspective' or from a
specifically configured perspective.

The wizard allows you to select one of three data model packaging modes on which to base the new
dataset: packaged, embedded, or external.

» A packaged data model is a data model that is located within a module, which is a web application.

» An embedded data model is a data model that is managed entirely within the TIBCO EBX®
repository.

After locating the data model on which to base your dataset, you must provide a unique name, without
spaces or special characters. Optionally, you may provide localized labels for the dataset, which will
be displayed to users in the user interface depending on their language preferences.

Attention
Table contents are not copied when duplicating a dataset.
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19.2 Creating an inheriting child dataset

The inheritance mechanism allows datasets to have parent-child relationships, through which default
values are inherited from ancestors by descendants. In order to be able to create child datasets, dataset
inheritance must be enabled in the underlying data model.

To create a child dataset, select the 'Select dataset[p117]' ~ menu in the navigation pane, then click
the * button next to the desired parent dataset.

As the dataset will automatically be based on the same data model as the parent dataset, the only
information that you need to provide is a unique name, and optionally, localized labels.

See also Dataset inheritance [p 159]
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cHAPTER 20

Viewing data

TIBCO EBX® offers different ways to list records. This chapter presents how to sort, search, and
display records in varying ways, and according to different user profiles, through to the concept of
'Views'.

This chapter contains the following topics:

1.

N kW

'View' menu
Sorting data
Quick Search

Searching and filtering data
Views

Views management

Grid edit
History

20.1 'View' menu

The 'View' drop-down menu allows accessing all available views and management features.

Views are managed directly in the 'View' menu toolbar, available on each listed view: 'View' menu
toolbar [p 138].

Views can also be grouped. An administrator has to beforehand define groups in 'Views configuration'
under the 'Groups of views' table. The end-user can then set a view as belonging to a group, through
the field "View group' upon creation or modification of the view. See 'View description' [p 127] for
more information.

20.2 Sorting data

Sort criteria control the order in which records are presented.

Use the 'Select and Sort' button at the top left of the table to define specific sorting criteria.

There are two types of sorting:

sorting by relevance, used in the quick search [p 122],

sorting by column.
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Sorting by column
The 'Sorting criteria' dialog box offers:
« on the left, the list of sorted columns,
« on the right, the list of unsorted columns.

Use the — — arrow buttons to toggle columns from one list to another.
Use the 1 | arrow buttons to change the priority order of the column.

To change the sort order of a column, use the 'ASC' (ascending) or 'DESC' (descending) button that
appears on the mouse-over.

20.3 Quick Search

Table

+ Actions = (C'\ V)

= Id ~  Legal Id MName Business Description Category Parent

The quick search is used to easily find a result in a tabular, a hierarchical, or a tile view.

It does not differentiate between upper and lower case. It allows you to search for several terms at
once (separated by spaces). By default, the records found are sorted by relevance. This search includes
all searchable columns, even those that are not visible. When the quick search is not possible for a
column, it is indicated by an icon when hovering over the column header.

See also Search [p 499]
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Special characters

The quick search offers special characters to refine your search on strings. Please note that columns
that are not string-based do not support this syntax, and certain search strategies such as 'Code’ does
not support it either.

+... required Makes it required that the word be present in the result.
Prevents the search engine from excluding this word from
the search.

Note

Works with +"phrase" or +(group).
Example:
+flute +bach

L Finds results with required flute and required bach.
Results with only flute or only bach will be ignored.

-... hot Excludes the word from the result.

Note
Works with -"phrase" or - (group).

Example:

bach -flute

L Find results with bach, but without flute.

«.~fuzzy Specifies that the search can change 2 characters of the word
to find it.

To allow for a single character to change, use ~1.

Note
Works with "phrase"~, to change 2 words in
the phrase.

Example:

handel~

L. Find results with a word that is handel, with 1 or 2 letters
differing.

2single joker Replaces an unknown character.
Example:

?2uttle
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L Finds results with a word starting with any character, and
ending with uttle.

*extended joker Replaces several unknown characters.
Example:

rachmanino*

L Find results with a word beginning with rachmanino.

"..."phrase Find the exact match of the phrase.

Note

Can be surrounded by +-~.

Example:

"Johann Sebastian Bach"

L Find results containing exactly Johann Sebastian Bach.

(...)group Allows grouping words to apply a special character + or -
to them.

Note

You can make groups of groups.
Example:
bach +(flute piano)

L Find the results with possibly bach, and necessarily flute
or piano.

Note

These special characters can also be used in the documentation search engine.

20.4 Searching and filtering data

The search pane is hidden by default and accessible via the ™ icon located to the right of the quick
search in the toolbar of the tabular, the hierarchical or the tile view.

The quick search and the criteria lines combine to narrow the search (restricting the result to fewer
and fewer records).

It is possible to deactivate a criteria line by unchecking it. The deactivated criteria are not kept during
a save.

The trashcan button W at the end of the line of each criterion permanently deletes the criterion.

To save the filter applied to a search, use the 'Save' button. Saving takes into account the quick search
and all active criteria.
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To recall a saved filter, use the '"Load' button. Loading replaces the quick search and the whole criteria
panel. Click on the 'Apply' button to start the new search.

When a view is applied, it ensures that it is displayed according to its configuration. All existing
criteria in the search panel are therefore removed. The view can contain a set of search criteria, which
are applied together with the at the same time as the view.

Some operators (such as 'text-search'’) allow to use Lucene regular expressions. See _technical
specifications of Lucene's regex pattern for more information.

Search on a field

All searchable fields are available, except those of type osd:locale which are not defined as
enumerations, and those of type osd:resource.

Validation filter

In field selection, the validation criteria display the records as of the last validation performed.

Note

This filtering only applies to records of the table that have been validated at least once
by selecting Actions > Validate at the table level from the workspace, or at the dataset
level from the navigation pane.

To filter on the validation severity level (independent from validation Message), use the 'Severity'
validation criterion. Available levels are: 'Errors', 'Warnings' and 'Information'.

To filter on the validation message (independent from validation Severity level), use the 'Message'
validation criterion.

Create complex filters

Use multiple criteria grouped by logical operator to create complex filters. The groups display in a tree
view that utilizes a variety of features to streamline the construction of even the most complex filters.

For example, take a record where Bob and Smith are values passed to the filter in the Name and
Surname fields, respectively. If the contains condition is used for both fields, the logical operators
impact record filtering as follows:

« AND: restricts the search, as a record must meet all of the criteria in this group to display. Only
a record that has Bob Smith displays in the results.

« OR: broadens the search, as a record only needs to meet one of the criteria in this group to display.
Any record displays where the Name field includes Bob, or the Surname field includes Smith.
For example, results might include Jon Smith and Bob Jones.

« NOT: inverts a group or criterion so that the opposite conditions from those specified must be
met to display the record.

« NOT AND: All records that are not Bob Smith are returned.

« NOT OR: Only records that do not have Bob or Smith are returned. For example, Peter Jones
and Mary Stewart.

« NOT applied to a single criterion: Reverses the condition for that criterion only. For example,
if the group's condition is AND, and NOT was applied to the Surname field, the Bob Smith
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record would be excluded from results as only records that do not contain Smith in the
Surname field are returned.

The following table describes actions available when working with groups:

Select an operator Toggle between the AND and OR operators.

Mouse hover: On operators allows you to select the following:
« NOT to invert the group.

to duplicate the group.

9 o ungroup the criteria.

On individual criterion hover to select NOT and invert the
condition applied to that criterion.

Drag and drop Drag lines connected to criteria:
« Up/down to reorder within the containing group.

« To another criterion in the same group to create a new
subgroup.

« To a different operator to move the criterion to that
group.

Group criteria button Use this button to enable group edit. Select the checkboxes
next to criteria you want to group. Note that action moves
the selected criteria to the new group.

Custom table searches
For backward compatibility, the feature for custom searching and filtering records is still operational

and accessible via the icon Y in the workspace. The icon and feature are only available when at least
one custom filter exists.

Additional custom filters can be specified for each table in the data model.

See also Customizing table filter [p 964]

Technical limitation

Optimized text search filters cannot be combined using the OR operator with non-optimized filters,
or filters that involve a different table.

Typical examples of this situation could be a text search with an OR filter on:
« An inherited field.
» A computed value without a local dependency.
+ A field from a different table (e.g. a linked field).

This technical limitation displays as "The request cannot be resolved since a "text search" operator is
inside an "OR" group" (technical limitation).
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20.5 Views

It is possible to customize the display of tables in EBX® according to the target user. There are three
types of views: tabular [p 128], hierarchical [p 128] and tiles [p 135].

A view can be created by selecting View > Create a new view in the workspace. To apply a view,
select it in View > name of the view.

Three types of views can be created:
« 'Simple tabular view": A table view to sort and filter the displayed records.
» 'Hierarchical view": A tree view that links data in different tables based on their relationships.

» 'Tile view": A view which displays the records in the form of cards that are positioned in rows
and columns. This view allows to show information in an eye catching form, sort, and filter the

records displayed.
View description
When creating or updating a view, the first page allows specifying general information related to the
view.
Documentation Localized label and description associated with the view.
Owner Name of the owner of the view. This user can manage and
modify it. (Only available for administrators and dataset
owners)
Share with Other profiles allowed to use this view from the 'View'
menu.
Note
Requires a permission, see Views permissions
[p 644].
View mode Simple tabular view, hierarchical view or tile view.
View group Group to which this view belongs (if any).
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Simple tabular views

Simple tabular views offer the possibility to define criteria to filter records and also to select the
columns that will be displayed in the table.

Displayed columns Specifies the columns that will be displayed in the table.
Sorted columns Specifies the sort order of records in the table. See Sorting

data [p 121].

Filter Defines filters for the records to be displayed in this table
view.

See Criteria editor [p 497].

Initial request When set to manual, users of this view will have to apply a
filter or a sort criteria before they can view data.

Pagination limit Forces a limit to the number of visible records.

Grid edit If enabled, users of this view can switch to grid edit, so that
they can edit records directly from the tabular view.

Disable create and duplicate If yes, users of this view cannot create nor duplicate records
from the grid edit.

Toolbar on top of table Defines the toolbar to use on top of this table view.

Toolbar on table row Defines the toolbar to use on each row of this table view.

Hierarchical views

A hierarchy view displays your data in a tree-like representation. Use hierarchy views to visualize
different relationships between data, or to group common values. To create a hierarchy view, you
define a dimension that determines what data will be included and how it displays. Consider the
following example and image where the dimension is Category --> Brand --> Product and displays
Products by Brand by Category.

D Grocery

¥ D Household #————— Cat:

Category Brand Product

v

Brand

~ @ ACME

0 1--ACME Pods < Praduct

O 2--ACME Powder
0 3--ACME C Liquid
0 4--ACME Liguid
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Hierarchy dimensions and members

Each hierarchy is defined by its dimension. The dimension is subdivided into dimension levels.
Members are hierarchy nodes and represent a record, or a field value. A member can be a parent of
other members, or a leaf node with no children. The table from which you create the hierarchy view
is called the target table. Members of the target table are lowest-level leaves, except in the case of
a recursive hierarchy.

In the following image:

» Grocery and Household are members of the Category dimension level. This is the top dimension
level.

« ACME is a member of the Brand dimension level and is at an intermediate level. A dimension
can have many intermediate levels.

+ The individual products listed at the Product dimension level are leaf members from the target
table. This is the bottom dimension level.

> @ Grocery

¥ @ Household «———————— Category

v (D ACME = Brand
Q 1--ACME Pods = Product
O 2--ACME Powder
O 3--ACME C Liquid
O 4--ACME Liquid

Creating a hierarchy view

This topic provides high-level instructions for creating a hierarchy view. See the following topics for
additional details about creating views of specific hierarchy types:

« Ragged hierarchies [p 130]

o Group by hierarchies [p 131]

o Time-based hierarchy dimensions [p 132]

To create a hierarchy view:
1. From the target table's Actions menu, select Create a new view.
2. After specifying the following information, click Next:
+ Add any view-related documentation such as a label and description.
« Set access permissions.
« For the View mode property, select Hierarchical view.

3. Use the Dimension box to define the hierarchy by working backwards through the dimension
levels:

1. Bottom level: The members of this level are pre-determined based on the target table.
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2. Intermediate levels: Start with the attribute that corresponds to the next highest dimension
level and continue to expand until you navigate to the highest level.

3. Top level: Select the attribute corresponding to the top dimension level.
4. Review the required options and after making desired changes, click Next.
5. Specify labels, filters, and sort options for the members of each dimension level:

« Navigate between dimension levels by selecting them in the breadcrumb at the top of the
screen.

» Make adjustments to labels, filters, and sort strategies as desired.

6. Click Save and quit to display the hierarchy view.

Ragged hierarchies

A ragged hierarchy includes members where their parent skips one level. An example of this type
of hierarchy is shown by using the Country, State, and City dimension. Some countries do not have
states, but they all have cities. In the case of the latter, the city members directly roll up to the Country
dimension level.

Attention
A ragged hierarchy only supports skipping one level.

To display ragged hierarchies in EBX®:

 In the data model, you must define all foreign key relationships from the target table. Using the
example above, the City table must hold a foreign key to the State and Country tables. Of course,
for cities with no state, this field is left undefined.
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« When configuring your hierarchy view, enable the Allow skipping level option under Advanced
properties. This property is highlighted in the image below:

Dimension v * Store
=  OCityFK (ea City)
v @ CityMName
> @ O Creator
o @ O Last updater
v @ CountryFK (=2 Country)
Display records in a new window * Yes @ No
Prune hierarchy " Yes * No
Display orphans " ®Yes _'No
Display root node * ®¥es 'No
Root node label = English (United States)
French (France)
lang
rmxml
Toolbar on top of hierarchy [not defined] -
Advanced properties -
Remove recursive root leaves - Yes ® No
Detect cycle - Yes ® No
Allow skipping level - LS Mo
Detect leaf " * Yes _ No
Allow children count - Yes ® MNo

Group by hierarchies

The dimension in a Group By hierarchy is defined using columns located in the same table. Allowed
column data types are foreign keys or the following enumerable types: String, Integer, Enumeration,
and Boolean. This provides a powerful tool for defining hierarchy views that group common values
together. A group by hierarchy also provides flexibility when setting the order for dimension levels.
For example, a Product table might include the following columns: Brand, Segment, Type, and
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Packaging. Use these columns in any order to show products by: Segment --> Type --> Packaging,

or Brand --> Segment --> Type --> Packaging.

By segment

- _ _Brand

Actions =

= @ [ All elements |
¥ @ Grocery
¥ (D Snacks
* (D Can
© 8--P-Chips Trad
© 10--P-Chips Salt N Ving
O 11--Pringles Spicy
* () Snack Size
© 9--P-Chips Short Stack
* ) Household
¥ (D Laundry Det
* (D Liquid
© 3--ACME C Liquid
© 4--ACME Liquid
> () Pods
> () Powder

Actions «

* @ [ Al elements |
¥ @ ACME
¥ (D) Household
* (D Laundry Det
- (@ Liquid
© 3--ACME C Liquid
O 4--ACME Liquid
> (@ Pods
* (1) Powder
¢ @ Charming
* ) P-Chips
= (D Grocery
¥ (I Snacks
= (@ Can
© 8--P-Chips Trad
© 10--P-Chips Salt N Ving
" (1 Snack Size

Time-based hierarchy dimensions

Use fields with a Date data type to define a time-based hierarchy dimension. When configuring the
view, choose from several predefined display options. Some options subdivide the time into smaller
units. For example, you can specify that a project's Due Date field is used to display all project

deadlines by month in Q1 of 2022.

To use a time-based dimension in a hierarchy view:

1. Create a new hierarchy view configuration:

1. When viewing a table, open the View menu and select Create a new view.

2. Provide a name and optionally specify share options.

3. For the View mode, select Hierarchical view and click Next.

2. Ensure the field used for the hierarchy's root dimension is of the Date data type and click Next.
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3. Click on the Date field at the top of the screen in the hierarchy structure breadcrumb and use the
Time dimension menu to specify how you want the dimension to display.

@EMSED / © project / © deadline

Actions *

Time dimension

- = @ [ All elements |

[not defined]

Century

Year

Year, Quarter

Year, Quarter, Month, Date
Year, Month

Year, Month, Date

v O 2022
/ voa1
= ) January
> (D Product A
v @ Product D
0 February
® March
0Q2

oaQ:
voqq.

4. Save and view the hierarchy.
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Hierarchical view configuration options

This form allows configuring the hierarchical view options.

Display records in a new window If 'Yes', a new window will be opened with the record.
Otherwise, it will be displayed in a new page of the same
window.

Prune hierarchy If "Yes', hierarchy nodes that have no children and do not
belong to the target table will not be displayed.

Display orphans If "Yes', hierarchy nodes without a parent will be displayed.

Display root node If 'No', the root node of the hierarchy will not be displayed
in the view.

Root node label Localized label of the hierarchy root node.

Toolbar on top of hierarchy Allows setting the toolbar on top of the hierarchy.

Detect cycle Allow cycle detection and display in a recursive case,

the oldest node record will be chosen as the cycle root.
Limitation: does not work in search or pruned mode.

Detect leaf Allows detecting whether the member is a leaf or not. The
leaf detection is very costly for large volumes of data. Thus,
it is recommended to disable this option when the query
response is delayed to display the hierarchy view. This
property is always disabled for orphans' parent members.

Labels

For each dimension level that references another table, it is possible to define localized labels for the
corresponding nodes in the hierarchy. The fields from which to derive labels can be selected using
the built-in wizard.

Filter

The criteria editor allows creating a record filter for the view.
See also Criteria editor [p 497]

Sort strategy
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For each dimension level, it is possible to choose one of the following sort strategies:

Default Nodes are sorted by label in alphabetical order

Sort by columns Nodes are sorted by selected column(s). The direction
(ascending/descending) can be chosen for each column.

Sort by ordering field Nodes are sorted by a hidden numeric field, which allows
users to dynamically change the order of sibling nodes in
the hierarchy view. This strategy is available only if there is
at least one 'Hidden' numeric field in the table.

In order to enable this option, you must designate an eligible
ordering field defined in the table on which the hierarchical
view is applied. An ordering field must have the 'Integer’
data type and have a 'Hidden' default view mode in its
advanced properties in the data model definition.

Except when the ordering field is in 'read-only' mode or
when the hierarchy is filtered, any field can be repositioned.

Attention

Do not designate a field that is meant to contain data as
an ordering node, as the data will be overwritten by the
hierarchical view.

Actions on hierarchy nodes

Each node in a hierarchical view has amenu ~ containing contextual actions.

Leaf nodes can be dissociated from their parent record, using 'Detach from parent'. The record then
becomes an orphan node in the tree, organized under a container "unset" node.

Leaf nodes can also change parent nodes, using 'Attach to another parent'. If, according to the data
model, a node can have relationships to multiple parents, the node will be both under the current
parent and added under the other parent node. Otherwise, the leaf node will be moved under the other
parent node.

Tile views

This view displays records as tiles arranged in a grid. Each tile and can include the following
information: Title (required), Subtitle, Image, and description. For the titles and description you can:
select fields to automatically populate the values, manually specify the text that displays, or use a
combination of both methods. Additionally, you can define sort and filter criteria that applies to the
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view. Toolbars can also be added. The following table lists and defines the properties available when

creating a tile view:

Title Defines the tile title displayed on first line.
Subtitle Defines the subtitle displayed on second line.
Image Defines the tile image.

Image > Default image URL

Defines the fallback image URL.

Image > URL

Defines the image URL.

Image > Height (px)

Sets the height of the image slot in pixels (between 10
and 250). The slot width will always be 180 pixels. If the
dimensions of the image exceed the size of the intended slot,
it will be adjusted according to the cropping rules defined
by the view.

Image > Cropping

Defines the cropping of the image. If "Cover", the image
will be scaled up or down so that occupy all the available
space. In this case, the image might be truncated. If "Scale
down", the image will be scaled down only if it overflows
the available space. Whatever the value, the image will
always be centered.

Tile description

Defines the tile text.

Tile description > Number of
displayed lines

Defines the number of lines (between 3 and 6).

Tile description > Line wrap

If "Yes", each row is displayed entirely (with line wrap) up
to the defined limit of the number of lines. The excess is
then truncated. If "No", each line is truncated.

Tile description > Content

Defines the tile text content.

Sort criteria

Specifies the sort order of records in the view. See Sorting
data [p 121].

Filter

Defines filters for the records to be displayed in this tile
view.

See Criteria editor [p 497].

Toolbar on top of table

Defines the toolbar to use on top of this table view.

TIBCO EBX® Product Documentation 6.2.0 136



Documentation > User Guide > Datasets > Viewing data

Tile toolbar Defines the toolbar to use on each item of this tile view.

View sharing

Users having the 'Share views' permission on a view are able to define which users can display this
view from their "View' menu.

To do so, simply add profiles to the 'Share with' field of the view's configuration screen.

View publication
Users having the 'Publish views' permission can publish views present in their 'View' menu.

A published view is then available to all users via Web components, workflow user tasks, data services
and perspectives. To publish a view, go to the 'View menu', click on the Edit button displayed on the
mouseover of a listed view and add a 'Publication name' to the view.

20.6 Views management

Manage recommended views

When a user logs in with no view specified, their recommended view (if any) is applied. Otherwise,
the default view is applied. The 'Manage recommended views' action allows defining assignment rules
of recommended views depending on users and roles.

Available actions on recommended views are: change order of assignment rules, add a rule, edit
existing rule, delete existing rule.

Thus, for a given user, the recommended views are evaluated according to the user's profile: the applied
rule will be the first that matches the user's profile.

Note

The 'Manage recommended view' feature is only available to dataset owners.
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'View' menu toolbar

The 'View' menu toolbar offers the following actions:

Edit Click on the 'Edit' button of the targeted view's toolbar to
access the editable form.

Duplicate Click on the 'Duplicate' button of the targeted view's toolbar
to duplicate the view. The new view creation form pre-
populates the field values from the view being duplicated.

Delete Click on the 'Delete' button of the targeted view's toolbar to
delete the view.

Define this view as my favorite Click on the "Define this view as my favorite' button of the
targeted view's toolbar. The favorite view will automatically
be applied when accessing the table. Click a second time on
the button to remove the view as the user's favorite view.

20.7 Grid edit

The grid edit feature allows modifying data in a table view. This feature can be accessed by clicking
on the £ button.

Accessing the grid edit from a table view requires that the feature be previously activated in the view
configuration.

See also Grid edit [p 128]

Copy/paste

The copy/paste of one or more cells into another one in the same table can be done through the Edit
menu. It is also possible to use the associated keyboard shortcuts Ctrl+C and Ctrl+V.

This system does not use the operating system clipboard, but an internal mechanism. As a
consequence, copying and pasting a cell in an external file will not work. Conversely, pasting a value
into a table cell won't work either.

All simple type fields using built-in widgets are supported.

20.8 History

The history feature allows tracking changes on master data.

The history feature must have been previously enabled at the data model level. See Advanced
properties for tables [p 63] for more information.

To view the history of a dataset, select Actions > History in the navigation pane.

To view the history of a table or of a selection of records, select Actions > View history in the
workspace.
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Several history modes exist, which allow viewing the history according to different perspectives:

History in current dataspace The table history view displays operations on the current
branch. This is the default mode.

History in current dataspace The table history view displays operations on the current
and ancestors branch and on all its ancestors.

History in current dataspace The table history view displays operations on the current
and merged children branch and on all its merged children.

History in all dataspaces The table history view displays operations on the whole

branch hierarchy.

In the history view, use the VIEW menu in order to switch to another history mode.

See also History [p 451]
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CHAPTER 21

Editing data

This chapter contains the following topics:

1. Working with records in the user interface

2. Importing and exporting data

3. Restore from history

21.1 Working with records in the user interface

Record editing takes place in the workspace portion of the user interface.

Note

This action is available only to authorized users in the 'Advanced perspective' or from
a specifically configured perspective.

Creating a record

In a tabular or a tile view, click the * button located above the table.

In a hierarchical view, select 'Create a record' from the menu of the parent node under which to create
the new record.

Next, enter the field values in the new record creation form. Mandatory fields are indicated by
asterisks.

Updating an existing record
Double-click the record to update, then edit the field values in the record form.

To discard any changes in progress and restore the fields to their values before editing, click the Revert
button.

Duplicating a record
To duplicate a selected record, select Actions > Duplicate.

A new record creation form pre-populates the field values from the record being duplicated. The
primary key must be given a unique value, unless it is automatically generated (as is the case for auto-
incremented fields).
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Deleting records

To delete one or more selected records, select Actions > Delete.

Comparing two records

To compare two selected records, select Actions > Compare.

Note

The content of complex terminal nodes, such as aggregated lists and user defined
attributes, are excluded from the comparison process. That is, the compare service
ignores any differences between the values of the complex terminal nodes in the records.

21.2 Importing and exporting data

In a table, records can be exported to or imported from CSV or XML format.

You can either manually select certain records of the table to export, or you can export the whole table.

See also
CSV Services [p 149]

XML Services [p 143]

21.3 Restore from history

When history is enabled on a table, it is possible to restore a record to a previous state, based on its
registered history. If the record (identified by its primary key) still exists in the table, it will be updated
with the historized values to be restored. Otherwise, it will be created.

In order to restore a record to a previous state, select a record in the history table view, and the select
Actions > Restore from history in the workspace. A summary screen is displayed with the details
of the update or creation to be performed.

The restore feature is available only on one record at a time.

If a table trigger must have a specific behavior on restore, different from the one on regular create and
update, the developer can use the method TableTriggerExecutionContext.isHistoryRestore™.
Note

This feature has limitations linked to the limitations of the history feature:

« the 'restore from history' feature is not available on tables containing lists that are not
supported by history. See Data model limitations [p 456].

» computed values, encrypted values and fields on which history has been disabled are
ignored when restoring a record from history, since these fields are not historized.

See also History [p 451]
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CHAPTER 22

XML import and export

This chapter contains the following topics:

1. Introduction

. Imports
. Exports

2
3
4, Handling of field values
5. Known limitations

22.1 Introduction
XML imports and exports can be performed on tables through the user interface using the Actions
menu in the workspace.
Both imports and exports are performed in the context of a dataset.
Imports and exports can also be done programmatically.

Default import and export option values can be set in the Administration area, under User interface
> Graphical interface configuration > Default option values > Import/Export.

22.2 Imports

Attention

Imported XML documents must be encoded in UTF-8 and its structure must conform to the
underlying data model of the target dataset.
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Import mode

When importing an XML file, you must specify one of the following import modes, which will dictate
how the import procedure handles the source records.

Insert mode Only record creations are allowed. If a record exists in
the target table with the same primary key as the source
record, an error is returned and the whole import operation
is cancelled.

Update mode Only modifications of existing records are allowed. If no
record exists in the target table with the same primary key as
the source record, an error is returned and the whole import
operation is cancelled.

Update or insert mode If a record with the same primary key as the source record
already exists in the target table, that record is updated.
Otherwise, a new record is created.

Replace (synchronization) mode If a record with the same primary key as the source record
already exists in the target table, that record is updated.
Otherwise, a new record is created. If a record exists in the
target table but is not present in the source XML file, that
record is deleted from the table.

Insert and update operations

The mode 'by delta' allows ignoring data model elements that are missing from the source XML
document. This mode can be enabled through data services or the Java API. The following table
summarizes the behavior of insert and update operations when elements are not present in the source
document.

TIBCO EBX® Product Documentation 6.2.0 144



Documentation > User Guide > Datasets > File import and export services > XML import and export

See the data services operations update [p 1025] and insert [p 10271, as well as ImportSpec.setByDelta”

in the Java API for more information.

State in source XML document

Behavior

Element does not exist in the source document

If 'by delta’ mode is disabled (default):
Target field value is set to one of the following:

« If the element defines a default value, the target field value
is set to that default value.

« If the element is of a type other than a string or list, the
target field value is set to null.

« If the element is an aggregated list, the target field value is
set to an empty list.

« If the element is a string that distinguishes null from an
empty string, the target field value is set to null. If it is a
string that does not distinguish between the two, an empty
string.

« If the element (simple or complex) is hidden in data
services, the target value is not changed.

See also Hiding a field in Data Services [p 9041

Note: The user performing the import must have the
permissions necessary to create or change the target field value.
Otherwise, the value will remain unchanged.

If 'by delta’ mode has been enabled through data services or
the Java API:

« For the update operation, the field value remains
unchanged.

« For the insert operation, the behavior is the same as when
byDelta mode is disabled.

Element exists but is empty (for example, <fieldA/>)

« For nodes of type xs:string (or one of its sub-types), the
target field's value is set to null if it distinguishes null
from an empty string. Otherwise, the value is set to empty
string.

« For non-xs:string type nodes, an exception is thrown in

conformance with XML Schema.

See also TIBCO EBX® whitespace management for data
types [p 88s]

Element is present and null (for example, <fieldA
xsi:nil="true"/>)

The target field is always set to null except for lists, for which
it is not supported.

In order to use the xsi:nil="true" attribute, you must
import the namespace declaration xmlns:xsi="http://
www.w3.0rg/2001/XMLSchema-instance".

Set missing values as null

1

When updating existing records, if a node is missing or empty in the XML file: if this option is "yes",
it will be considered as null. If this option is "no", it will not be modified.
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Ignore extra columns

It may happen that the XML document contains elements that do not exist in the target data model.
By default, in this case, the import procedure will fail. It is possible, however, to allow users to launch
import procedures that will ignore the extra columns defined in the XML files. This can be done in
the configuration parameters of the import wizard for XML. The default value of this parameter can
be configured in the 'User interface' configuration under the 'Administration’ area.

Optimistic locking

If the technical attribute ebxd:lastTime exists in the source XML file, the import mechanism
performs a verification to prevent an update operation on a record that may have changed since the
last read. In order to use the ebxd:lastTime attribute, you must import the namespace declaration
xmlns:ebxd="urn:ebx-schemas:deployment_1.0. The timestamp associated with the current record
will be compared to this timestamp. If they are different, the update is rejected.

22.3 Exports

Note
Exported XML documents are always encoded in UTF-8.

When exporting to XML, if the table has filters applied, only the records that correspond to the filter
are included in the exported file.
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The XML export options are as follows:

Download file name

Specifies the name of the XML file to be exported. This field
is pre-populated with the name of the table from which the
records are being exported.

User-friendly mode

Specifies whether exported values will be represented in
a user-friendly way, or in the standard XML raw format.
For example, in user-friendly mode, dates and numbers are
formatted according to the user's locale, and foreign keys
and enumerated values display their associated labels.

Note: If this option is selected, the exported file will not be
able to be re-imported.

Include technical data

Specifies whether internal technical data will be included in
the export.

Note: If this option is selected, the exported file will not be
able to be re-imported.

Is indented

Specifies whether the file should be indented to improve its
readability by a human.

Omit XML comment

Specifies whether the generated XML comment that
describes the location of data and the date of the export
should be omitted from the file.

22.4 Handling of field values

Date, time & dateTime format

The following date and time formats are supported:

Type Format Example
xs:date yyyy-MM-dd 2007-12-31
xs:time HH:mm:ss or HH:mm:ss.SSS 11:55:00

xs:dateTime

yyyy-MM-ddTHH:mm:ss or yyyy-MM-

ddTHH:mm:ss.SSS

2007-12-31T11:55:00
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22.5 Known limitations

Association fields

The XML import and export services do not support association values.
Exporting such fields will not cause any error, however, no value will be exported.

Importing such fields will cause an error, and the import procedure will be aborted.

Selection nodes

The XML import and export services do not support selection values.
Exporting such fields will not cause any error, however, no value will be exported.

Importing such fields will cause an error, and the import procedure will be aborted.
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CHAPTER 23

CSV import and export

This chapter contains the following topics:

1. Introduction

. Exports
. Imports

2
3
4, Handling of field values
5. Known limitations

23.1 Introduction

CSV imports and exports can be performed on tables through the user interface using the Actions
menu in the workspace.

Both imports and exports are performed in the context of a dataset.

Imports and exports can also be done programmatically.

Default import and export option values can be set in the Administration area, under User interface
> Graphical interface configuration > Default option values > Import/Export.

See also Default option values [p 637]

23.2 Exports

When exporting to CSV, if the table has filters applied, only the records that correspond to the filter
are included in the exported file.
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The CSV export options are as follows:

Download file name Specifies the name of the CSV file to be exported. This field
is pre-populated with the name of the table from which the
records are being exported.

File encoding Specifies the character encoding to use for the exported file.
The default is UTF-8.

Enable inheritance In order to consider the inheritance [p 31] during a CSV
export, the option has to be defined in the model.

For more information on inheritance, see Inheritance and
value resolution [p 470].

Specifies if inheritance will be taken into account during a
CSV export.

If inheritance is enabled, resolved values of fields are
exported with the technical data that define the possible
inheritance mode of the record or the field.

If inheritance is disabled, resolved values of fields are
exported and occulted records are ignored.

By default, this option is disabled.

Note: Inheritance is always ignored, if the table dataset has
no parent or if the table has no inherited field.

User-friendly mode Specifies whether exported values will be represented in a
user-friendly way, or in a raw format. For example, in user-
friendly mode, dates and numbers are formatted according
to the user's locale, and foreign keys and enumerated values
display their associated labels.

Note: If this option is selected, the exported file will not be
able to be re-imported.

Include technical data Specifies whether internal technical data will be included in
the export.

Note: If this option is selected, the exported file will not be
able to be re-imported.

Column header Specifies whether or not to include column headers in the
CSV file.

« No header

« Label: For each column in the spreadsheet, the CSV
displays its label. Each label is localized according to
the locale preference of the current session. If no user-
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friendly label is defined for a node, the technical name
of the node is used.

« XPath: For each column in the spreadsheet, the CSV
displays the path to the node in the table.

Field separator Specifies the field separator to use for exports. The
default separator is comma, it can be modified under
Administration > User interface.

List separator Specifies the separator to use for values lists. The
default separator is line return, it can be modified under
Administration > User interface.

APT

Programmatic CSV exports are performed using the classes ExportSpec* and ExportImportCSVSpec™

in the Java API.
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23.3 Imports

Download file name Specifies the name of the CSV file to be imported.

Import mode When importing a CSV file, you must specify one of the
following import modes, which will control the integrity of
operations between the source and the target table.

+ Insert mode: Only record creation is allowed. If a
record exists in the target table with the same primary
key as the source record, an error is returned and the
whole import operation is cancelled.

« Update mode: Only modifications of existing records
are allowed. If no record exists in the target table with
the same primary key as the source record, an error is
returned and the whole import operation is cancelled.

« Update or insert mode: If a record with the same
primary key as the source record already exists in the
target table, that record is updated. Otherwise, a new
record is created.

+ Replace (synchronization) mode: If a record with the
same primary key as the source record already exists in
the target table, that record is updated. Otherwise, a new
record is created. If a record exists in the target table
but is not present in the source XML file, that record is
deleted from the table.

File encoding Specifies the character encoding to use for the exported file.
The default is UTF-8.

Enable inheritance In order to consider the inheritance [p 31] during a CSV
import, the option has to be defined in the model.

For more information on inheritance, see Inheritance
and value resolution [p 470] and ExportImportCSVSpec.

APT

setInheritanceEnabled .

Specifies whether the inheritance will be taken into account
during a CSV import. If technical data in the CSV file define
an inherit mode, corresponding fields or records are forced
to be inherited. If technical data define an occult mode,
corresponding records are forced to be occulted. Otherwise,
fields are overwritten with values read from the CSV file.
By default, this option is disabled.

Note: Inheritance is always ignored if the dataset of the table
has no parent or if the table has no inherited field.
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Column header Specifies whether or not to include column headers in the
CSV file.

+ No header

« Label: For each column in the spreadsheet, the CSV
displays its label. Each label is localized according to
the locale preference of the current session. If no user-
friendly label is defined for a node, the technical name
of the node is used.

« XPath: For each column in the spreadsheet, the CSV
displays the path to the node in the table.

Field separator Specifies the field separator to use for exports. The
default separator is comma, it can be modified under
Administration > User interface.

List separator Specifies the separator to use for values lists. The
default separator is line return, it can be modified under
Administration > User interface.

APT

Programmatic CSV imports are performed using the classes ImportSpec™ and ExportImportCSVSpec™

in the Java API.

23.4 Handling of field values

Aggregated lists

The CSV import and export services support multi-valued fields, namely aggregated lists. This is only
supported for simple typed lists, such as lists of string, date, or int, and for foreign keys. If a table
reference is linked to a composite primary key, each item in the list is a formatted string, for example,
"true|99". Aggregated lists of groups are not exported.

At export, the items in the list are separated using line separators. In cases where the exported field
already contains a line separator, for example in an osd:html or an osd:text, the code _crnl_ is
inserted in place of the field value's line separators. The same formatting is expected at import, with
the whole field value surrounded by quotes.

Hidden fields

Hidden fields are exported as ebx-csv:hidden strings. An imported hidden string will not modify a
field's content.

‘Null" value for strings

Using CSV import and export services, a string with a value set to null is exported as an empty string.
Therefore, a round trip export-import procedure will end up replacing null string values with empty
strings.

Using programmatic services, the specific value ebx-csv:nil can be assigned to strings with values
set to null. If this is done, the null string values will not be replaced by empty strings during round
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trip export-import procedures. See ExportImportCSVSpec.setNullStringEncoded™ in the Java API
for more information.

Date, time & dateTime format

The following date and time formats are supported:

Type Format Example

xs:date yyyy-MM-dd 2007-12-31

xs:time HH:mm:ss or HH:mm:ss.SSS 11:55:00

xs:dateTime yyyy-MM-ddTHH:mm:ss or yyyy-MM- 2007-12-31T11:55:00
ddTHH:mm:ss.SSS

23.5 Known limitations

Aggregated lists of groups

The CSV import and export services do not support multi-valued groups, that is, aggregated lists of
complex type elements. Exporting such nodes will not cause any error, however, no value will be
exported.

Terminal groups

In a CSV file, it is impossible to differentiate a created terminal group that contains only empty fields
from a non-created one.

As a consequence, some differences may appear during comparison after performing an export
followed by an import. To ensure the symmetry of import and export, use XML import and export
instead. See XML import and export [p 143].

Column label headers

If two columns share the same label header, an export of the table can be performed successfully, but
exported data cannot later be re-imported.

Association fields
The CSV import and export services do not support association values, i.e. the associated records.
Exporting such fields will not cause any error, however, no value will be exported.

Importing such fields will cause an error and the import procedure will be aborted.

Selection nodes
The CSV import and export services do not support selection values, i.e. the selected records.
Exporting such fields will not cause any error, however, no value will be exported.

Importing such fields will cause an error and the import procedure will be aborted.
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CHAPTER 24

Working with existing datasets

This chapter contains the following topics:

1. Validating a dataset

. Duplicating a dataset

2
3. Deactivating a dataset
4

. Managing dataset permissions

24.1 Validating a dataset

To validate a dataset at any time, select Actions > Validate from the navigation pane. A generated
report provides the results of the validation. From the validation report, you have the option to update
the reported validation status by clicking the Revalidate button, or to click the Reinitialize validation
report button to clear the current validation report associated with the dataset in order to be able to
rerun a full validation from scratch.

Validations of data can also be run at the table level by navigating to the desired table from the
navigation pane, then selecting Actions > Validate from the workspace.

See Validation [p 587] for detailed information about incremental data validation.

24.2 Duplicating a dataset

To duplicate an existing dataset, select it from the 'Select dataset [p 117]' ~ menu in the navigation
pane, then select Actions > Duplicate.

24.3 Deactivating a dataset

When a dataset is activated, it will be subject to validation. That is, all mandatory elements must be
defined in order for the dataset to be valid. If a dataset is active and validated, it can be safely exported
to external systems or to be used by other Java applications.

If a dataset is missing mandatory elements, it can be deactivated by setting the property 'Activated'
to 'No' from Actions > Information.

24.4 Managing dataset permissions

Dataset permissions can be accessed by selecting Actions > Permissions in the navigation pane.
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Permissions are defined using profile records. To define a new permissions profile, create a new record
in the 'Access rights by profile' table.
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See also Profile [p 27]

Profile

Defines the profile to which these permissions apply.

Restriction policy

If 'Yes', indicates that when the permissions defined here
are more strict than otherwise defined, these permissions
are respected. This is contrary to the default where the most
permissive rights defined take precedence.

See Resolving user-defined rules [p 489].

Dataset actions

Specifies the permissions for actions on the dataset.

Create a child dataset

Indicates whether the profile can create a child dataset.
Inheritance also must be activated in the data model.

Duplicate the dataset

Indicates whether the profile can duplicate the dataset.

Delete the dataset

Indicates whether the profile can delete the dataset.

Activate/deactivate the
dataset

Indicates whether the profile can modify the Activated
property in the dataset information. See Deactivating a
dataset [p 155].

Create a view

Indicates whether the profile can create views and
hierarchies in the dataset.

Tables policy

Specifies the default permissions for all tables. Specific
permissions can also be defined for a table by clicking the
'+' button.

Create a new record

Indicates whether the profile can create records in the table.

Overwrite inherited record

Indicates whether the profile can override inherited records
in the table. This permission is useful when using dataset
inheritance.

Occult inherited record

Indicates whether the profile can occult inherited records
in the table. This permission is useful when using dataset
inheritance.

Delete a record

Indicates whether the profile can delete records in the table.

Values access policy

Specifies the default access permissions for all the nodes
of the dataset and allows the definition of permissions for
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specific nodes. The default access permissions are used if
no custom permissions have been defined for a node.

The specific policy selector allows granting specific
access permissions for a node. The links "ReadOnly",
"ReadWrite", and "Hidden" set the corresponding access
levels for the selected nodes.

It is possible to remove custom access permissions using the
"(default)" link.

Rights on services This section specifies the access permissions for services. A
service is not accessible to a profile if it is crossed-out.
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CHAPTER 25

Dataset inheritance

Using the concept of dataset inheritance, it is possible to create child datasets that branch from a parent
dataset. Child datasets inherit values and properties by default from the parent dataset, which they can
then override if necessary. Multiple levels of inheritance can exist.

An example of using dataset inheritance is to define global default values in a parent dataset, and
create child datasets for specific geographical areas, where those default values can be overridden.

Note

By default, dataset inheritance is disabled. It must be explicitly activated in the
underlying data model.

See also Data model configuration [p 46]

This chapter contains the following topics:

1. Dataset inheritance structure

2. Value inheritance

25.1 Dataset inheritance structure

Once the root dataset has been created, create a child dataset from it using the * button in the dataset
selector in the navigation pane.

Note

« A dataset cannot be deleted if it has child datasets. The child datasets must be deleted first.

« If a child dataset is duplicated, the newly created dataset will be inserted into the existing
dataset tree as a sibling of the duplicated dataset.

25.2 Value inheritance

When a child dataset is created, it inherits all its field values from the parent dataset. A record can
either keep the default inherited value or override it.

In tabular views, inherited values are marked in the top left corner of the cell.

The ™a button can be used to override a value.
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Record inheritance

A table in a child dataset inherits the records from the tables of its ancestor datasets. The table in the
child dataset can add, modify, or delete records. Several states are defined to differentiate between
types of records.

Root A root record is a record that was created in the current
dataset and does not exist in the parent dataset. A root record
is inherited by the child datasets of the current dataset.

Inherited An inherited record is one that is defined in an ancestor
dataset of the current dataset.

Overwritten An overwritten record is an inherited record whose values
have been modified in the current dataset. The overwritten
values are inherited by the child datasets of the current
dataset.

Occulted An occulted record is an inherited record which has been
deleted in the current dataset. It will still appear in the
current dataset as a record that is crossed out, but it will not
be inherited in the child datasets of the current dataset.

When the inheritance button % is toggled on, it indicates that the record or value is inherited from the
parent dataset. This button can be toggled off to override the record or value. For an occulted record,
toggle the button on to revert it to inheriting.
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The following table summarizes the behavior of records when creating, modifying or deleting a record,

depending on its initial state.

State

Create

Modify value

Delete

Root

Standard new record creation.
The newly created record will
be inherited in child datasets
of the current dataset.

Standard modification of an
existing record. The modified
values will be inherited in the
child datasets of the current
dataset.

Standard record deletion. The
record will no longer appear
in the current dataset and the
child datasets of the current
dataset.

Inherited

If a record is created using
the same primary key as an
existing inherited record, that
record will be overwritten
and its value will be the one
submitted at creation.

An inherited record must first
be marked as overwritten in
order to modify its values.

Deleting an inherited record
changes it state to occulted.

Overwritten

Not applicable. Cannot create
a new record if the primary
key is already used in the
current dataset.

An overridden record can be
returned to the inherited state,
but its modified value will be
lost.

Individual values in an
overridden record can be
set to inheriting or can be
modified.

Deleting an overwritten
record changes its state to
occulted.

Occulted

If a record is created using
the primary key of an existing
occulted record, the record
state will be changed to
overwritten and its value
modified according to the one
submitted at creation.

Not applicable. An occulted
record cannot be modified.

Not applicable. An occulted
record is already considered
to be deleted.

See also Record lookup mechanism [p 472]
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CHAPTER 206

Introduction to collaborative features
(Team Up)

This chapter contains the following topics:
1. Overview

2. Accessing the Team Up features

26.1 Overview

Use Team Up to collaborate and engage with others. Leave comments on records, rate records, and
assign tags to records. These interactions can promote a better overall understanding of data.

The following provides an overview of Team Up features:

« Comments: Leave comments on records, reply, and react to other's comments. Assign moderators
to tables that can manage comments from other users.

» Tags: Apply tags to records. Tags are classified in tag catalogs. Assign an administrator to manage
tag catalogs.

» Ratings: Leave a rating from 1 to 5 stars on each record. When leaving a rating, optionally add
a note to explain it.

26.2 Accessing the Team Up features

To access the Team Up features available for a record:

1. Open a record details page.
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2. In the right sidebar, click the icon corresponding to the Team Up feature you want to use.

Master Data - Reference ~  Author [ lastNameAuthoré firstNameAuthoré [00-0-006] ]

r1
La

Tutorial v Authors EditorWithContracts @
Actions ¥ ®
Id *= 00-0-006
) *
Titles Lastname * lastNameAuthoré
Publishers Firstname * firstNameAuthoré ‘

Address addressAuthoré

lastNameAuthoré firstNameAuthoré

Royalties Birth date / / ] [id
Contracts Death date / / 1 [i4
BookRental City cityAuthoré
Country France
Books + Actions ¥ No records v Y
Id ~ Title Type Creation date Publisher Price Sales
No records found.
< »
Save and close Revert Close
See also

Comments [p 167]

Ratings [p 173]
Tags [p 177]
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CHAPTER 27

Comments

This chapter contains the following topics:
1. Overview

Adding a comment

Editing a comment

Deleting a comment

Replying to a comment

Reacting to a comment

N ok DN

Moderating a comment

27.1 Overview

Use the Team Up comments feature to discuss the details of a record. Add your own comments, or
reply and react to comments from other users.

Master Data - Reference ~  Author [ lastNameAuthor1 firstNameAuthor1 [00-0-001] ] 3 Comments x
Tutorial ~ ~ Authors  EditorWithContracts @
— UU Userl Userl 10/19, 17:54
Actions ~ ® |
Id *- 00-0-001 Lorem ipsum dolor sit amet.
_ *
Titles Lastname * lastNameAuthor1 61 Bo @0 A s
Publishers Firstname *  firstNameAuthorl N treplytodisplay+
Address addressAuthorl —
lastNameAuthor1 firstNameAuthor1 | UU User2 User2 elibiay
. Birth date VA = i
Royalties = @ Consectetur adipiscing elit. (moderated)
Contracts Death date / / i) 4
BookRental City cityAuthorl Moderated by User3 User3 10/19,18:1
Dapibus eu interdum vitae.
Country France
o #Ho @1 A
Books + Actions ¥ No records v Y S % e
Id ~ Title Type Creation date Publisher
UU User3 User3 10/19, 18:15

No records found.

Nam et mi eu leo mollis aliquet. Duis at q

uam.
Bo 1 @o A e
Save and close Revert Close . Write your comment
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27.2 Adding a comment

Add a comment using the text input at the bottom of the Comments sidebar.

Master Data - Reference  ~  Author [ lastNameAuthor1 firstNameAuthor1 [00-0-001] ] 3 Comments x
Tutorial ~ ~ Authors  EditorWithContracts @
UU Userl Userl 10/19,17:54
Actions ¥ ®
Id *- 00-0-001 Lorem ipsum dolor sit amet.
) *
Titles Lastname * lastNameAuthor1 G1 Po ®o A s
Publishers Firstname *  firstNameAuthorl W treplytodisplay
Address addressAuthorl YR ALK
lastNameAuthor1 firstNameAuthor1 [ UU User2 User2 10/19, 18:0°
. Birth date /7 = i
Royalties ol @ Consectetur adipiscing elit. (moderated)
Contracts Death date / / ] 4
BookRental City cityAuthorl Moderated by User3 User3 10/19, 18:14
Dapibus eu interdum vitae.
Country France
o %o @1 A
Books + Actions ¥ No records v Y L ”® o
Id ~ Title Type Creation date Publisher

No records found.

Save and close Revert Close

Save

27.3 Editing a comment

UU  User3 User3 10/19,18:15

Nam et mi eu leo mollis aliquet. Duis at q
uam.

Go %1 @o A

. Write your comment

Edit your comments by clicking the editing button in the toolbar (highlighted below). Note that

comments edited by a moderator cannot be edited.

For details about comment moderation, see Moderating a comment [p 170].

Master Data - Reference  ~

Save and close

Author [ lastNameAuthor1 firstNameAuthor1 [00-0-001] ]

Tutorial v Authors EditorWithContracts
Actions ¥
Id #= 00-0-001
Titles Lastname * lastNameAuthor1
Publishers Firstname * firstNameAuthorl
Address addressAuthorl
lastNameAuthor1 firstNameAuthor1 [
Royalties Birth date / / [ [i7
Contracts Death date / / 1 [iA
BookRental City cityAuthorl
Country France
Books + Actions v No records ¥

Id ~ Title Type

Revert Close

@

1 Comments X
UU Userl Userl 10/19, 17:54
d
Lorem ipsum dolor sit amet.
* Eflio o0 ufc|e
‘ 1 reply to display v

UU User3 User3 10/19, 18:15

Nam et mi eu leo mollis aliquet. Duis at g
uam.

Bo @1 @o o

Y

Creation date Publish

No records found.

QU Write your comment
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27.4 Deleting a comment

Delete one of your comments by clicking the delete button in the toolbar located under the comment.

Master Data - Reference - Author [ lastNameAuthor1 firstNameAuthor1 [00-0-001] ] £2  Comments x
Tutorial - Authors EditorWithContracts O]
— UU User1 Userl 10/19, 17:54
Actions ¥ ® |
Id = 00-0-001 Lorem ipsum dolor sit amet.

- * [« .
Titles Lastname * lastNameAuthor1 7?0 ®o g o
Publishers Firstname = firstNameAuthorl A 1 reply to display ¥

Address addressAuthorl
lastNameAuthor1 firstNameAuthor1 [( G User3 User3 L0115 151
. - - ser3 User: /19, 18:15
Royalties Birth date / / [ [iA
Contracts Death date / / 5 ] Nam et mi eu leo mollis aliquet. Duis at q
uam.
BookRental 1 i -
ookRenta City cityAuthorl Go @1 @o d
Country France
Books + Actions ¥ No records v Y
Id ~ Title Type Creation date Publish
No records found.
Ll >
Save and close Revert Close QU Write your comment

27.5 Replying to a comment

Reply to a comment using the reply button in the toolbar located under the comment.

VY

Master Data - Reference - Author [ lastNameAuthor1 firstNameAuthor1 [00-0-001] ] 3 Comments x
Tutorial  ~ Authors  EditorWithContracts @

— UU Userl Userl 10/19, 17:54
Actions ¥ ® |

Id *— 00-0-001 Lorem ipsum dolor sit amet.
) * 7

Titles Lastname *  lastNameAuthorl RN 7o @0 o @ EI
Publishers Firstname *  firstNameAuthorl ) J 1 reply to display v

Address addressAuthorl

lastNameAuthor1 firstNameAuthor1 [(

. - . UU  User3 User3 10/19, 18:15
Royalties Birth date / / [ [
Contracts Death date / / [ i Nam et mi eu leo mollis aliquet. Duis at g
uam.
BookRental i :
City cityAuthorl ©o ®1 @o P
Country France
Books + Actions v No records v Y
Id ~ Title Type Creation date Publish
No records found.
4 »
Save and close Revert Close QU Write your comment
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27.6 Reacting to a comment

React to comments using the available reaction buttons in the toolbar located under the comment.
Change your reaction by clicking a different reaction; remove your reaction by clicking the same
reaction again.

Master Data - Reference - Author [ lastNameAuthor1 firstNameAuthor1 [00-0-001] ] £2  Comments x
Tutorial ~ ~ Authors EditorWithContracts @
— UU User1 Userl 10/19, 17:54
Actions ¥ ®
Id = 00-0-001 Lorem ipsum dolor sit amet.
- * .
Titles Lastname * lastNameAuthor1 b e o
Publishers Firstname = firstNameAuthorl A 1 reply to display ¥
Address addressAuthorl
lastNameAuthor1 firstNameAuthor1 [ G User3 User3 oo s
i - - ser3 User: /19, 18:15
Royalties Birth date / / [ [iA
Contracts Death date / / 5 ] Nam et mi eu leo mollis aliquet. Duis at q
uam.
BookRental 1 i -
ookRental City cityAuthor1 Go B1 @o P
Country France
Books + Actions ¥ No records v Y
Id ~ Title Type Creation date Publish
No records found.
Ll >
Save and close Revert Close QU Write your comment

27.7 Moderating a comment

Moderate and edit other's comments by clicking the moderate icon highlighted below. When editing
other's comments you can leave a note that indicates why the original content was moderated.

Master Data - Reference -~ Author [ lastNameAuthor1 firstNameAuthor1 [00-0-001] ] L2 Comments x
Tutorial ~ ~ Authors  EditorWithContracts 9}

— UU Userl Userl 10/19, 17:54
Actions ¥ ® |

Id *- 00-0-001 Lorem ipsum dolor sit amet.
, *

Titles Lastname * lastNameAuthorl b1 o @o iod
Publishers Firstname * firstNameAuthor1 L 3 1 reply to display v

Address addressAuthorl

lastNameAuthor1 firstNameAuthor1

. - - UU User3 User3 10/19, 18:15

Royalties Birth date / / [£1 [iA
Contracts Death date / / £l v} \l:laar:qn et mi eu leo mollis aliquet. Duis at g
BookRental i i

City cityAuthorl G0 #B1 @o A

Country France

Books + Actions v No records v Y

Id ~ Title Type Creation date Publisher

No records found.

Save Save and close Revert Close . Write your comment
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For details about how to manage moderators, see Managing user access and Team Up features [p 688].

See also

Ratings [p 173]
Tags [p 177]
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CHAPTER 28

Ratings

This chapter contains the following topics:

1. Overview

2. Rating a record and editing a rating

3. Deleting a rating

28.1 Overview

Give records ratings by leaving up to 5 stars and optionally leave an explanation for the rating. The
Ratings sidebar displays:

« Arecord's overall rating.

« The individual ratings supplied by other users.

« The comments related to those ratings.

Master Data - Reference  ~

Tutorial  ~

Actions ¥

Titles
Publishers
lastNameAuthor1 firstNameAuthorl
Royalties
Contracts

BookRental

2 ratings

2 few minutes ago

Author [ lastNameAuthor1 firstNameAuthor1 [00-0-001] ] L1 Ratings

Authors EditorWithContracts ® 4.0

®
Id 00-0-001

*
Lastname * lastNameAuthor1

UU  User2 User2
Firstname * firstNameAuthorl A
Address addressAuthorl : "
Lorem ipsum dolor sit amet.
Birth date /7 [ [id
Death date / / & i UU Userl Userl
City cityAuthor1
Country France
Books + Actions ¥ No records v Y
Id ~ Title Type Creation date Publisher
No records found.
>
Your rating
[Explain your rating

Save and close Revert Close
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28.2 Rating a record and editing a rating

Use the inputs at the bottom of the Rating sidebar to add your rating and optionally leave a comment.
Perform the same actions to edit your rating.

Master Data - Reference  ~  Author [ lastNameAuthor1 firstNameAuthor1 [00-0-001] ]

r1
L

Ratings X

Tutorial ~ ~ itorWi ®
Authors EditorWithContracts 4.0 2 ratings
Actions ¥ ®
Id *= 00-0-001
N
Titles Lastname *  lastNameAuthorl
. UU User2 User2
Publishers Firstname * firstNameAuthor1 A
Address addressAuthorl L . dolor si
lastNameAuthor1 firstNameAuthor1 orem ipsum dolor sit amet.
Royalties Birth date / / =] [
Contracts Death date / / =) [ @ Userl Usert
10/25, 10:46
BookRental City cityAuthorl
Country France
Books + Actions ¥ No records v Y
Id ~ Title Type Creation date Publisher
No records found.
»
Your rating
Explain your rating
Save and close Revert Close

28.3 Deleting a rating

Delete your rating using the delete icon located to the right of your rating. Note that your rating always
displays at the top of the individual ratings list.

Master Data - Reference  ~ Author [ lastNameAuthor1 firstNameAuthor1 [00-0-001] ] C2  Ratings x
Tutorial ~ ~ itorWi ®
Authors EditorWithContracts 4.0 2 ratings
Actions ¥ ®
Id *= 00-0-001
X
Titles Lastname * lastNameAuthor1
) UU Userl Userl
Publishers Firstname * firstNameAuthorl ‘

Address addressAuthorl

lastNameAuthor1 firstNameAuthor1 [

Royalties Birth date / ] [vi] UU User2 User2
Contracts Death date / / [ A yesterd
BookRental City cityAuthor1 Lorem ipsum dolor sit amet.
Country France
Books + Actions ¥ No records v Y
Id ~ Title Type Creation date Publish

No records found.

Your rating

Explain your rating 0
Save and close Revert Close
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See also
Comments [p 167]

Tags [p 177]
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CHAPTER 29

Tags

This chapter contains the following topics:

1. Overview

2. Applying tags
3. Removing a tag

29.1 Overview

Use the Tags sidebar to assign one or more tags to a record.

Master Data - Reference  ~  Author [ lastNameAuthorl firstNameAuthor1 [00-0-001] ] o3 Tags x
Tutorial - Authors EditorWithContracts 9} Applied tags
Actions ¥ [ J
Id *= 00-0-001 O T @ TagH
) A *
Titles Lastname lastNameAuthor1
Publishers Firstname * firstNameAuthorl ‘ Apply tag

Address addressAuthorl

Search or create tag
lastNameAuthor1 firstNameAuthorl

Royalties Birth date / / =) [id
- _ Last used ciick 1o appiy
Contracts Death date / / = [i4
BookRental City cityAuthorl Tag B
Country France
Most used cick to apply
Books + Actions v No records v Y
@ TagB ' @ TagC
Id ~ Title Type Creation date Publisher
No records found. My tags cick to apply

@ TagB '@ TagC

Save and close Revert Close
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29.2 Applying tags

Applying existing tags
Apply a tag from the sections Last used, Most used and My tags by clicking on it.

Master Data - Reference -~ Author [ lastNameAuthor1 firstNameAuthor1 [00-0-001] ] 01 Tags x
Tutorial - Authors EditorWithContracts (0] Applied tags
Actions ¥ L 3
Id = 00-0-001 © TagA TagH
) *
Titles Lastname * lastNameAuthor1
Publishers Firstname * firstNameAuthor1 A Apply tag
Address addressAuthorl Search or create tag
lastNameAuthor1 firstNameAuthorl
Royalties Birth date / / [ [ig
~ ~ Last used ciick to apply
Contracts Death date / / | 4
BookRental City cityAuthor1 @ TagB
Country France
Most used cick to apply
Books + Actions ¥ No records v Y
TagB '@ Tag C
Id ~ Title Type Creation date Publisher
No records found. My tags cick to aply
J »
@ TagB | @ TagC

Save Save and close Revert Close
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If the required tag is not displayed under the sections Last used, Most used and My tags then search
for it in the table's tags catalog using the input field Search or create.

Master Data - Reference ~  Author [ lastNameAuthor1 firstNameAuthor1 [00-0-001] ] £l Tags X
Tutorial ~ ~ Authors  EditorWithContracts @ Applied tags
Actions ¥ [ J
Id = 00-0-001 ) TEGA
) *
Titles Lastname * lastNameAuthorl
Publishers ¥ || Apply tag

Firstname * firstNameAuthorl

Address addressAuthorl T8 “

lastNameAuthor1 firstNameAuthorl

Royalties Birth date / / [ [i4 i @Tag B
Contracts Death date /o S 1 @Tag C
BookRental City cityAuthor1 4 E
Country France
Most used ciick to 2pp
Books + Actions ¥ No records ¥ Y
@ TagB @ TagC
Id ~ Title Type Creation date Publisher
No records found. My tags ciick to aopl

@ TagB @ TagC

Save Save and close Revert Close

For details about managing tag catalogs, see Managing tags and tag catalogs [p 688].
Applying a new tag

If the required tag doesn't exist in the table's tags catalog, then create it by typing its name into the
input field Search or create and pressing Enter or by clicking the Send button.
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If you are an administrator for the table's tag catalog, you can choose between making the tag public or
private when creating a new tag. All profiles can see public tags, and only creators can see private tags.

Master Data - Reference ~  Author [ lastNameAuthor1 firstNameAuthor1 [00-0-001] ] L3 Tags X
Tutorial v Authors EditorWithContracts @ Applied tags
Actions ¥ ®
Id 00-0-001 ) TEIA
) *
Titles Lastname * lastNameAuthorl
Publishers Firstname * firstNameAuthorl ) Apply tag
Address addressAuthorl Tag D Create public ta
lastNameAuthor1 firstNameAuthor1l & @ P 9
Royalties Birth date /o | [i8 (@) Create private tag
_ Last used
Contracts Death date / / ] [i4
BookRental City cityAuthorl Tag B
Country France
Most used cick o apply
Books + Actions ¥ No records v Y
Tag B Tag C
Id ~ Title Type Creation date Publisher
No records found. My tags cick to apply
« >
Tag B Tag C
Save and close Revert Close

For details about managing tag catalog administrators, see Managing tags and tag catalogs [p 688].
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29.3 Removing a tag

Remove a tag assigned to the record using the 'x' button that appears on the tag under the section
Applied tags.

Master Data - Reference -~ Author [ lastNameAuthor1 firstNameAuthor1 [00-0-001] ] 01 Tags x
Tutorial - Authors EditorWithContracts ® Applied tags
Actions ¥ L4 3
Id = 00-0-001 SACiE O
) *
Titles Lastname * lastNameAuthor1
Publishers Firstname * firstNameAuthor1 S Apply tag

Address addressAuthorl

Search or create tag
lastNameAuthor1 firstNameAuthor1

Royalties Birth date / / [ [ig
~ ~ Last used ciick to apply
Contracts Death date / / | 4
BookRental City cityAuthor1 @ TagB
Country France
Most used cick to apply
Books + Actions ¥ No records v Y
TagB | @ Tag C
Id ~ Title Type Creation date Publisher
No records found. My tags cick to aply
4 »
@ TagB | @ TagC
Save and close Revert Close
See also

Comments [p 167]

Ratings [p 173]
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CHAPTER 30

Introduction to workflow models

This chapter contains the following topics:
1. Overview

2. Using the Workflow Models area user interface

3. Generic message templates

4. Limitations of workflows

30.1 Overview

What is a workflow model?

Workflows in TIBCO EBX® facilitate the collaborative management of data in the repository. A
workflow can include human actions on data and automated tasks alike, while supporting notifications
on certain events.

The first step of realizing a workflow is to create a workflow model that defines the progression of
steps, responsibilities of users, as well as other behavior related to the workflow.

Once a workflow model has been defined, it can be validated and published as a workflow publication.
Data workflows can then be launched from the workflow publication to execute the steps defined in
the workflow model.

See also

Workflow model (glossary) [p 331

Data workflow (glossary) [p 35]

Basic concepts related to workflow models

A basic understanding of the following terms is necessary to proceed with the creation of workflow
models:

o script task [p 34]
o user task [p34]
o work item [p 35]

« workflow condition [p 34]

« sub-workflow invocation [p 34]
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o wait task [p 34]

« data context [p 34]

30.2 Using the Workflow Models area user interface

Workflow models i Workflow modeling ?

. Actions menu |

New product process ~

. Workflow model selector |
Actions - m . ’

= Workflow modeling

I Workflow model configuration

Waorkflow model steps

Workspace

Navigation pane

Note

This area is available only to authorized users in the 'Advanced perspective'. Only
authorized users can access these interfaces.

30.3 Generic message templates

Notification emails can be sent to inform users of specific events during the execution of data
workflows.

Generic templates can be defined and reused by any workflow model in the repository. To work with
generic templates, select 'Message templates' from the Workflow Models area Actions menu.

These templates, which are shared by all workflow models, are included statically at workflow model
publication. Thus, in order to take template changes into account, you must update your existing
publication by re-publishing the affected models.

Please note that, if you want to export those templates in an archive, you will have to select the dataset
"configuration" as it is the one containing the message templates.

When creating a new template, two fields are required:
+ Label & Description: Specifies the localized labels and descriptions associated with the template.

« Message: Specifies the localized subjects and bodies of the message.
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The message template can include data context variables, such as ${variable.name}, which are
replaced when notifications are sent. System variables that can be used include:
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system.time

System time of the repository.

system.date

System date of the repository.

workflow.lastComment

Last comment on the previous user task. (Note:
this variable refers to the last user task, not the
current one. Also the current task is the one on
which the workflow is positioned, and it also
includes the completion notification of a user
task).

workflow.lastDecision

Last decisions made on the previous user task.
(Note: this variable refers to the last user task,
not the current one. Also the current task is the
one on which the workflow is positioned, and
it also includes the completion notification of a
user task).

user.fullName

Full name of the notified user.

user.login

Login of the notified user.

workflow.process.label

Label of the current workflow.

workflow.process.description

Description of the current workflow.

workflow.workItem.label

Label of the current work item.

workflow.workItem.description

Description of the current work item.

workflow.workItem.offeredTo

Role to which the current work item has been
offered.

workflow.workItem.allocatedTo

User to whom the current work item has been
allocated.

workflow.workItem.link

Link to access the current work item in the work
item inbox, using the Web Component API.

This link can only be computed if a current
work item is defined and if the URL is
configured in Workflow-executions, in the
email configuration.
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workflow.workItem.link.allocateAndStart Link to access the current work item in the work
item inbox, using the Web Component API. If
the target work item has not yet been started, it
will be automatically allocated to and started by
the user clicking the link.

This link can only be computed if a current
work item is defined and if the URL is
configured in Workflow-executions, in the
email configuration.

workflow.currentStep.label Label of the current step.
workflow.currentStep.description Description of the current step.
Example

Generic template message:

Today at ${system.time}, a new work item was offered to you

Resulting email:

Today at 15:19, a new work item was offered to you

30.4 Limitations of workflows

The following functionality is currently unsupported in EBX®:
+ Scheduled tasks, task executed as soon as its turn comes, and whose execution cannot be delayed.

« Event tasks, allowing the workflow to move forward upon receiving an event, such as a web
service call.

« Time limitation on a task duration.

« User profile names can be up to 64 characters, otherwise compatibility is not guaranteed.

Related concepts Data workflows [p 214]
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CHAPTER 31

Creating and implementing a
workflow model

This chapter contains the following topics:

1. Creating a workflow model

Implementing the steps

User tasks
Script tasks
Conditions

Sub-workflow invocations

Wait tasks

©® N ek~ N

Editing the workflow diagram

31.1 Creating a workflow model

A new workflow model can be created in the Workflow Models area. The only required information
at creation is a name that is unique in the repository.

The steps of the workflow model are initialized with a single transition. In order to fully implement
the workflow model, you must define the sequence of steps beyond this initial transition.

31.2 Implementing the steps

A workflow model defines steps that correspond to different operations that must be performed on
data, and associated conditions. The following types of steps exist:

« User task

« Script task

« Condition

» Sub-workflow invocation
«  Wait task

A data context is linked to each data workflow. This data context can be used to define variables that
can be used as input and output variables in the steps of the workflow.
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Progress strategy of the next step

For each step type (excluding user task with multiple work items), a property is available to define
which progress strategy has to be applied for the next step. Upon step completion, this strategy is
evaluated in order to define the navigation when the workflow is executed. By default, the progress
strategy is set to 'Display the work items table'. In that case, after the step has been executed, the work
items table (work items inbox or monitoring > work items) is automatically displayed, in order to
select the following work item.

Another strategy can be selected: 'Automatically open the next step'. This strategy allows the user to
keep working on this workflow and to directly execute the next step. If, following to this execution, a
work item is reached and the connected user can start it, then the work item is automatically opened (if
several work items are reached, the first created is opened). Otherwise, the next step progress strategy
is evaluated. If no work item has been reached, the work items table will be displayed.

This strategy is used to execute several steps in a row without going back to the work items inbox.

There are some limitations that will lead to disregard this strategy. In that case, the work items table is
automatically displayed. This property will be disregarded when: the current step is a user task with
more than one work item.

In the case of conditions, two other strategies are available: 'If true, automatically open the next step'
and 'If false, automatically open the next step'. These strategies allow choosing which strategy will
be applied according to the condition result.

In the case of sub-workflows invocation, a dedicated property « Foreground sub-workflow » is
available to precise the progress strategy. For the previous progress strategy « Open directly the next
step », a foreground sub-workflow must be selected. Only the steps and associated progress strategy
included in this foreground sub-workflow will be evaluated. Please note the following specific rules
about the foreground sub-workflow property :

« If only one sub-workflow is launched, it is automatically considered in the foreground,

« The foreground sub-workflow property will be ignored if the previous step has not selected the
progress strategy « Automatically open the next step »,

+ When all the sub-workflow are completed, and if the last completed sub-workflow is the
foreground one, then the progress strategy defined on the sub-workflow invocation step is
evaluated: if the progress strategy is « automatically open the next step », the next step can be
opened without displaying the inbox. In all cases, the progress strategy of the last step of the sub-
workflow is always ignored.

Hidden in progress view

For each step type, a property is available to define which steps must be hidden in the workflow
progress view by default.

If this property is enabled, the step will be automatically hidden in the workflow progress view for
non-administrator users (neither built-in administrator nor workflow administrator). Hidden steps can
be displayed on demand.

31.3 User tasks

User tasks are steps that involve actions to be performed by human users. Their labels and descriptions
can be localized.
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Mode

For backward compatibility reasons, two user task modes are available: the default mode and the
legacy mode.

By default, a user task generates a single work item. This mode offers more features, such as offering
a work item to a list of profiles or directly displaying the avatars in the workflow progress view.

In the legacy mode, a user task can generate several work items.

By default, the user task creation service is hidden in legacy mode. To display it, a property should
be enabled in the ebx.properties file. For more information, see Disabling user task legacy mode
[p 5671.

List of profiles

The definition of the profiles of a user task may vary depending on the user task mode.

[Default] Offered to the following profiles

The defined profiles are the roles or the users to whom the user task is being offered. When executing
the user task, a single work item is generated. If a single user is defined, the work item is automatically
assigned to this user. If a role is defined, the work item is offered to the members of the role. If several
users and roles are defined, the work item is offered simultaneously to these users and to the members
of these roles.

[Legacy mode] Participants

The participants are the roles or the users to whom the user task is intended. By default, when executing
the user task, a work item is generated by profile. If a profile refers to a user instead of a role, the work
item is directly allocated to that user. If a profile is a role, the work item is offered to the members
of the role.

For more information

See also Extension [p 193]

Service
TIBCO EBX® includes the following built-in services:
» Access a dataspace
+ Access data (default service)
» Access the dataspace merge view
« Compare contents
» Create a new record
» Duplicate a record.
« Export data to a CSV file
« Export data to an XML file
+ Import data from a CSV file
+ Import data from an XML file
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+ Merge a dataspace

+ Validate a dataspace, a snapshot or a dataset

See also EBX® built-in services [p 417]

Configuration

Main options > Enable reject
By default, only the accept action is offered to the user when saving a decision.

It is possible to also allow users to reject the work item by setting this field to 'Yes'.

Main options > Enable confirmation request

By default, a confirmation request is displayed after user task execution when the user saves the
decision by clicking the 'Accept' or 'Reject' button.

To disable this confirmation prompt, set this field to 'Yes'.

Main options > Enable comments

By default, comments are enabled. When a work item is open, a 'Comments' button is displayed and
allows the user to enter a comment.

It is possible to hide this 'Comments' button by setting this property to No.

Main options > Comments required
By default, it is optional to submit a comment associated with a work item.

It is possible to require the user to enter a comment before saving the decision by setting this field to
the desired validation criteria. Comments can be set to be always required, required only if the work
item has been accepted, or required only if the work item has been rejected.

Main options > Customized labels

When the user task is run, the user can accept or reject the work item by clicking the corresponding
button. In the workflow model, it is possible for a user task to define a customized label and
confirmation message for these two buttons. This can be used to adapt the buttons to a more specific
context.

[Legacy mode] Termination > Task termination criteria

A single user task could be assigned to multiple participants and thus generate multiple work items
during workflow execution. When defining a user task in the workflow model, you can select one of
the predefined methods for determining whether the user task is finished, based on the statuses of its
component work items. When the user task's exit requirement has been satisfied, the data workflow
will move on to the next step defined in its model.

For example, for the case of a user task where a product record needs to be approved, you could
designate three potential participants. The task termination criteria can specify whether the product
record needs to be approved by all three users, or only the first user to respond.

TIBCO EBX® Product Documentation 6.2.0 192



Documentation > User Guide > Workflow models > Creating and implementing a workflow model

The default user task termination criteria is "When all work items have been accepted.'

Note

If you  specify a  service extension overriding the  method
UserTask.handleworkItemCompletion to handle the determination of the user task's
completion, it is up to the developer of the extension to verify from within their code
that the task termination criteria defined through the user interface has been met. See
UserTask.handleworkItemCompletion™ in the JavaDoc for more information

[Legacy mode] Termination > Reject tolerance

By default, if a user rejects a work item during workflow execution, the user task is placed into an
error state and the workflow progress is halted. When the user task is in an error state, a workflow
administrator must intervene by replaying the step where the error occurred in order to continue the
workflow execution.

In order to change this default behavior, it is possible to define a certain number of work item
rejections to tolerate. While within the limit of tolerated rejections, no error will occur and it is the
task termination criteria that determines when to end the user task.

The following task termination criteria automatically tolerate all rejections:
« 'When all work items have been either accepted or rejected'

«+ 'Either when all work items have been accepted, or as soon as one work item has been rejected'

Extension

A custom class can be specified in order for the task to behave dynamically in the context of a given
data workflow. For example, this can be used to create work items or complete user tasks differently
than the default behavior.

APT

The specified rule is a JavaBean that must extend the UserTask™ class.

Attention

If a rule is specified and the handleworkItemCompletion method is overridden, the completion
strategy is no longer automatically checked. The developer must check for completion within this
method.

Notification

A notification email can be sent to users when specific events occur. For each event, you can specify
a content template.

It is possible to define a monitor profile that will receive all emails that are sent in relation to the
user task.

See also Generic message templates [p 185]

Reminder

Reminder emails for outstanding offered or allocated work items can be periodically sent to the
concerned users. The recipients of the reminder are the users to whom the work item is offered or
allocated, as well as the recipients on copy.
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The content of the reminder emails is determined by the current state of the work item. That is, if the
work item is offered, the notification will use the "Offered work items" template; if the work item is
allocated, the notification will use the "Allocated work items" template.

Deadline

Each user task can have a completion deadline. If this date passes and associated works items are not
completed, a notification email is sent to the concerned users. This same notification email will then
be sent daily until the task is completed.

There are two deadline types:
o Absolute deadline: A calendar date.

» Relative deadline: A duration in hours, days or months. The duration is evaluated based on the
reference date, which is the beginning of the user task or the beginning of the workflow.

31.4 Script tasks

Script tasks are automatic tasks that are performed without human user involvement.

Three types of script tasks exist, which, once defined, can be used in workflow model steps:

Library EBX® includes a number of built-in library script tasks,
which can be used as-is.

Any additional library script tasks must be declared in a
module.xml file. A library script task must define its label,
description and parameters. When a user selects a library
script task for a step in a workflow model, its associated
parameters are displayed dynamically.

Specific Specifies a Java class that performs custom actions. The
associated class must belong to the same module as
the workflow model. Its labels and descriptions are not
displayed dynamically to users in workflow models.

Script Specifies a script based on DSIL (Domain Specific
Language) to define custom operations . The EBX® IDE is
used to facilitate scripts writing.

A script is defined by its name, label, description and
parameters. When a user selects the name of the script for
a step in a workflow model, its associated parameters are
displayed dynamically.

Packaging TIBCO EBX® modules [p 819]

Library
EBX® includes the following built-in library script tasks:
+ Create a dataspace

+ Create a snapshot
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+ Merge a dataspace

+ Import an archive

+ Close a dataspace

» Set a data context variable

» Send an email

+ Delete records (Note: this script can remove several records)

APT

Library script tasks are classes that extend the class ScriptTaskBean™. Besides the built-in library
script tasks, additional library script tasks can be defined for use in workflow models. Their labels
and descriptions can be localized.

The method ScriptTaskBean.executeScript™ is called when the data workflow reaches the
corresponding step.

Attention

The method scriptTaskBean.executeScript” must not create any threads because the data
workflow moves on as soon as the method is executed. Each operation in this method must therefore
be synchronous.

See the example [p 952].

It is possible to dynamically set variables of the library script task if its implementation follows the
Java Bean specification. Variables must be declared as parameters of the bean of the library script task
in module.xml. The workflow data context is not accessible from a Java bean.

Note

Some built-in library script tasks are marked as "deprecated" because they are not
compatible with internationalization. It is recommended to use the new script tasks that
are compatible with internationalization.

Specific

Specific script tasks are classes that extend the class Sample of ScriptTask [p 952].

API

The method ScriptTask.executeScript™ is called when the data workflow reaches the corresponding

step.

Attention

The method ScriptTask.executeScript™ must not create any threads because the data workflow
moves on as soon as the method is executed. Each operation in this method must therefore be
synchronous.

See the example [p 952].

It is not possible to dynamically set the variables of the bean for specific script tasks. However, the
workflow data context is accessible from the Java bean.
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Script

EBX® Script is procedural language based on DSL (Domain Specific Language). It proposes a large
library which can be used to define custom tasks.

The method executeScriptTask [p 1282] of the script is called when the data workflow reaches the
corresponding step. See the examples [p 1282].

31.5 Conditions

Conditions are decision steps in workflows.

Two types of conditions exist, which, once defined, can be used in workflow model steps:

Library condition EBX® includes a number of built-in library conditions,
which can be used as-is.

Any additional library script tasks must be declared in a
module.xml file. A library condition must define its label,
description and parameters. When a user selects a library
condition for a step in a workflow model, its associated
parameters are displayed dynamically.

Specific condition Specifies a Java class that implements a custom condition.
The associated class must belong to the same module as
the workflow model. Its labels and descriptions are not
displayed dynamically to users in workflow models.

Packaging TIBCO EBX® modules [p 819]

Library conditions
EBX® includes the following built-in library conditions:
« Dataspace modified?
» Data valid?
« Last user task accepted?
« Value null or empty?
+ Values equals?

Library conditions are classes that extend the class ConditionBean™. Besides the built-in library
conditions, additional library conditions can be defined for use in workflow models. Their labels and
descriptions can be localized.

See the example [p 955].

It is possible to dynamically set variables of the library condition if its implementation follows the
Java Bean specification. Variables must be declared as parameters of the bean of the library condition
in module.xml. The workflow data context is not accessible from a Java bean.

Specific conditions

Specific conditions are classes that extend the class condition™.
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See the example [p 954].

It is not possible to dynamically set the variables of the bean for specific conditions. However, the
workflow data context is accessible from the Java bean.

31.6 Sub-workflow invocations

Sub-workflow invocation steps in workflow models put the current workflow into a waiting state and
invoke one or more workflows.

It is possible to include another workflow model definition in the current workflow by invoking it
alone in a sub-workflow invocation step.

If multiple sub-workflows are invoked by a single step, they are run concurrently, in parallel. All sub-
workflows must be terminated before the original workflow continues onto the next step. The label
and description of each sub-workflow can be localized.

The property « Foreground sub-workflow » is useful to precise the progress strategy when several
sub-workflows are launched. If the previous step progress strategy is « directly open the next step
», this property defines which sub-workflow should be considered in the foreground (only one sub-
workflow can hold this behavior). Only the work items which have been generated in this foreground
sub-workflow will be able to be opened automatically without passing by the inbox. If only one sub-
workflow is defined, this property is ignored (the single sub-workflow is automatically considered in
the foreground). For further information, refer to the progress strategy: Progress strategy of the next
step [p 190]

Two types of sub-workflow invocations exist:

Static Defines one or more sub-workflows to be invoked each
time the step is reached in a data workflow. For each
sub-workflow, it is possible to set its localized labels
and descriptions, as well as the input and output variable
mappings in its data context.

This mode is useful when the sub-workflows to be launched
and the output mappings are predetermined.

Dynamic Specifies a Java class that implements a custom sub-
workflow invocation. All workflows that could be
potentially invoked as sub-workflows by the code must be
declared as dependencies.

The workflow data context is directly accessible from the
Java bean.

Dynamic sub-workflow invocations must be declared in a
module.xml file.

This mode is useful when the launch of sub-workflows is
conditional (for example, if it depends on a data context
variable), or when the output mapping depends on the
execution of the sub-workflows.
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31.7 Wait tasks

Wait task steps in workflow models put the current workflow into a waiting state until a specific event
is received.

When a wait task is reached, the workflow engine generates a unique resume identifier associated
with the wait task. This identifier will be required to resume the wait task, and as a consequence the
associated workflow.

A wait task specifies which profile is authorized to resume the wait task; and a Java class that

1

implements a wait task bean: waitTaskBean™.
The workflow data context is directly accessible from the Java bean.

Wait task beans must be declared in a module.xml file.

First, the wait task bean is called when the workflow starts waiting. At this time, the generated resume
identifier is available to call a web service for example. Then, the wait task bean is called when the wait
task is resumed. In this way, the data context may be updated according to the received parameters.

Note

The built-in administrator always has the right to resume a workflow.

31.8 Editing the workflow diagram

About
A workflow model is displayed in a BPMN-like editable diagram.

This view provides full editing capabilities and can help modelers have a clear view of the workflow
model they are designing.

Please also note that, although the diagram is derived from BPMN standards, it is not a strict
representation of BPMN since EBX® workflow concepts are slightly different.

Saving the layout

It is possible to save the modified layout. Please note that this is not a user-based save: it will be
shared by all the users.
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Actions

Export as PNG Creates a PNG image.

Export as SVG Creates an SVG image.

Export as PDF Creates a PDF document from the workflow model. Several
properties are available to custom your export. You can
configure the orientation of the pdf pages (Landscape or
Portrait), the size (A3, Letter, etc ...). There is also two
properties that might provide more details to your model:

o Display identifiers (default value is true): Same
behavior with "Show steps identifiers" in the workflow
diagram toolbar but restricted to the pdf export. It will
show the step identifiers for each step.

+ Add index (default value is true): At the end of the pdf,
an index recording all the steps of the diagram will be
added. It might be useful in the case where several steps
title are too long to be fully displayed.

For this property, we recommend showing the steps
identifiers as it will help in recognizing which index line
corespond to which step.

View

Layout > Default layout Applies the default layout to the diagram.

Display > Show/Hide grid Shows the grid if the grid is not visible, hides it otherwise.

Display > Zoom In A zoom in is executed on the diagram. To go faster you can
use "Ctrl, Up mouse wheel" with the mouse pointing the
diagram boundary.

Display > Zoom Out A zoom out is executed on the diagram. To go faster you
can use "Ctrl, Down mouse wheel" with the mouse pointing
the diagram boundary.

Display > Show/Hide steps Show/hide a badge displaying the identifier of a workflow
identifiers step.

Plan view > Hierarchy Shows the hierarchical view of a given workflow model if
enabled.
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Buttons
Save layout Saves the current layout.
Save layout and close Saves the current layout and closes the service.
Revert Reverts changes and reloads a previously saved layout.
Close Closes the service.
Edit
Create Hovering over a link or selecting it, makes '+' appear. It is
used to create a new step.
Delete DEL
Pressing 'DEL' key will remove the selected node.
Please note that this action cannot be undone.
Node toolbar Hovering on a node or directly selecting it makes a toolbar
appear. It is used to either:
« Edit a step.
+ Remove a step.
« Duplicate a step.
« Relink to an existing step.
« Show or hide in progress view.
Edit a node Double click on a node in order to quick edit a step.
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Features

The diagram view offers useful additional features

Undo last action CTRL + Z
Please note that it cannot be done after the following actions:
« Create/Remove/Edit/Duplicate a step
« Relink
« Show/Hide in progress view

« Revert

Zoom in/Zoom out. Mouse middle button then mouse wheel / CTRL then mouse
wheel. Also see View [p 199]

Multiple selection Click on the nodes or links selected holding down the CTRL
button / Draw a selection rectangle (you will need to hold
down the left click for 1 second before drawing the area).

Customizing links drawing When clicking on a link, you can either move the segments
by dragging the squares which appear on the corners, or
separate a specific segment by moving the circle in the

middle.
Edit a step Double clicking on a step will display an edition form.
Overview A panel is now available with a miniature workflow diagram

view which can be used to navigate within it. This panel
can be collapsed, expanded and dragged inside the area
allocated for the workflow diagram view.
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CHAPTER 32

Configuring the workflow model

This chapter contains the following topics:

1.

N ok DN

Information associated with a workflow model

Workflow model properties

Data context

Custom workflow execution views

Permissions on associated data workflows

Workflow model snapshots

Deleting a workflow model

32.1 Information associated with a workflow model

To view and edit the owner and documentation of your workflow model, select 'Information’ from the
workflow model 'Actions' [p 185] menu for your workflow model in the navigation pane.

Owner Specifies the workflow model owner, who will have the

rights to edit the workflow model's information and define
its permissions.

Localized documentation Localized labels and descriptions for the workflow model.

Activated This property is deprecated. Whether the workflow model

is activated. A workflow model must be activated in order
to be able to be published.
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32.2 Workflow model properties

Configuration for a workflow model is accessible in the navigation pane under "Workflow model
configuration'.

Module name Module containing specific Java resources (user task
extensions, specific scripts and conditions).

Notification of start The list of profiles to which to send notifications, based on
a template, when a data workflow is launched.

See Generic message templates [p 185].

Notification of completion The list of profiles to which to send notifications, based
on a template, when a data workflow is completed.
The notification is only sent if the workflow has been
completed under normal circumstances, that is, not due to
an administration action.

See Generic message templates [p 185].

Notification of error The list of profiles that will receive notifications, based on
a template, when a data workflow is in error state.

See Generic message templates [p 185].

Priority By default, each workflow associated with this model will
be launched with this priority. Setting a priority is optional.
If no priority is defined here, and a default priority is set for
the repository, the repository default priority will be used
for any associated workflow with no priority assigned. See
Work item priorities [p 225] for more information.

Note: Only users who are defined as workflow
administrators will be able to manually modify the priority
level of any associated data workflows.

Activate quick launch By default, when a workflow is launched, the user is
prompted to enter a documentation for the new workflow
in an intermediate form. This documentation is optional.
Setting the 'Activate quick launch' property to 'Yes' allows
skipping this documentation step and proceeding directly to
the workflow launch.

Automatically open the first step Allows determining the navigation after a workflow is
launched. By default, once a workflow is launched,
the current table (workflow launchers or monitoring >
publications) is automatically displayed.
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Enabling this property will allow the workflow user to
keep working on the launched workflow. If, after the first
workflow step is executed, a work item is reached, and this
work item can be started by the workflow creator, then the
work item is automatically opened (if several work items
are reached, the first created is opened). This will save the
user from selecting the corresponding work item from the
work items inbox.

If no work item has been reached, the next step progress
strategy is evaluated.

If no work item has been opened, the table from which the
workflow has been launched is displayed.

Limitation: This property will be ignored if the first step is
a sub-workflow invocation.

Workflow trigger Component that intercepts the main events of a workflow.

This bean must be declared in a module.xml file. See the
example [p 958].

Permissions Permissions on actions related to the data workflows
associated with the workflow model.

This bean must be declared in a module.xml file. See the
example [p 957].

Programmatic action Defines a custom component that handles the permissions
permissions of the workflow. If set, this overrides all permissions defined
in the property 'Permissions'.

32.3 Data context

The data context configuration can be accessed from the navigation pane.

Each workflow has its own data context, thus allowing to have its own local dataspace during its
execution. This gives the possibility to store and to vary values that will direct the workflow execution.
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The data context is defined by a list of variables. Each variable has the following properties:

Name Identifier of the variable.

Default value If defined, the variable will be initialized with this default
value.

Input parameter "Yes' must be checked in order to define this variable as an

input parameter.

Output parameter "Yes' must be checked in order to define this variable as an
output parameter. Else, this variable will not be displayed in
the list of output parameters, in the task definition interface.

32.4 Custom workflow execution views

The workflow execution views customization can be accessed from the navigation pane.

The customization allows configuring the specific columns of the work items and workflow views
(inbox, work items monitoring, active workflows monitoring and completed workflows). For each
specific column, it is possible to associate an expression that can contain data context variables that
will be evaluated upon display of the workflow.
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32.5 Permissions on associated data workflows

Workflow administration Defines the profile that is allowed to perform administration
actions on the workflows. The administration actions
include the following: replay a step, resume a
workflow, terminate a workflow, disable a publication
and unpublish. In order to perform these actions, this
profile is automatically granted the "Visualize workflows"
permission. The built-in administrator always has the
workflow administration rights.

Workflow administration > Defines the profile that is allowed to replay a workflow step.

Replay a step In order to perform this action, this profile is automatically
granted the "Visualize workflows" permission. A button in
the "Monitoring > Active workflows" section is available to
replay a step. A profile with the "Workflow administration"
permission is automatically allowed to perform this specific
action. The built-in administrator always has the rights to
replay a step.

Workflow administration > Defines the profile that is allowed to terminate and
Terminate workflow clean a workflow. In order to perform this action, this
profile is automatically granted the "Visualize workflows"
permission. A button in the "Monitoring > Active
workflows" section is available to terminate and clean an
active workflow. A button in the "Completed workflows"
section is available to delete a completed workflow. A
profile with the "Workflow administration" permission is
automatically allowed to perform this specific action. The
built-in administrator always has the rights to terminate a

workflow.
Workflow administration > Defines the profile that is allowed to force resuming a
Force a workflow to resume waiting workflow. In order to perform this action, this

profile is automatically granted the "Visualize workflows"
permission. A button in the "Monitoring > Active
workflows" section is available to resume a workflow. A
profile with the "Workflow administration" permission is
automatically allowed to perform this specific action. The
built-in administrator always has the right to resume a

workflow.
Workflow administration > Defines the profile that is allowed to disable a workflow
Disable a publication publication. In order to perform this action, this profile

is automatically granted the "Visualize workflows"
permission. A button in the "Monitoring > Publications"
section is available to disable a publication. It is only
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displayed on active publications. A profile with the
"Workflow administration” permission is automatically
allowed to perform this specific action. The built-in
administrator always has the rights to disable a publication.

Workflow administration > Defines the profile that is allowed to unpublish a

Unpublish workflow publication. In order to perform this action, this
profile is automatically granted the "Visualize workflows"
permission. A button in the "Monitoring > Publications"
section is available to unpublish disabled publications only.
A profile with the "Workflow administration" permission is
automatically allowed to perform this specific action. The
built-in administrator always has the unpublish rights.

Allocation management Defines the profile that is allowed to manage work items
allocation. The allocation actions include the following:
allocate work items, reallocate work items and deallocate
work items. In order to perform these actions, this
profile is automatically granted the "Visualize workflows"
permission. The built-in administrator always has the
allocation management rights.

Allocation management > Defines the profile that is allowed to allocate work items. In

Allocate work items order to perform these actions, this profile is automatically
granted the "Visualize workflows" permission. A button
in the "Monitoring > Work items" section is available
to allocate a work item. It is only displayed on offered
work items. A profile with the "Allocation management"
permission is automatically allowed to perform this specific
action. The built-in administrator always has the work items
allocation rights.

Allocation management > Defines the profile that is allowed to reallocate work items.

Reallocate work items In order to perform this action, this profile is automatically
granted the "Visualize workflows" permission. A button
in the "Monitoring > Work items" section is available to
reallocate a work item. It is only displayed on allocated
work items. A profile with the "Allocation management"
permission is automatically allowed to perform this specific
action. The built-in administrator always has the work items
reallocation rights.

Allocation management > Defines the profile that is allowed to deallocate work items.
Deallocate work items In order to perform this action, this profile is automatically
granted the "Visualize workflows" permission. A button
in the "Monitoring > Work items" section is available to
deallocate a work item. It is only displayed on allocated
work items. A profile with the "Allocation management"
permission is automatically allowed to perform this specific
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action. The built-in administrator always has the work items
deallocation rights.

Launch workflows Defines the profile that is allowed to manually launch new
workflows. This permission allows launching workflows
from the active publications of the "Workflow launchers"
section. The built-in administrator always has the launch
workflows rights.

Permissions to launch a workflow are always automatically
verified, even by API. It is possible to bypass
these automatic permission checks and manage specific
authorization rules manually.

For this, set the ebx.properties permissionCheckDelegated
[p 567] to true and use the dedicated API workflowEngine.
isUserAuthorizedToLaunch®™ to delegate permission
evaluation to the developer.

Visualize workflows Defines the profile that is allowed to visualize workflows.
By default, the end-user can only see work items that
have been offered or allocated to him in the "Inbox"
section. This permission also allows visualizing the
publications, workflows and work items associated with
this workflow model in the "Monitoring" and "Completed
workflows" sections. This profile is automatically granted
the "Visualize completed workflows" permission. The built-
in administrator always has the visualize workflows rights.

Visualize workflows > The If enabled, the workflow creator has the permission to

workflow creator can visualize it view the workflows he has launched. This restricted
permission grants access to the workflows he launched and
to the associated work items in the "Monitoring > Active
workflows", "Monitoring > Work items" and "Completed
workflows" sections. The default value is 'No'.

Visualize workflows > Visualize =~ Defines the profile that is allowed to visualize completed

completed workflows workflows. This permission allows visualizing completed
workflows in the "Completed workflows" section and
accessing their history. A profile with the "Visualize
workflows" permission is automatically allowed to perform
this action. The built-in administrator always has the
visualize completed workflows rights.

Note

A user who has no specific privileges assigned can only see work items associated with
this workflow that are offered or allocated to that user.

See also Workflow administration [p 229]
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32.6 Workflow model snapshots

The history of workflow model snapshots can be managed from Actions > View publications history.

The history table displays all snapshots which contain the selected workflow model and indicates if
a workflow model is published. For each snapshot, the Actions button allows you to export or view
the corresponding workflow model.

32.7 Deleting a workflow model

Workflow model can be deleted, however any associated publications remain accessible in the Data
Workflows area. If a new workflow model is created with the same name as a deleted workflow model,
publishing will prompt to replace the old publication.

See also Publishing workflow models [p 211]

TIBCO EBX® Product Documentation 6.2.0 210



Documentation > User Guide > Workflow models > Publishing workflow models

CHAPTER 33

Publishing workflow models

This chapter contains the following topics:

1. About workflow publications

2. Publishing and workflow model snapshots

3. Sub-workflows in publications

33.1 About workflow publications

Once a workflow model is defined, it must be published in order to enable authorized users to launch
associated data workflows.

Two services are available in order to publish :

« With the button Publish in the navigation pane: this service allows to publish only the model
currently edited.

» Through the button Mass publish that can be found in the toolbar on the same level of the
section title Workflow models : this service allows many models to be published at once. The
first step allows to select many models to publish: only models not containing sub-workflows
invocation will appear in this step. Indeed, a workflow having sub-workflows doesn't qualify for
mass publish.

Workflow models can be published several times. A publication is identified by its publication name

33.2 Publishing and workflow model snapshots

When publishing a workflow model, a snapshot is taken of its current state. A label and a description
can be specified for the snapshot to be created. The default snapshot label is the date and time of the
publication. The default description indicates the user who published the workflow model.

For each workflow model being published, the specified publication name must be unique. If a
workflow model has already been published, it is possible to update an existing publication by reusing
the same publication name. The names of existing workflow publications associated with a given
workflow model are available in a drop-down menu. In the case of a publication update, the old version
is no longer available for launching data workflows, however it will be used to terminate existing
workflows. The content of different versions can be viewed in the workflow model snapshot history.

See also Workflow model snapshots [p 210]
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33.3 Sub-workflows in publications

When publishing a workflow model containing sub-workflow invocation steps, it is not necessary to
separately publish the models of the sub-workflows. From an administration standpoint, the model
of the main workflow (the one currently published by a user) and the models of the sub-workflows
are published as a single entity.

The system computes the dependencies to workflow models used as sub-workflows, and automatically
creates one publication for each dependent model. These technical publications are dedicated to the
workflow engine to launch sub-workflows, and are not available in the Workflow Data area.

The multiple publication is not available for a workflow model containing sub-workflow invocation
steps. This is why the first step of the publication (selection of workflow models to publish) is not
offered in this case.

Republishing the main workflow model automatically updates the invoked sub-workflow models.

Although a sub-workflow model can be published separately as a main workflow model, this will not
update the version used by an already published main workflow model using this sub-workflow.
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CHAPTER 34

Introduction to data workflows

This chapter contains the following topics:

1. Overview

34.1 Overview

A data workflow is an executed step-by-step data management process, defined using a workflow
model publication. It allows users, as well as automated procedures, to perform actions collaboratively
on a set of data. Once a workflow model has been developed and published, the resulting publication
can be used to launch a data workflow to execute the defined steps.

Depending on the workflow user permissions defined by the workflow model, a user may perform
one or more of the following actions on associated data workflows:

« As auser with default permissions, work on and complete an assigned work item.

« As a user with workflow launching permissions, create a new data workflow from a workflow
model publication.

+ As a workflow monitor, follow the progress of ongoing data workflows and consult the history
of completed data workflows.

» As a manager of work item allocation, modify work item allocations manually for other users
and roles.

« As a workflow administrator, perform various administration actions, such as replaying steps,
terminating workflows in progress, or rendering publications unavailable for launching data
workflows.

See also
Work items [p 221]

Launching and monitoring data workflows [p 227]

Administration of data workflows [p 229]

Permissions on associated data workflows [p 207]

Related concepts Workflow models [p 184]
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CHAPTER 35

Using the Data Workflows area user
interface

This chapter contains the following topics:

1. Navigating within the interface

Navigation rules

Custom views

Specific columns

Filtering items in views

O e

Workflow progress view
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35.1 Navigating within the interface

Data workflow functionality is located in the Data Workflows area of the TIBCO EBX® user

interface.
Data workflows Inbox ?

g - Actions =

Woarkflow launchers
o 1-210f21 ~ T View «
» Monitoring
Publications
Active workflows
Work items

Completed workflows

Workspace

Navigation pane

Note

This area is available only to authorized users in the 'Advanced perspective' or from a
specifically configured perspective. Only authorized users can access these interfaces.
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The navigation pane is organized into several entries. These entries are displayed according to their
associated global permission. The different entries are:

Work items inbox All work items either allocated or offered to you, for which
you must perform the defined task.

Workflow launchers List of workflow model publications from which you are
allowed to launch data workflows, according to your user
permissions.

Monitoring Monitoring views on the data workflows for which you have

the necessary viewing permissions.

Publications Publications for which you have the necessary viewing
permissions. If you have additional administrative
permissions, you can also disable the ability to launch data
workflows from specific publications from this view.

Active workflows Data workflows in the process of execution for which
you have the necessary viewing permissions. If you have
additional administrative permissions, you can also perform
actions such as replaying steps of data workflows, and
terminating the execution of data workflows from this view.

Work items Work items for which you have the necessary viewing
permissions. If you have additional administrative
permissions, you can also perform actions relevant to
work item administration, such as allocating work items to
specific users or roles from this view.

Completed workflows Data workflows that have completed their execution, for
which you have the necessary viewing permissions. You can
view the history of the executions of the data workflows.
If you have additional administrative permissions, you can
also clean completed workflows from the repository from
this view.

Note

Each section can be accessed through Web Components, for example, for portal integration,
or programatically using the servicekey class in the Java API.

See also

Using TIBCO EBX® as a Web Component [p 409]

Servicekey”
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35.2 Navigation rules

Work items inbox
By default, once a work item has been executed, the work items inbox is displayed.

This behavior can be modified according to the next step progress strategy, which can allow to execute
several steps in a row without going back to the work items inbox.

See the progress strategy of a workflow step [p 190] in workflow modeling.

Workflow launchers
By default, once a workflow has been launched, the workflow launchers table is displayed.

This behavior can be modified according to the model configuration, which can allow to directly open
the first step without displaying the workflow launchers table.

See the automatic opening of the first workflow step [p 204] in workflow modeling.

35.3 Custom views

It is possible to define views on workflow tables and to benefit from all associated mechanisms
(publication included).

Permissions to create and manage workflow table views are the same as the permissions for data table
views. It may thus be necessary to change the permissions in the 'Administration' section in order to
benefit from this feature, by selecting Workflow management > Workflows.

See the Views [p 127] for more information.

35.4 Specific columns

By default, specific columns are hidden in the views that can benefit from it (inbox, work items
monitoring, active workflows monitoring and completed workflows).

A custom view should be created and applied in order to display the specific columns. For each
work item or workflow, the matching defined in the associated workflow model is then applied. If an
expression is defined for a column and contains data context variables, these variables are evaluated
upon display. If the expression contains built-in expressions which depend on the locale, the expression
is evaluated in the default locale.
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35.5 Filtering items in views

In certain tables, such as the 'Work item inbox', you can narrow down the entries displayed in the
tables by viewing only the entries of a certain state. In such views, there is a menu from which you
can select a state to see its corresponding items.

Inbox

Actions -

¢ BShow all
@hOffered
B Allocated  d start

EpStarted @
1d start

35.6 Workflow progress view

Whether as a user with a work item to perform, or as a data workflow monitor or administrator, you

can view the progress or the history of a data workflow execution by clicking the 'Preview’ @l button
that appears in the 'Data workflow' column of tables throughout the data workflows user interface.
This opens a pop-up displaying an interactive progress view of the data workflow's execution. In this
view, you can see the overall progress of the execution, as well as click on an individual step to view
the details of its information.

If steps have been defined as hidden in the workflow modeling, they are automatically hidden in the
workflow progress view for non-administrator users (non built-in administrators and non workflow
administrators). A button is available to display hidden steps. The choice of users (show or hide steps)
is saved by user, by publication during the user session.

For user tasks performed using the new mode (single work item), the main information about the
single work item is directly displayed in the workflow progress view, when applicable: the avatar
of the user associated with the work item, and the decision that has been taken for the work item
(accepted or rejected).
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CHAPTER 306

Work items

This chapter contains the following topics:

1. About work items

2. Working on work items as a participant

3. Work item priorities

36.1 About work items

A work item is a unit of work that must be performed by a human user as a part of a user task.
By default, when a workflow model defines a user task, data workflows that are launched from that
model's publications will generate an individual work item for each of the participants listed in the
user task.

See also Overview [p 965]

Work item states

When the data workflow spawns a work item for a modelled user task during execution, the work item
passes through several possible states: offered, allocated, started, and completed.

Creation of work items

Default mode
By default, a single work item is generated regardless of the list of defined profiles.

By default, if a single user is defined in the list of profiles, the created work item is in the allocated
state.

By default, in other cases, the created work item is in the offered state.

Note

The default behavior described above can be overridden by a programmatic extension
defined in the user task. In this case, work items may be generated programmatically and
not necessarily based on the user task's list of participants.

Legacy mode

By default, for each user defined as a participant of the user task, the data workflow creates a work
item in the allocated state.
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By default, for each role defined as a participant of the user task, the data workflow creates a work
item in the offered state.

Note

The default behavior described above can be overridden by a programmatic extension
defined in the user task. In this case, work items may be generated programmatically and
not necessarily based on the user task's list of participants.

Variations of the work item states

When the work item is in the allocated state, the defined user can directly start working on the allocated
work item with the 'Take and start' action. The work item's state becomes started.

When the work item is in the offered state, any user or member of the roles to whom the work item is
offered can take the work item with the 'Take and start' action'. The work item's state becomes started.

Before a user has claimed the offered work item, a workflow allocation manager can intervene to
manually assign the work item to a single user, thus moving the work item to the allocated state. Then,
when that user begins work on the work item by performing the action 'Start work item', the work
item progresses to the started state.

Finally, after the user who started the work item has finished the assigned action, the concluding accept
or reject action moves the work item to the completed state. Once a user completes a work item, the
data workflow automatically progresses onto the next step defined in the workflow model.
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Diagram of the work item states

.-ﬁs User task J

(Workflow model)

Wo rk item Work item
0 Role partidpant 0 User participant

Offered I%ﬁ [Admin] Allocate Allocated

[User] Take and sa‘;r [User] Start work item

Started 8}

g

[User] Accept or Reject

| Completed ijg‘v
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AL User task J
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36.2 Working on work items as a participant

All work items relevant to you as a user (either offered or allocated to you), appear in your work
items inbox. When you begin working on a work item, you can add an associated comment that will
be visible to other participants of the data workflow, as well as administrators and monitors of the
workflow. As long as you are still working on the work item, you can go back and edit this comment.

After you have performed all the necessary actions assigned for the work item, you must signal its
completion by clicking either the Accept or Reject button. The labels of these two buttons may differ
depending on the context of the work item.

To review the current progress of a data workflow for which you have a waiting work item in your

work item inbox, click its 'Preview’ A button in the Data workflow’ column of the table. A pop-
up will show an interactive progress view of the data workflow up until this point and the upcoming
steps. You can view the details of a step by clicking on that step.

Note

If you interrupt the current session in the middle of a started work item, for example by
closing the browser or by logging out, the current work item state is preserved. When
you return to the work item, it continues from the point where you left off.
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36.3 Work item priorities

Work items may carry a priority value, which can be useful for sorting and filtering outstanding work
items. The priority of a work item is set at the level of its data workflow, rather than being specific to
the individual work item itself. Thus, if a data workflow is considered urgent, all its associated open
work items are also considered to be urgent. By default, there are six priority levels ranging from 'Very
low' to "'Urgent', however the visual representation and naming of the available priority levels depend
on the configuration of your TIBCO EBX® repository.

See also user task (glossary) [p 341

Related concepts User tasks [p 190]
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CHAPTER 37

Launching and monitoring data
workflows

This chapter contains the following topics:

1. Launching data workflows

2. Monitoring activities

3. Managing work item allocation

37.1 Launching data workflows

If a workflow model has given you the permissions to launch data workflows from its publications,
you can create new data workflows from the "Workflow launchers' entry in the navigation pane. To
create a new data workflow from a workflow model publication, click the Launch button in the entry
of the publication.

You can optionally define localized labels and descriptions for the new data workflow you are
launching.

37.2 Monitoring activities

If a workflow model's permissions have configured your user or role for workflow monitoring, you
have the ability to follow the progress of data workflows that are currently executing. You can access
your monitoring views from the 'Monitoring' section of the navigation panel. If you have additional
workflow management permissions, you can also perform the associated actions from these views.

Once the data workflows that you monitor have completed execution, they appear under 'Completed
data workflows', where you can consult their execution history.

37.3 Managing work item allocation

If a workflow model defines special allocation management permissions for you or a role that you
belong to, you have the ability to manually intervene for work item allocations during the execution
of associated data workflows. In this case, you are able to perform one or more of the actions listed
below on work items.
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Select 'Work items' in the 'Monitoring' section of the navigation pane. The actions that you are able
to perform appear in the Actions menu of the work item's entry in the table, depending on the current
state of the work item.

Allocate Allocate a work item to a specific user. This action is
available for work items in the offered state.

Deallocate Reset a work item in the allocated state to the offered state.

Reallocate Modify the user to whom a work item is allocated. This
action is available for work items in the allocated state.

See also
Work items [p 221]

Permissions on associated data workflows [p 207]

Related concepts Workflow models [p 184]
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CHAPTER 38

Administration of data workflows

If you have been given permissions for administration activities associated with data workflows, any
relevant publications, active data workflows, and work items, will appear under the entries of the
'Monitoring' section in the navigation panel. From these monitoring views, you can directly perform
administrative tasks from the Actions menus of the table entries.

Note

When a workflow model gives you administrative rights, you automatically have
monitoring permissions on all of the relevant aspects of data workflow execution, such
as publications, active data workflows, and work items.

This chapter contains the following topics:

1. Overview of data workflow execution

2. Data workflow administration actions

38.1 Overview of data workflow execution

When a data workflow is launched, a token that marks the step currently being executed is created
and positioned at the start of the workflow. As each step is completed, this token moves on to the next
step as defined in the workflow model on whose publication the data workflow is based.

At any given point during the execution of a data workflow, the token is positioned on one of the
following:

 a script task, which is run automatically and requires no user interaction. The script task is
completed when the defined actions finish running.

« auser task, which spawns one or more work items to be performed manually by users. Each work
item is completed by an explicit 'Accept' or 'Reject’ action from a user, and the completion of the
umbrella user task is determined according to the task termination criteria defined for the user
task in the workflow model.

« a condition, which is evaluated automatically in order to determine the next step in the execution
of the data workflow.

« a sub-workflows invocation, which launches associated sub-workflows and waits for the
termination of the launched sub-workflows.

+ await task, which pauses the workflow until a specific event is received.

The token can be in the following states:
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+ To execute: The token is the process of progressing to the next step, based on the workflow model.
» Executing: The token is positioned on a script task or a condition that is being processed.
» User: The token is positioned on a user task and is awaiting a user action.

» Waiting for sub-workflows: The token is positioned on a sub-workflow invocation and is
awaiting the termination of all launched sub-workflows.

» Waiting for event: The token is positioned on a wait task and is waiting for a specific event to
be received.

« Finished: The token has reached the end of the data workflow.

« Error: An error has occurred.

See also Workflow management [p 673]

38.2 Data workflow administration actions

Actions on publications

Disabling a workflow publication

To prevent new data workflows from being launched from a given workflow publication, you can
disable it. Select the 'Publications' entry from the navigation pane, then select Actions > Disable in
the entry for the publication you want to disable.

Once disabled, the publication will no longer appear in the "Workflow launchers' view of users, but
any data workflows already launched that are in progress will continue executing.

Note

Once a publication has been disabled, it cannot be re-enabled from the Data Workflows
area. Only a user with the built-in repository 'Administrator' role can re-enable a disabled
publication from the Administration area, although manually editing technical tables
is not generally recommended, as it is important to ensure the integrity of workflow
operations.

Unpublishing a workflow publication

If a workflow publication is no longer required, you can remove it completely from the views in the
Data Workflows area by unpublishing it. To do so,

1. Disable the workflow publication to prevent users from continuing to launch new data workflows
from it, as described in Disabling a workflow publication [p 230].

2. Unpublish the workflow publication by selecting Actions > Unpublish from the workflow
publication's entry in the same table of publications.

Note

When you choose to unpublish a workflow publication, you will be prompted to confirm
the termination and cleaning of any data workflows in progress that were launched from
this workflow publication, and any associated work items. Any data that is lost as a result
of forcefully terminating a data workflow cannot be recovered.
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Actions on data workflows

From the tables of data workflows, it is possible to perform actions from the Actions menu in the
record of a given data workflow.

Replaying a step

In the event of an unexpected failure during a step, for example, an access rights issue or unavailable
resources, you can "replay" the step as a data workflow administrator. Replaying a step cleans the
associated execution environment, including any related work items and sub-workflows, and resets
the token to the beginning of the current step.

To replay the current step in a data workflow, select Actions > Replay the step from the entry of the
workflow in the 'Active workflows' table.

Terminating and cleaning an active data workflow
In order to stop and clean a data workflow that is currently in progress, select Actions > Terminate
and clean from the entry of the workflow in the 'Active workflows' table. This will stop the execution
of the data workflow and clean the data workflow and all associated work items and sub-workflows.
Note

This action is not available on workflows in the 'Executing' state, and on sub-workflows

launched from another workflow.

Note

Workflow history data is not deleted.

Forcing termination of an active data workflow
In order to stop a data workflow that is currently in progress, select Actions > Force termination
from the entry of the workflow in the 'Active workflows' table. This will stop the execution of the
data workflow and clean any associated work items and sub-workflows.
Note

This action is available for sub-workflows, and for workflows in error blocked on the

last step.

Note

Workflow history data is not deleted.

Forcing resumption of a waiting data workflow
In order to resume a data workflow that is currently waiting for an event, select Actions > Force
resumption from the entry of the workflow in the 'Active workflows' table. This will resume the data
workflow. Before doing this action, it is the responsibility of the administrator to update the data
context in order to make sure that the data workflow can execute the next steps.

Note

This action is only available for workflows in the 'waiting for event' state.
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Cleaning a completed data workflow

When a data workflow has completed its execution, its history is viewable by monitors and
administrators of that workflow in the view 'Completed workflows'. To remove the completed
workflow, you can perform a clean operation on it. To do so, select Actions > Clean from the entry
of the workflow in the 'Completed workflows' table.

When cleaned a workflow is no longer visible in the view 'Completed workflows' but its history is
still available from the technical administration area.

Note

This action is not available on sub-workflows launched from another workflow.

See also Workflow management [p 673]

Modifying the priority of a data workflow

After a data workflow has been launched, an administrator of the workflow can alter its priority level.
Doing so changes the priority of all existing and future work items created by the data workflow. To
change the priority level of a data workflow, select Actions > Modify priority from the entry of the
workflow in the 'Active workflows' table.

See also Permissions on associated data workflows [p 207]
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CHAPTER 39

Introduction to data services

This chapter contains the following topics:
1. Overview

2. Using the Data Services area user interface

39.1 Overview

What is a data service?
A data service [p 35] is:
« a standard Web service that interacts with TIBCO EBX®.

SOAP data services can be dynamically generated based on data models from the 'Data Services'
area.

« a RESTful service that allows interaction with EBX®.

The built-in REST data services have an OpenAPI interface, they are also self-descriptive through
the returned metadata.

They can be used to access some of the features available through the user interface.

See also
WSDL/SOAP [p 998]
REST [p 1052]

Lineage

Lineage [p 36] is used to establish user permission profiles for non-human users, namely data services.
When accessing data using WSDL interfaces, data services use the permission profiles established
through lineage.

Glossary

See also Data services [p 35]
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39.2 Using the Data Services area user interface

A

(1)

B 0 U B g/

Data services Lineage ?

Data

Dataspace

Data workflow Sclcc_t a_sccurlty p_roﬁlc for w_hc-m the WSDL will be _crcated_
Permissions for this profile will be applied to the available contents and

Lineage actions.

Others
Security profile ® Mona Lisa (joconde) -

Navigation pane Workspace

Note

This area is available only to authorized users in the 'Advanced perspective'.

Related concepts

Dataspace [p 98]
Dataset [p 116]

Data workflows [p 214]

Introduction [p 998]
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cHAPTER 40

Generating data service WSDLs

This chapter contains the following topics:

1. Generating a WSDL for operations on data

Generating a WSDL for dataspace operations

Generating a WSDL for data workflow operations

Generating a WSDL for lineage

Generating a WSDL for administration
Generating a WSDL to modify the default directory

O e

40.1 Generating a WSDL for operations on data

To generate a WSDL for accessing data, select 'Data’ in the navigation panel in the Data Services
area, then follow through the steps of the wizard:

1. Choose whether the WSDL will be for operations at the dataset level or at the table level.

2. Identify the dataspace and dataset on which the operations will be run

3. Select the tables on which the operations are authorized, as well as the operations permitted.
4. Download the generated WSDL file by clicking the button Download WSDL.

Operations on datasets

The following operations can be performed using the WSDL generated for operations at the dataset
level:

+ Select dataset content for a dataspace or snapshot.
» Get dataset changes between dataspaces or snapshots

» Replication unit refresh

Operations on tables

The following operations, if selected, can be performed using the WSDL generated for operations at
the table level:

« Insert record(s)

« Select record(s)

TIBCO EBX® Product Documentation 6.2.0 237



Documentation > User Guide > Data services > Generating data service WSDLs

« Update record(s)

+ Delete record(s)

+ Count record(s)

» Get changes between dataspace or snapshot
» Get credentials

« Run multiple operations on tables in the dataset

See also

WSDL download from HTTP protocol [p 1011]

Operations generated from a data model [p 1017]

40.2 Generating a WSDL for dataspace operations

To generate a WSDL for dataspace-level operations, selecting 'Dataspace' in the navigation panel
of the Data Services area. The generated WSDL is generic to all dataspaces, thus no additional
information is required.

Download the generated WSDL file by clicking the button Download WSDL.

Operations on dataspaces

The following operations can be performed using the WSDL generated for operations at the dataspace
level:

« Create a dataspace

+ Close a dataspace

+ Create a snapshot

« Close a snapshot

+ Merge a dataspace

« Lock a dataspace

« Unlock a dataspace

« Validate a dataspace or a snapshot

« Validate a dataset

See also

WSDL download from HTTP protocol [p 1011]

Operations on datasets and dataspaces [p 1038]

40.3 Generating a WSDL for data workflow operations

To generate a WSDL to control data workflows, select 'Data workflow' from the Data Services
area. The generated WSDL is not specific to any particular workflow publication, thus no additional
information is required.

Download the generated WSDL file by clicking the button Download WSDL.
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Operations on data workflows
« Start a data workflow
« Resume a data workflow

« End a data workflow

See also

WSDL download from HTTP protocol [p 1011]

Operations on data workflows [p 1044]

40.4 Generating a WSDL for lineage

To generate a WSDL for lineage, select 'Lineage' from the Data Services area. It will be based
on authorized profiles that have been defined by an administrator in the 'Lineage' section of the

Administration area.

The operations available for accessing tables are the same as for WSDL for operations on data [p 2371.

Steps for generating the WSDL for lineage are as follows:

1. Select the profile whose permissions will be used. The selected user or role must be authorized

for use with lineage by an administrator.

2. Identify the dataspace and dataset on which the operations will be run

3. Select the tables on which the operations are authorized, as well as the operations permitted.

4. Download the generated WSDL file by clicking the button Download WSDL..

See also Lineage [p 234]

40.5 Generating a WSDL for administration

This action is only available to administrators.
To generate a WSDL for:
« managing the user interface

« getting system information

select 'Administration' from the Data Services area.

Operations for administration
» Close user interface
+ Open user interface

« Get system information

See also

WSDL download from HTTP protocol [p 1011]

User interface operations [p 1048]

System information operation [p 1048]
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40.6 Generating a WSDL to modify the default directory

This action is only available to administrators, and only if using the default directory.

To generate a WSDL to update the default directory, select 'Directory' from the Data Services area.

Operations on the default directory

The operations available for accessing tables are the same as for WSDL for operations on data [p 237].

See also

WSDL download from HTTP protocol [p 1011]

Directory services [p 1047]
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CHAPTER 41

Introduction to metadata
management

This chapter contains the following topics:

1. Understanding metadata and its importance

. Challenges and solutions

. Audience

2
3
4., Approaches to metadata management
5. Where to go from here

41.1 Understanding metadata and its importance

Metadata provides information about data itself, like what it is, what it's for, and how it's organized.
It also includes information about the business and technical processes related to the data, and the
connections between different pieces of data.

Managing metadata well helps an organization understand and control its operations, systems, and
how work gets done. This is important for making the most of the data you have and sometimes it's
even required by law.

If you don't manage metadata properly, you might end up with messy and confusing data. It would
be like trying to find a specific book in a library without a catalog; you wouldn't know where to start
looking, or even if the book is there.

In summary, metadata tells you what data you have and helps you find and use it effectively. Otherwise,
it can be hard to make sense of all the information you have.

41.2 Challenges and solutions

One of the biggest challenges is in implementing a metadata management strategy that unifies the
way you describe, manage, map, and discover your data assets. Critical to the success of strategy
implementation is a mutual understanding of the strategy between business parties, a controlled data
flow, and a solid definition of high-quality data.

EBX®'s metadata management capabilities ensure end-to-end management so you can govern, master,
map, and exchange data. Using the features included in the EBX® Metadata Management application,
you can implement:
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A Data catalog: helps you document your information system by classifying your data sources.
The goal is to achieve a well-defined view of your information system through different lenses:
technical, business, and data specialists profiles. When you document and map your data, you can
identify and bridge potential gaps. This allow users to find the data they need, when they need it.

A Business glossary: allows you to document business terms, their definitions, and the
relationships between terms. A unified vocabulary facilitates communication in your organization
by supplying a common understanding of business concepts. Issues solved by creating a business
glossary include: an inconsistent business vocabulary, data redundancy and duplication, data
freshness, and data quality.

Metadata management: ensures that you obtain value from data by using metadata to inventory,
assess and analyze data assets. For example, you can analyze metadata and data for potential
added value such as identification and capture of additional metadata or datasets. In other words,
it can help you capture data you might not realize you have. Metadata management enhances
the experience that users have while interacting with business solutions or products. This creates
a collaborative experience and ensures that different types of users find the appropriate virtual
environment in which to work.

41.3 Audience

The EBX® Metadata Management application can address the needs of the most diverse organizations
and facilitate collaboration across teams. Business users, data architects, data engineers, data stewards,
analysts, application architects, application owners, etc. are provided with collaborative workflows.
EBX® uses profiles to support role-based access which ensures appropriate exposure of key data
elements and provides needed compliance.

41.4 Approaches to metadata management

There are two main types of approaches to metadata management with EBX®:

Bottom up examples: starting with mapping out the information system, a metadata catalog
initialization or an application owner who wants to retro-document their application.

Top down examples: the Architecture Board launches an information system cartography project,
from the business/applicative architecture to the technical architecture.

41.5 Where to go from here

It is important to understand the Key terms [p 246] used in the documentation. If you are a business
user, you might want to familiarize yourself with an overview of the User interface [p 251] components
and how to use some of the generic features. If you are an administrator, you might benefit from
understanding the configuration options [p 736] available to administrators.
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CHAPTER 42

Key terms

The following table defines key terms commonly used when discussing the EBX® Metadata
Management application's features:

Term Description

Application Software, services, reports, or other documents that exploit, manipulate, or expose data. Applications can serve
business processes and be subject to rules.

Asset Any container or provider of structured data that can be referenced and documented. System instances can
contain or expose assets and assets can be comprised of other assets. For instance, an Excel file is an asset. It
contains sheets which contain tables, columns, lines and cells—all of which are assets. Assets can supply and
be supplied by other assets via a technical flow.

Business A collection of related activities or tasks completed in a specific sequence. They produce business value in the
process form of a product or a service for a customer or user.
Business term Word or phrase that describes a concept used in a branch or domain. A business glossary governs and

communicates business terms.

Data element An atomic unit of data that has precise meaning or semantics. It can represent a complex object such as

a Customer or a Product, or it can define a simple value such as a Birth date or a First name. Simple data
elements are combined to create more complex elements. For example, a Customer is composed of a Person,
which is composed of a First name and other data elements. A data element can also have a relationship with
other data elements.

Dataset A collection of data of the same structure that defines a population of the same data element, or set of data
elements. A dataset can be an exhaustive list of countries or a list of French customers aged 18-24. In these 2
examples, we have a natural link between the dataset and one high level data element which are respectively
Country or Customer. However, it can be more complex or less natural, such as a list of product entries from an
ERP which can represent different data elements with the same structure for technical convenience.

Environment Any application can exist in or on many environments for different reasons. It can be due to a geographical
organization where an application must be redundant for non-functional requirements. It can also be due to

the business or structural organization where the segregation of duties implies the creation of many separated
environments. But most likely, it is required for the build and configuration of the application that needs to be
tested and qualified before to go to production. An environment is then composed of all the system instances its
architecture relies on.

Flow The movement of data between two applications. Exchange of data can include many individual flows between
sources and targets. At a logical level, technical flows define and allow data exchange to occur. Additionally,
they specify a flow's non-functional requirements and any information that could help understand or build
them.
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Term Description

Group Group of persons, includes users of the application as well as non-users, but all persons of the group are
meant to have a role in the management of data: dataset owner, system manager, etc. Examples of groups are:
Marketing group, IT group, etc.

Identifying this group of persons will be used to assign them the ownership of a documented object, e.g.:
system, instance, etc. The responsibilities linked to the management of the various objects are also linked to
groups.

Infrastructure Foundation or frameworks that supports systems. It is composed of physical or logical resources that support
storage, processing, analysis and exchanges of data. An infrastructure is in most case a physical or virtual
server running an operating system.

Instance Concrete installation of a given system, it can be the installation of a software, a file system, a service provided
by a service provider, an internal service, or any other container of provider of data assets or components of any
application. It runs on an infrastructure.

Link It materializes the relation between two data elements in data assets. It then defines how the links between two
assets are ensured in the containing system. It can be a database foreign key, an hyperlink, or just a code or any
other technical representation.

Relation Linking two data elements, it makes one the representation of the other. It defines why the data elements are
related and in which conditions. It can also carry rules. There can be many relationships between two same data
elements. A "Company" can be both the "Supplier" and the "Customer" of another "Company". As different
rules can apply to these two cases, it is interesting to be able to create two different relations instead of one with
a multiple condition.

Role This is not the definition of users roles within EBX® but roles upon data in the information system. A role is
not necessarily active on data governance or data management but can define, for instance, a passive notified
role. Each element of a RACI matrix can then be defined as a role given to a list of groups of persons.

Rule Defines or limits some aspects of a given data category to control or influence the behavior of business data. It
is used for making decisions and for governing programs or policies.

Provider Any company providing one or many systems. It can be a software vendor, a system integrator or any other
outsourcing company, but it can also be an internal organization.

System Any technical component that participates to the elaboration of an application, but also any technical
component that provides or uses data. A system is then materialized by an instance.

Technical flow A data aims to be used but is also sourced. It then comes from an origin going though intermediaries to reach
a final destination before reaching another in the future. Each step in this journey that is a flow between two or
many applications is a technical flow. It defines the bridge between two assets, telling at any level what is the
source of any target.
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CHAPTER 43

Accessing the metadata perspective

You can access the EBX® Metadata Management application and its related features from the
Metadata perspective. This perspective is only available to you if the metadata module was deployed
and access was granted to you by an administrator.

To access the metadata perspective, click the Select perspective icon in the top-right of the main
toolbar, and select Metadata. Note that the Metadata administration perspective is only available
for administrator roles.

v Metadata ,Jw] pX¢

Y

Metadata Administration ¥t
Advanced perspective ¥ (1)

Automatic selection »

o
*
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CHAPTER 44

Overview of the User Interface

This chapter contains the following topics:

1. Main UI
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44.1 Main Ul

The left of the screen is the main navigation pane:

# Home page

Q, Search

& Inbox

& Active workflows

@ Completed workflows

€ Dashboard

& My profile

Catalog
Applications
Datasets
Data elements

Governance

[| Business terms

Rules

Z2 Roles

I Groups

“..  Programs

Metadata

4 Assets

<" Asset types

Technology

= Instances

1 Systems

<= Infrastructures
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The main part of the screen is the workspace:

OEJ.G

eCommerce Platform
eCommerce

=

Main application in the
company for selling products
online. This is not our back-end
application.

'

Maore

Q, Secarch

SAP ERP
ERP

i
—

Main agplication for billing
Based on SAP

i

Maore

340 View of our busin...

Reporting

Dashboard done in Spetfire,

Contains oll kind of dotas
regarding our business:

customer, products, stores...

Maore

CRM B2B
CRM

&

Primary Customer Relotionship
Management systemn for
companies (B2B) prospects
and customers. Central
worldwide instance accessible

from amywhere with double
-
=
3 1
More

Companies MDM
MDM
TIBCO EEX

Companies master dota
management on the MDM
platform about companies.

Concerns any company
wihatever the rofe . provider,

customer.,

-
o=

3 1

Mone
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To the right of the workspace is the sidebar that contains contextual services according to the content
of the workspace, such as comments, or information about a selected asset.

Comments

@ John Doe

Using this dataset for the 2019 report

about 5 hours ago
0 0

1
G 72 @ (& Reply

e Jane Doe

Is it suppose to be the official dataset?

N &€ * ©

about 3 hours ago
0 0 2
S 7 9 Reply

= Hide the reply «

9 John Doe

Yes, I'll flag it official

about 3 hours ag

1 0
O %O @ (& Reply

9 Write your comment
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CHAPTER 45

Navigation pane overview

This chapter contains the following topics:

1. Overview

45.1 Overview

The Navigation pane, is located at the left of the screen. It allow you to access to all features available
to your profile. Administrators use permission settings to determine accessible features. Each section
contains a color-coded group of related features.

To change the size of the Navigation pane, drag its right border. Additionally, you can collapse display
to show icons only by clicking the arrow in the upper right corner.
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6 0 k D O =

Home page
Search

Inbox

Active workflows

Completed workflows

Dashboard

My profile

Applications
Datasets

Data elements

Business terms
Rules

Roles

Groups

Programs

Assets

Asset types

Instances
Systems

Infrastructures

Home section

The options in the Home section are not associated to a specific type of metadata. The section includes
an home page, a global search, accesses to workflows, dashboards and your profile where you can
modify your details.

TIBCO EBX® Product Documentation 6.2.0

256



Documentation > User Guide > EBX® Metadata Management > User Interface > Navigation pane > Navigation pane overview

Catalog section

The Catalog section groups all logical descriptions including applications, datasets and data elements.
A logical description is a way to represent entities that is easier to understand. Logical descriptions
can apply to entities that do not exist yet. For example, you can describe an application before it is
created, or document a dataset before populating it with data values that are stored in, or provided

by, a physical asset.

Governance section

The Governance section includes documentation about how data is managed by different business
domains. Each domain can have its own data related terminology and roles. This section also defines
user groups, their related roles, and data rights. Comprehensive metadata management programs aim

to register any program, initiative or project around data.

Metadata section

The materialization of the dataset described in the catalog is documented in the Metadata section.
This section includes assets, which are physical resources that contain or provide data. Assets are the
materialization of the logical descriptions in the Catalog Asset technical structures and properties are

stored according to their types.

Technology section

The Technology section allows you to access the more technical aspects of metadata management.
One of the main components is instances. Instances are comprised of one or more systems that
expose data. A system can also be any system that is included in the process of data management and
governance. Systems are supplied by a provider which is a vendor, external, or internal organization.

Privacy section

The management of data privacy, as is required by many regulatory authorities, stipulates an inventory
of processing activities and personal consents. It also requires that any request coming from a personal
data owner is registered and that data breaches are communicated to owners. Connected to physical
assets containing them, systems processing them and concepts defining their nature, all request

conditions are unified to ensure they comply with any rules that their usage implies.
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CHAPTER 46

Catalog overview

This section covers logical descriptions for applications, datasets and data elements. A logical
description is a universal and common description of entities. These descriptions can exist before
entities are created. for example:

« An application can be described before it exists.
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+ A dataset can be documented before the corresponding data values are stored in, or provided by,
a physical asset.

Application Environment
Dataset
+parent
Data Element
+parent
Data Element Type Relation
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CHAPTER 47

Creating applications

This chapter contains the following topics:
1. Overview

2. Creating a new application

3. Creating a new Data protection level (CIA) entry

4. Creating a new application type

47.1 Overview

In the Catalog menu of the main control panel, select Applications to access the application screen.
The main page listing all existing applications displays.

47.2 Creating a new application

After selecting the + icon in the top-left corner, you can create an application by providing the required
information. Use the tooltip to view descriptions of any properties that you have questions about.
When you have completed the creation of your application, select Save and close.
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47.3 Creating a new Data protection level (CIA) entry

You can create predefined data protection level configurations to apply to your applications. When
creating or updating an application, select + Create from the Data protection level (CIA) menu.

ntifie *= [auto-incremented value |

1bel : My Application

[not defined] -

[not defined] -
Data protection level (CIA)

[not defined]

+ Cr?Jlﬁe Selector 7

Documentation [not defined]
7 Drive & Upload
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applications

47.4 Creating a new application type

As shown below, you can create a new application type from the Type menu by selecting + Create.

|dentifier
Label

Description

Codename

Type

Owner

Data protection level (CIA)

Logo

[ auto-incremented value |

CRM system

Primary Customer Relationship Management (CRM) system.
Central instance accessible from anywhere with two-factor

authentication. No VPN connection required. Connect to this

application to track sales operations and value events.

Primary CRM

[not defined]
CRM @

+ Cregte

Selector 7

Tnm‘am‘nga;

7 Drive

4 Upload
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CHAPTER 48

Creating data elements

This chapter contains the following topics:
1. Overview

2. Creating a new data element

3. Creating a new data element type

4. Creating a new data element status

48.1 Overview

In the Metadata perspective's Catalog menu, select Data elements. The workspace changes focus
and displays all existing data elements.

48.2 Creating a new data element

Select the + to create a new data element record. In the screen that displays you can use the fields to
provide information about the data element. Use the tooltip to view descriptions of any properties that
you have questions about. When you have completed the creation of your application, select Save
and close.
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48.3 Creating a new data element type

When creating a data element, you can use the Data element type menu to create a new data element

type.
|dentifier =1
Label * Customer
Description A person who buys goods or services from a shop or business.
/
Documentation [not defined]
7 Edit & Upload
Data element type 4
[not defined]
Parent data element
Attribute
Logo Object (7}
+ Create Selector [

— e

48.4 Creating a new data element status

When creating a data element, you can create a new data element status using the Status menu.

Status [ >
. [not defined]
Critical data
+ Create Selector (7
Personal data category [not defined] v

Regular Expression
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This chapter contains the following topics:

1.

©® N ek~ N

Launch Provisioning Workflow

First step: content analysis

Second step: fill view elements

Third step: review

Forth step: approvals

Fifth step: view finalization

Validation
Published View Updates

CHAPTER 49

Provisioning

49.1 Launch Provisioning Workflow

Provisioning is a process that allows you to define a view that aggregates selected assets or datasets.
In the case of datasets, the preferred asset will be used.

Select the datasets you want to include, and then click the Request provisioning icon (cart) in the
toolbar to launch provisioning.
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49.2 First step: content analysis

EBX® displays what can be done with the contents of the shopping cart.

Shopping cart content analysis

The list of exploitable items from your shopping cart is displayed in the table below.
Assets are direclty considered for provisioning when preferred asset are resolved from Datasets.

Item in cart Corresponding asset name Asset type Supported
Datasets > Active customers - - -
Assets > orders orders DB Table Yes

Assets > name_basics name_basics DB Table Yes

By clicking on the start button you will be redirected to the declaration of the asset corresponding to the view to be published.
It requires a name that will be used as publication name and an instance of TDV in which the view will be published.

Enabled

No

Yes

After reviewing the elements select Start.

49.3 Second step: fill view elements

Request provisioning

Mame - Report_Customers_2020

Owner * Marketing -

Instance TDV - For Localhost test agent -

Justification ® Need to access this data to build our yearly report up to date
for 2020)

On this page, you’ll have to fill in key information for the view to be created. This view will be created
as an EBX® Metadata Management application asset. This asset must have a owner and must be
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located in an instance of TDV where the view will be created. A justification is required by reviewers

and approvers to qualify you request.

The instances of TDV available are the ones that are automatically created on agent registration.

49.4 Third step: review

This step occurs only when a reviewer has been configured by an administrator.

49.5 Forth step: approvals

This step occurs only when at least one approver has been configured by an administrator.

49.6 Fifth step: view finalization

When all elements are set, select Finalize.

Finalize provisioning > Report_Customers_2020

Send back to requester

Main Referenced assets References ncoming flows Outgoing flows Datasets
dentifier = 67,393
Name ‘ [Report_CustDmers_EDEO ]
Labe: . @ Report_Customers_2020
y:
Asset type : TDV Published View - L’.'

Logo . @

S

DB View 64.png
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49.7 Validation

You can check the created view in the EBX® Metadata Management application's assets table.

Hierarchy Asset View

P @ ds_bikestores (disabled)
> @ imdb
P @ iso3166

® 1 TDV - for Localhost test agent

e My View

You can also check the creation of this Published TDV View in your TDV Studio.

49.8 Published View Updates

For TDV published views that were created using provisioning, the owner can perform update
operations from EBX®.

Add incoming flows to a published view

If you add an incoming flow to an asset of type TDV Published View, this triggers a publication of
the corresponding resource in TDV.
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In the Metadata menu of the main control panel, select Asset to display the main page listing all
existing assets. Then, open the TDV Published View asset that you wish to edit.

Hierarchy asset view

o g EHEBEe0 O®B M-

> @ imdb
® @ TDV - for Localhost test agent

v B, TestHZ

b B ds_orders

£L PublishedView

Select the Incoming flows tab.

PublishedView
Main Referenced assets References Incoming flows I Qutgoing flows Datasets
Identifier T 25541
Name *  PublishedView
Label . 0 PublishedView
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Select the + icon in the upper-left corner to create a new technical flow.

PublishedView
Main Referenced assets References Incoming flows Qutgoing flows Datasets
+ Actions «
= Source asset  ~ Data transfer Flow type Caching Protocol transformation
title_akas (g Mo Logical

Select a source asset. Only assets that are the results of harvesting and can be published are presented
in this list.

PublishedView » Technical flows : New record

Bbource asset ¢ customers - 4
Target asset == PublishedView [
Data transfer Yes @ No
Flow type Logical -
Caching Yes '® No
Protocol transformation Yes @No
Parent flow [not defined] -
Documentation [not defined]

4 Edit & Upload
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Select Save to validate creation of a new flow. Saving may take a little time because it will also create
a corresponding publication in TDV.

¥ BV Desktop (admin)
¥ @ Composite Data Services

¥ L@ Databases

> @ system

gy ¥y ¥y ¥y vy ¥y vy vy Yy vy vy

e
e
=
e
e
e
e
=
e
e
F

PublishedView

-] customers
- title_akas

Remove incoming flows from a published view

Delete incoming flow

If you remove an incoming flow from an asset of type TDV Published View, this will trigger a removal
of the corresponding published resource in TDV.

In the Metadata menu of the main control panel, select Asset to display the main page listing all
existing assets.
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Open the TDV Published View asset that you wish to edit.

Hierarchy asset view

> @ imdb
® @ TDV - for Localhost test agent

v B, TestHZ

b B ds_orders

£L PublishedView

Select Edit and then the Incoming flows tab.

PublishedView

Main Referenced assets References Incoming flows I Qutgoing flows Datasets
Identifier == 25541
Name *  PublishedView
Label . 0 PublishedView
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Select the flow you want to remove and select Delete in the Actions menu.

PublishedView

Main Referenced assets References Incoming flows Qutgoing flows Datasets

+ Actions

Duplicate this record

View history o Logical
Data Exchange ,

Y Insight y © Logical
Visualization »

No No

Delete ? ata transfer Flow type Caching Protocol transformation

This will delete the technical flow and also the corresponding published element in TDYV, if one exists.

v 9 Desktop (admin)

¥ @ Composite Data Services

v Iﬁ Databases
> e

gy ¥ ¥y ¥y vy ¥y ¥y vy vy vy

> @&

® PublishedView

Disable asset used as incoming flow

If you manually disable an asset that is used as incoming flow for a published view, this triggers a
removal of the corresponding published resource in TDV.

TIBCO EBX® Product Documentation 6.2.0

275



Documentation > User Guide > EBX® Metadata Management > User Interface > Navigation pane > Metadata catalog > Provisioning

In the Metadata menu of the main control panel, select Asset to display the main page listing all

existing assets will be displayed.

Select the asset you wish to disable and edit it.

Hierarchy asset view

4
il
=
=
=
&

v @) TDV - for Localhost test agent

Set the Disabled field to Yes.

A warning displays to indicate that this asset is used as an incoming flow for a TDV Published View.

Disabled . ) (® Yes No

ﬂ, This asset is used as incoming flow for TDV Published view
‘PublishedView'. Once it is disabled corresponding published resource
in TDV will be deleted.

This will delete the corresponding published element in TDV if one exists.
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cHAPTER 50

Regular expressions

This chapter contains the following topics:

1.

£ LN e WD

Overview
Characters

Character classes

Predefined character classes

POSIX character classes (US-ASCII only)

Classes for Unicode scripts, blocks, categories and binary properties

Boundary matchers

Greedy quantifiers

Reluctant quantifiers

10.Possessive quantifiers

11.Logical operators

12.Back references

13.Quotation

14.Special constructs (named-capturing and non-capturing)

50.1 Overview

Regular expressions are used to classify assets and tie them to data elements depending on whether
the sample data of an asset matches with the regular expressions defined on data elements.

50.2 Characters

x The character x

\\ The backslash character

\on The character with octal value On (0 <= n <= 7)

\onn The character with octal value Onn (6 <= n <= 7)

\emnn The character with octal value Omnn (6 <= m <= 3, 0 <= n <= 7)

\xhh The character with hexadecimal value Oxhh
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o \uhhhh The character with hexadecimal value 0xhhhh

o \x{h...h} The character with hexadecimal value Oxh...h (Character. MIN_CODE_POINT <=
0xh...h <= Character MAX_CODE_POINT)

« \t The tab character (\uoee9)

« \n The newline (line feed) character (\uoeoA)
» \r The carriage-return character (\ueeep)

o \f The form-feed character (\ueeoc)

+ \a The alert (bell) character (’007")

+ \e The escape character ('\u601B)

+ \cx The control character corresponding to x

50.3 Character classes

« [abc] a, b, or ¢ (simple class)

« [nabc] Any character except a, b, or ¢ (negation)

» [a-zA-Z] athrough z or A through Z, inclusive (range)

» [a-d[m-p]] a through d, or m through p: [a-dm-p] (union)

o [a-z&&[def]] d, e, or f (intersection)

o [a-z&&[~bc]] a through z, except for b and c: [ad-z] (subtraction)

o [a-z&&[~m-p]] a through z, and not m through p: [a-1q-z] (subtraction)

50.4 Predefined character classes

« . Any character (may or may not match line terminators)
« \d A digit: [0-9]

« \\D A non-digit: [20-9]

» \s A whitespace character: [ \t\n\x0B\f\r]

« \\S A non-whitespace character: [A\s]

e \w A word character: [a-zA-Z_0-9]

« \W A non-word character: [A\w]

50.5 POSIX character classes (US-ASCII only)

« \p{Lower} A lower-case alphabetic character: [a-z]

« \p{Upper} An upper-case alphabetic character: [A-Z]

o \p{Ascii} All ASCII:[\x00-\x7F]

» \\p{Alpha} An alphabetic character:[\p{Lower}\p{Upper}]
o \p{Digit} A decimal digit: [0-9]

o \p{Alnum} An alphanumeric character:[\p{Alpha}\p{Digit}]
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50.6 Classes for Unicode scripts, blocks, categories and

\p{Punct} Punctuation: One of 1"#$%&"' ()*+, -./:;<=>?@[\]1~_" " {|}~
\p{Graph} A visible character: [\p{Alnum}\p{Punct}]

\p{Print} A printable character: [\p{Graph}\x20]

\p{Blank} A space or atab: [ \t]

\p{Cntrl} A control character: [\x00-\x1F\x7F]

\p{xDigit} A hexadecimal digit: [0-9a-fA-F]

\p{Space} A whitespace character: [ \t\n\x0B\f\r]

binary properties

\p{IsLatin} A Latin script character (script)

\p{InGreek} A character in the Greek block (block)

\p{Lu} An uppercase letter (category)

\p{IsAlphabetic} An alphabetic character (binary property)

\p{Sc} A currency symbol

\P{InGreek} Any character except one in the Greek block (negation)

[\p{L}&&[A\p{Lu}]] Any letter except an uppercase letter (subtraction)

50.7 Boundary matchers

A The beginning of a line

$ The end of a line

\b A word boundary

\B A non-word boundary

\A The beginning of the input

\G The end of the previous match

\z The end of the input but for the final terminator, if any

\z The end of the input

50.8 Greedy quantifiers

x? X, once or not at all
X* X, zero or more times
X+ X, one or more times
x{n} X, exactly n times
x{n, } X, at least n times

X{n,m} X, at least n but not more than m times
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50.9 Reluctant quantifiers

« X?? X, once or not at all
e X*? X, zero or more times
o X+? X, one or more times
« x{n}? X, exactly n times
o X{n,}? X, at least n times

« X{n,m}? X, at least n but not more than m times

50.10 Possessive quantifiers

« X7+ X, once or not at all
e X*+ X, zero or more times
« X++ X, one or more times
« X{n}+ X, exactly n times
o X{n,}+ X, at least n times

« X{n,m}+ X, at least n but not more than m times

50.11 Logical operators

« xv X followed by Y
« X|Y Either X or Y

« (X)X, as a capturing group

50.12 Back references

« \n Whatever the nth capturing group matched

» \k<name> Whatever the named-capturing group name matched

50.13 Quotation

+ \ Nothing, but quotes the following character
» \Q Nothing, but quotes all characters until \E
» \E Nothing, but ends quoting started by \qQ

50.14 Special constructs (hamed-capturing and non-
capturing)

+ (?<name>X) X, as a named-capturing group
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e (?7:X) X, as a non-capturing group

o (?idmsuxuU-idmsuxU) Nothing, but turns match flags i d m s u x U on - off

+ (?idmsux-idmsux:X) X, as a non-capturing group with the given flagsi d m s u x on - off
+ (?=X) X, via zero-width positive lookahead

« (?'X) X, via zero-width negative lookahead

o (?7<=X) X, via zero-width positive lookbehind

o (?<!X) X, via zero-width negative lookbehind

+ (?>X) X, as an independent, non-capturing group
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CHAPTER B1

Governance overview

This section describes how data is managed by the different business domains.

Each domain can have its own terminology and roles. Additionally, groups of users along with their
roles and entitlements over data are defined here.
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Data programs aim to register any program, initiative or project around data.

Role Business Process
e
RACI
Rules
Business

Business Term
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CHAPTER 52

Defining a business term

To define a business term, use the Governance menu in the Metadata and select Business Term to

open the corresponding screen. This screen displays all existing terms and gives access to the creation
menu to add new terms to the list.

Click on the + icon in the top left corner to access the creation screen.

When you have completed the creation of your business term, click on the Save and close button.

TIBCO EBX® Product Documentation 6.2.0 285



Documentation > User Guide > EBX® Metadata Management > User Interface > Navigation pane > Governance > Defining a business term

TIBCO EBX® Product Documentation 6.2.0 286



Documentation > User Guide > EBX® Metadata Management > User Interface > Navigation pane > Metadata > Metadata section overview

CHAPTER 53

Metadata section overview

The materialization of the dataset described in the catalog is documented in the Metadata section.
Asset are physical resources containing or providing data.

Their technical structures and properties according to their types are located in this section.

o Technical Flow

=S0Lrce

[ “tlarget

Link |

Asset Type
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CHAPTER 54

Managing assets

This chapter contains the following topics:
1. Create an asset

Modify an asset
Complex data types

Asset types
Create a new asset type

O e

Duplicate asset type

54.1 Create an asset

Under Metadata in the Metadata perspective, select Assets to view your assets.

Click on the + Asset button in the top left corner to access the asset creation screen.

54.2 Modify an asset

If you want to modify the current asset, click on the Edit button on the top left corner.
You will see the asset form pre-filled with existing data. You can modify what you want.

In the form view, you may see embedded tables. Each embedded table represent an association (way
to link your current asset to other elements). In this case, you can open the Actions menu and:

+ Select one or multiple record(s) an detach it (them).
+ Select one or multiple record(s) an delete it (them).
« Create a new target record.

» Associate to existing record.

54.3 Complex data types

Some asset types are defined as containing data. These assets can also contain a data type attribute.
The values that this attribute can carry are enumerated as data types and can be selected in a list. A
new occurrence can also be created. A data type is made of a label and a description and is mainly
informative. However, a flag can be set to define a type as complex. As soon as a data is complex, all
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assets linked to this data type will share the same structure. It means that the sub tree starting from
this asset will be synchronized will all assets of the same type.

v [@ Test_1_prime
w» [ Test 2
EE Test 3
Ed] Test 4
v [ Test 1
w [ Test_2
EE Test 3

Ed] Test 4

Here, Test_1 and Test_1_prime have the same complex type. Their structure are synchronized from the
creation of Test_1_prime which happened after the creation of Test_1. Any change on any attributes
of a child of Test_1 will affect its counterpart under Test_1_prime. Any deletion or creation will also
be mirrored by any assets of the same data type.
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Name

Description

Asset type's parent

Specific included fields

DB table

Collection of related data
held in a table format within
a database. It consists of
columns and rows. DB
Schema

- Encoding- Partitioned
DB table- TableSpace-
Encryption- Sample file

N/A

DB Column

Set of data values of
particular simple type. May
contain text values, numbers
or even pointers to files in the
operating system.

DB Table

- Field type- Precision-
Encryption- Column index-
Sample file

DB Schema

Database structure described
in a formal language
supported by the database
management system.

- Tablespace

N/A

DB View

Searchable object in a
database that is defined by a

query.

DB Schema

- Tablespace

DB Function

Perform basic operations,
such as Sum, Average,
Count, etc., and additionally
use criteria arguments,

that allow you to perform
the calculation only for

a specified subset of the
records in your database.

DB Schema

- Tablespace

DB Synonym

Represent an alias or alternate
name for a table, view,
sequence or other schema
object.

DB Schema

- Tablespace

DB Sequence

Database object which allows
users to generate unique
integer values.

DB Schema

- Tablespace

REST Service

REST web services allow
querying systems to
manipulate web resources via
their textual representations
through a set of uniform,
stateless, predefined
operations.

- Version- URL (endpoint or
URI)

N/A

REST Resource

Object with a type, associated
data, relationships to other
resources, and a set of
methods that operate on it.

REST Service

- Field type- URL (endpoint
or URI)

SOAP Service

Simple object access protocol
service for exchanging
structured information.

- Version- URL (endpoint or
URI)

N/A
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Name

Description

Asset type's parent

Specific included fields

SOAP Operation

Operation in a SOAP service
like getRecord, count, Create,
etc.

SOAP Service

- URL (endpoint or URI)

SOAP Request Request to access soap SOAP Operation N/A
operation.
SOAP Response Response returned from a SOAP Operation N/A
soap request link to a specific
soap operation.
Excel Workbook Collection of one or more - Version- Encoding- Locale- N/A
spreadsheets also called Attribute value- Encryption-
worksheets. File name- File size- File
extension- Header present-
Protected- Sample file
Excel Worksheet Single page in a file created Excel Workbook - Protected- Order- Sample
with Excel. file
Excel Worksheet Array Array of worksheet. Excel worksheet - Number of lines- Start line-
Protected- Sample file
CSV file Comma separated value file - Version- Encoding- N/A
which allows data to be saved | Encryption- File name- File
in a tabular format. size- File extension- Line
separator- String delimiter-
Header present- Start line-
Protected- Sample file
Column Represent a column in a CSV - CSV file - Excel Worksheet - Format- Field type- Default
file or excel worksheet. value- String delimiter-
Column index- Row index-
Formula- Orientation-
Sample file
XML File Extensible markup language - Version- Encoding- XML N/A
data file. Formatted much Encoding- Encryption-
like an HTML document but File name- File size- File
uses customs tags to define extension- Protected- Sample
object and the data within file
each object.
XML Stream Stream of xml content. - Encoding- XML Encoding N/A

XML Element

Is everything from the
element's start tag to the
element's end tag.

- XML file - XML Stream

- Field type- Node type-
Default value- TagName
(attribute name)- Pattern-
Range- Enumeration-
Maximum length- Minimum
length- Sample file

XML Attribute

Contains data related to a
specific element.

XML Element

- Field type- Default value-
Sample file

JSON File

File that stores simple
data structures and objects
in JavaScript Object
Notation(JSON) format,
which is a standard data
exchange format.

- Version- Encoding-
Encryption- File name-
File size- File extension-
Protected- Sample file

N/A
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unknown format.

Name Description Asset type's parent Specific included fields
JSON Element Data structure in a JSON. - JSON file- JSON stream - Format- Field type- Default
Data can be a json object, value- Array length- Media
text, number, boolean, etc. encoding- Content media
type- Pattern- Range-
Enumeration- Maximum
length- Minimum length-
Sample file
JSON Property Each JSON Element is JSON Element - Field type- Default value-
identified by its JSON Sample file
property.
JSON Stream Stream of JSON content. - Encoding N/A
TDV Published view Specific TIBCO® Data - Encoding- Sample file N/A
Virtualization published view.
Undefined Default asset type for N/A N/A

54.5 Create a new asset type

You can create a new asset type by clicking the + button on the top left corner of the asset type main

view.

You will see a form with fields to complete.

54.6 Duplicate asset type

If you want to create your own asset type from an existing one, you can click on the duplicate action

button.

First of all, you will need to display the asset type you want to duplicate by clicking on it if you are
in the hierarchical view or clicking on the More button in the card view mode.

QO = o

DB Table

Maore

DB Column

More
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In the asset type view form, click on the duplicate button on the top left corner.

0}

= D

DB Table 3

TRUE

You will see a pre-filled form in which you can make your updates.
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CHAPTER BbH

Technology overview

Data management relies on instances that are represented as many systems.

This is an instance of a system running on a given infrastructure which exposes data.

Systems can also be any system entering in the process of data management and governance.

They are provided by a provider which can be a vendor or any other external or internal organization.

System type
\
Provider System Stack
Infrastructure Type
Instance Infrastructure Operating System
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CHAPTER 56

Create an instance

In the Technology group of the Main perspective, select Instances to access the instance screen. The
main page listing all existing instances displays.

From there you have multiple choices for instance creation:

+ Click on the + icon in the top left corner to access the creation screen and create an instance from
scratch.

+ Click on the squared + icon in the top left corner to access the creation screen from the Agent.

For the instances created from scratch you have a possibility to create a corresponding data source
in TDV and harvest metadata automatically. See Create data source from instance [p 365] for more
information.

This chapter contains the following topics:

1. Create an instance from the Agent

56.1 Create an instance from the Agent

To create an instance from the agent you will need to have an available agent connected to your
TIBCO® Data Virtualization application.

On the instance’s main page, click on the + icon at the top.

i o
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The main page listing all available data sources to add displays. In this page, you can select one or
more data sources you want to add by clicking on the checkbox and selecting + Create instance(s)
in the top left corner.

| © Create instance(s) 1 selected
fshared/examples/City-Instance File-Delimited MNEW
/shared/examples/dellstore PostgreSQL 9.1 NEW
fshared/examples/ds_inventory PostgreSQL 2.1 MEW

At the end of the creation, you will see a success message and the instance will be automatically added
to the instance list.

Attributes description displayed on the data source selection list:

Datasource identifier in TDV: TDV identifier of the data source in your application.
Datasource type: Type of the data source like Oracle, PostgreSQL ...

Instance identifier in the EBX® Metadata Management application: Identifier of the selected
instance in the instance table of theEBX® Metadata Management application.

The identifier is empty if the corresponding instance does not exist in the EBX® Metadata
Management application.

Status: Status of the TDV data source in the EBX® Metadata Management application. If equals
to NEW), the data source does not exist in the application. If equals to STORED, the data source
already exits.

Created at: Datasource creation date.

Updated at: Datasource last updated date.
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This chapter contains the following topics:

1. Overview

2. Create a new system

3. Create a new stack

57.1 Overview

In the Technology group of the Main perspective, select Systems to access the system screen. A

main page listing all existing systems displays.

CHAPTER B7

Create a system

If you click on Hierarchy view, you will see a few built-in systems needed for harvesting and
provisioning features.

TIBCO Data Virtualization

IBM DB2 (several versions)

HBase (several versions)

HSQLDB

Microsoft Excel

Microsoft SQL Server (several versions)
Oracle MySQL (several versions)

Oracle Database (several versions)
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» PostgreSQL (several versions)

System hierarchical view

© Amazon Aurora
© Db2 (9)

O Db2 (10)

O Db2 (11)

O ¢ Db2z/0S

O Db2 z/0S (11)

© E-commerce plateform (1.4.2)
© HBase

© HBase (0.98)

© HSQLDB (2.2)

© Linux

These built-in systems cannot be deleted as are needed by harvesting & provisioning features. You
are able to create other systems and system types, according to your needs.

57.2 Create a hew system

After clicking on the + icon in the top left corner, you have access to the creation screen. In this screen
you have to fill system information.
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57.3 Create a new stack
A stack is a way to rationalize information system and technical architecture governance by associating
different systems together in a structured manner and trying to limit the combinations between them.

In the EBX® Metadata Management application, a stack is defined as a system referencing another
system.

To define a new Stack, create a new System using System type = Stack and fill the other System
attributes.

Then you have two possibilities to define the stack components

« From the Stack itself, in the Stack components tab, associate the components (Systems) of this
stack (for instance, a database + an application server and a web server, to define a web application
stack)

« From each component, in the Stacks tab, associate this component to the wanted stack.
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CHAPTER 58

Create a system type

The system types have multiple uses. For example:
 Sorting systems into families
+ Defining stacks
+ Defining operating systems for infrastructures
« Typing TDV infrastructure to allow provisioning

In the Technology menu of the main control panel, select Systems to access the system screen. When
creating a System, you have to define its type.

A few built-in system types are defined:
« Operating System: this one is used to filter available operating systems in infrastructure definition
page
« Database System
« Middleware
» Application Server
»  Web Server
» Enterprise Service Bus
« Infrastructure Service
« Security Service
« Storage System
« Messaging System
« FEvent Management System
« Caching System
« File System
« Agent
» Datawarehouse
« Datamart
« Datalake
« ETL
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« Hadoop-based Platform
« Registry/Directory
« Gateway
« Stack: this one is used to define [stacks]./manage_systems.html)
« Data Virtualization (TIBCO® Data Virtualization for instance)
+ Cloud Platform
» Spreadsheet
« Master Data Management
« ERP
» Business Intelligence
+ Undefined
This chapter contains the following topics:

1. Create a new system type

58.1 Create a new system type

You can create other system types if built-in types are not sufficient for your usage.
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On system creation/update page, on system type selection you can create a new system type

Type

Provider

Edition

Version
Commercial version
License

Usage policy
Parent system

Contact

Documentation

Built-in system

\

[not defined]

Agent

Application Server
Business Intelligence
Caching System

Cloud Platform

Data Virtualization
Database System
Datalake

Datamart
Datawarehouse
Enterprise Service Bus
ERP

ETL

Event Management System
File System

Gatewavy [7
+ Create Selector [

TIBCO EBX® Product Documentation 6.2.0

305



Documentation > User Guide > EBX® Metadata Management > User Interface > Navigation pane > Technology > Create a system type

TIBCO EBX® Product Documentation 6.2.0 306



Documentation > User Guide > EBX® Metadata Management > User Interface > Navigation pane > Technology > Create an infrastructure

CHAPTER 59

Create an infrastructure

This chapter contains the following topics:

1. Create an infrastructure type

2. Create a new infrastructure type

59.1 Create an infrastructure type

The infrastructure types are used to classify infrastructures between families. In the Technology group
in the Main perspective, select Infrastructuresto access the infrastructure screen. When creating
an infrastructure, you have to define its type.

A few built-in infrastructure types are defined
« SaaS Application
« Paas Instance
« laaS Instance
« Physical Server
+ Virtual Server
« Containerized: use of Docker technology, for instance
« Serverless
» Appliance: Oracle Exadata, for instance
« Mainframe
« 10T Device
» Mobile Device
« Virtual Desktop
« Personal Computer
+ Undefined

59.2 Create a new infrastructure type

You can create other infrastructure types if built-in types are not sufficient for your usage.
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On infrastructure creation/update page, on infrastructure type selection you can create a new
infrastructure type:

Identifier = 8
Label * Infrastructure
Description

| =

[not defined]
CPU number Appliance

Containerized
CPU type

laas Instance
RAM number (GB) IOT Device

i Mainframe

Drive type

Mobile Device
Drive capacity (GB)

Paa5s Instance

Operating system Personal Computer

Physical Server

Clust
e Saa$ Application
Business Continuity Plan Serverless
Undefined
Owner
Virtual Desktop
Documentation Virtual Server [

+ Create Selector [
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cHAPTER 60

Create a provider

In the Technology menu in the Metadata perspective, select Providers to access the provider screen.
The main page listing all existing providers displays.
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CHAPTER 61

Privacy overview

The management of data privacy, as it is required by many regulation authorities, means keeping an
inventory of processing activities and personal consents. It also requires you to register any request
coming from personal data owners and communicate data breaches to them.

Connected to physical assets containing them, systems processing them and concepts defining their
nature, all conditions are unified to ensure compliance with rules that their usage implies.

Request status Request type

Consents Requests

Processing activity purpose

Consent - Processing activity Processing activites o

Processing activity type

Data breaches

Processing activity - Security measure

Security measures Data breaches type
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CHAPTER 62

Processing activities

Located in the Metadata perspective under Privacy, the Processing activities table registers all
processing activities for your company. For regulation compliance purposes, it is important that
companies can provide this registry of activities. This is especially true for activities related to personal
information.

Each processing activity gathers information such as the purpose, the responsibilities, the impact
assessment, the related data categories and personal data categories.
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CHAPTER 63

Cconsents

Located in the Metadata under Privacy, the Consents table allows you to track individual consent
for given processing activities and personal data.
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CHAPTER 64

Data breaches

Located in the Metadata under Privacy, the Data breaches table handles reporting of detected data
breaches. A breach concerns a given instance. Most regulation requires that a notification is submitted
to supervisory authorities that includes: breach status, discovery date, submission date, impacted
customers, etc.
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CHAPTER 65

Requests

Most data privacy regulations give individuals the right to request that a company disclose what data
from the individual the company manages and processes. For instance, chapter I1I of the GDPR text
lists the access, rectification, portability, erasure, processing restriction and object rights of a person.
Located in the Metadata perspective under Privacy, the Requests table allows you to keep track of
such requests and their progress.
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CHAPTER 606

Workspace

This chapter contains the following topics:
1. Overview

2. Data views

66.1 Overview

The workspace displays metadata and allows you to perform related actions. Except for the home
section, all menu items display a default view to access a list of entities. A grid contains cards that
represent an entity of the same kind, such as an application or a business term. A hierarchical view
is used to provide a default view of assets.

A toolbar displays in the upper left corner of the workspace. It allows an authorized user to create
records by clicking on the plus icon. When the created item is subject to a workflow, this button
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launches a creation workflow. This toolbar also allows you to switch to the default tabular view or to
the default hierarchical view. Select the clock icon to access modification history for the current entity.

Applications (Tile view) 3 ?
© °c8 Bam <0 M- Q v @
Total: 15 records View = =
eCommerce Platform Finance ERP 360 View of our busi...
eCommerce ERP Reporting
SAP4 2 Spotfire
Main application in the comp... Main application for billing. Dashboard done in TIBCO Sp...
This is not our back-end appl... Based on SAP Contains all kind of datas reg...
=0
CRM B2B Companies MDM Sales Reporting
CRM MDM Reporting
salesforce TIBC2D EBX 2 Spotfire
Primary Customer Relationsh... Companies master data man... Reporting for sales worlwide.
Central worldwide instance a... Concerns any company what... Done in TIBCO Spotfire.

66.2 Data views

From an initial view, you can access other views and services to display metadata or perform actions.
When browsing in views, a built-in breadcrumb allows you to navigate to previous pages. This is the
recommended method of navigation as browser navigation buttons are not fully supported.

Applications > Finance ERP X £l ?
Actions + ¢ > @
Main Datasets Data elements Instances Business processes Consuming applications 3 [ ]
Identifier = 2
Label * | Finance ERP ]
Description Main application for billing.
Based on SAP
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When in the Metadata perspective, you have access to all of the standard EBX® data views:

Tabular view
Hierarchical view
Tile view
Graphical view
Details view

Custom views you create [p 347]
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CHAPTER 67

Home page

This chapter contains the following topics:
1. Overview

2. Home page widgets

3. Customize your home page

67.1 Overview

The Home page displays a global metadata view using widgets that allow quick access to services
and data.

As shown below, the first time you access the Home page you can choose to:

+ Use the default home page: Selecting this option displays the default home page, which you can
customize later. See customize your home page [p 340] for more information.

+ Create your home page: Selecting Configure my home page displays an unpopulated home page
and an Add widget button in the top left corner. Use this button to choose from and add available
widgets to your home page. Use the Save button to save changes.

67.2 Home page widgets

The Home page displays information on widgets. You can create your own widget from a widget type
or use a pre-configured widget. The following section describes the types of widgets available.

Widget types

There are multiple widget types available. For example, there is a widget for quick access to search
globally, another one for quick access to a specific table. The following sections describe the available
widgets.

Global search widget

This widget displays a search bar where you can enter search terms to search using the Global search
service. Configuration options are not available for this widget.

Metadata agent status widget

This widget displays metadata agent status. You can see if an agent is connected and, if not, the reason
why. This widget includes the following configuration options:
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« Title: widget title
» Description: widget description

» Agent: Optional parameter to limit the displayed agents to one or many selected agents

O- Metadata Agents status

o Second Agent
tdv-agent-test-3.orchestranetworks.com

o Localhost test agent
tabula.orchestranetworks.com

Workflow tasks widget

This widget displays the workflow tasks that are waiting for you or offered to you. From this widget
you can click on a task to access the workflow view or the workflow graph view. If a task is offered
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to you but not already allocated, a pop-up message displays to inform you that it will be allocated to
you. Configuration options are not available for this widget.

LJ Workflow tasks

E Create new Datasets 7
Create new occurrence of Datasets

Number of elements widget

This widget displays an entity’s top rated elements. You can click on an element to access it. If no
element is rated, this widget displays an empty sign. This widget includes the following configuration
options:

« Title: widget title
» Description: widget description
« Entity: select the entity you want to display

« Number of elements: number of top rated elements to be displayed
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+ Predicate: Xpath predicate format to filter the selected entity

Application 1

CRM

Last created elements

This widget displays last created elements from selected entities. You can access the element by
clicking on it. Hover your mouse over an element to display a tooltip that includes the creation time
and creator’s user name. This widget includes the following configuration options:

 Title: widget title
« Description: widget description

 Entity: select one or more entities that you want to display
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« Number of elements: maximum number of elements to display

+ Last created elements

Tibco MDM
Applications

Last modified elements

This widget displays the most recently modified elements from selected entities. You can access
the element by clicking on it. Hover your mouse over an element to display a tooltip that includes
the modification time and and the user name that made the modification. This widget includes the

following configuration options:
 Title: widget title
« Description: widget description

 Entity: select one or more entities that you want to display
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« Number of elements: maximum number of elements to display by entity

g Last modified elements

Application 1
Applications

Widget “Library” and “My widget”

On the Add widget dialog you can choose:
» The Library tab to display pre-configured widgets or shared widgets.
» The My widget tab to display your widgets.

Create/Duplicate/Update/Delete a widget

You can create any widget type you want. You can duplicate an existing widget from your widget
library or from the shared ones. You can only update or delete your own widgets.
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Create a widget

To create a new widget, click on the gear icon in the top left corner of the home page.

Q  Search
-O Metadata Agents status

o Second Agent
tdv-agent-test-3.orchestranetworks.com

o Localhost test agent
tabula.orchestranetworks.com
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You are now in home page edit mode. Click on Add widget in the top left corner.

+ Add widget

Q, Search
0

'O- Metadata Agents status

Second Agent
tdv-agent-test-3.orchestranetworks.com

Localhost test agent
tabula.orchestranetworks.com
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A dialog displays that allows you to create a widget. Select Create widget to open the widget
configuration wizard and begin the creation process.

]
N\,
i

P
N,
il

Cancel Create widget

The widget configuration wizard includes the following steps:
» Select the widget type.
+ Configure widget: configure widget values and specific widget type attributes.
« Share widget: configure the widget sharing parameter. A shared widget is available for other users.

« Verify widget: verify widget information and process creation.

Note

You must enter all required information at each step to move to the next. The Next button
is disabled until you do.
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The following sequence of images shows a sample widget creation:

Add widget

o Select widget type

Please select the widget type you want to use for your custom widget
Widget type
Global Search v

o Configure widget

° Share widget

o Create and add

Add widget

o Select widget type

o Configure widget

Fill widget main information
Widget name*

Widget description

Previous MNext

o Create and add
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Add widget

o Select widget type

° Configure widget

o Share widget

A shared widget will appear in the widget library for those who belongs to the selected
profiles

Share widget

Profiles*

everyone -

Previous

o Create and add

Add widget

o Select widget type

° Configure widget

o Share widget

° Create and add

You are about to create a new widget for you. If you click on "Validate" the widget will
be added and displayed in your home page. If you are not sure, you can review your
widget by clicking on the "Previous" button.

Previous Validate
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Modify a widget

When you modify a widget, a simplified version of the widget configuration wizard allows you to

modify: type attributes, the sharing configuration, and verify and apply the changes.
To modify widget:
If the widget you want to edit is on your Home page:

1. Select the gear icon to edit the Home page.

2. Select the edit icon on the widget you want to modify.

3. Complete the steps in the wizard.

+ Add widget

O Metadata Agents status

o Second Agent

tdv-agent-test-3.orchestranetworks.com

o Localhost test agent
tabula.orchestranetworks.com

If the widget you want to edit is not on your Home page:
1. Select the gear icon to edit the Home page.
2. Select Add widget and in the dialog that displays, select the My widget tab.

3. Select the edit icon on the widget you want to modify.
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4. Complete the steps in the wizard.

Select widget
Library by waiclpet
" Test form i _
test form
8 Toprated assets W |
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The following sequence of images demonstrates the widget modification process.

O Modity widget

Fill widget main information

Widget name *
Top rated Applications

Widget description

Display top rated Applications

Specifics parameters for widget type : Top rated elements

Title®

Top rated Applications

Description

Display top rated Applications

Entity *
Applications

MNumber of elements *

5

Mot empty and not negative

Predicate

[

[
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@ Modify widget

o Share widget

A shared widget will appear in the widget library for those who belongs to the
selected profiles

Share widget

Profiles *

everyone b

o Apply modifications

@ Modify widget
0 Share widget

e Apply modifications

Are you sure to apply modification ? If you click on "Validate" the widget will be
updated. If you are not sure, you can review your modifications by clicking on the

"Previous" button.

Previous Validate

Duplicate a widget

To duplicate an existing wizard:

1. Select the gear icon to edit the Home page.
2. Select Add widget.

3. Choose the desired widget from the library or your collection and select its duplicate icon. The
configuration wizard displays.
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4. Complete the steps in the wizard to duplicate the widget and add it to your current home page.

Select widget

Cancel Create widget

Delete a widget
You can only delete widgets that you have created. To delete a widget:
1. Select the gear icon to edit the Home page.
2. Select Add widget.
3. Select the My widget tab.
4

. Select the delete icon on the desired widget. The widget is deleted after you confirm the action.

Select widget

Es Test form

1 1 Top rated assets AN |

Cancel Create widget

Note: if your widget was shared or was in use in your home page, this action will remove it for you
and all other users.

67.3 Customize your home page

If you prefer to display a specific widget instead of another you can do it thanks to home page
customization.

If you start from the default home page or from a blank one, you can:
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o Modify widget position [p 341]

« Add/Remove pre-configured widget [p 342]

o Add/Update/Remove a widget created by you [p 345]

Modify widget position
To move a widget:

1. Select the settings icon.

2

Q  Search
O Metadata Agents status

o Second Agent
tdv-agent-test-3.orchestranetworks.com

o Localhost test agent
tabula.orchestranetworks.com
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2. Select and drag a widget to the desired location.

+ Add widget

Q

%0
O Metadata Agents status

o Second Agent
tdv-agent-test-3.orchestranetworks.com

o Localhost test agent
tabula.orchestranetworks.com

0 %i

Application 1 632
Mumber of Assets

)
CRM 4

Ol
o
13

MNumber of Instances

|

3. Save your modifications.

Add/Remove pre-configured widget

To add and remove widgets, enter Home page edit mode by selecting the settings icon.
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To remove a widget, select its close icon.

+ Addwidget

Q. Search
s oe
) Metadata Agents status : %{ |
o Second Agent | 632
tdv-agent-test-3.orchestranetworks.com 3 Number of Assets
| &
o Localhost test agent i .
tabula.orchestranetworks.com 1 %0
Ol
o
13
Number of Instances
4 i
00 00
W Top rated Applications * lop rated Assets
= Aopliatont R
CRM
a w W
To add a widget:

1. Select Add widget.
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2. From the Library tab, select the widget you want to add.

Select widget

Library My widget

Global search

o Metadata Agents status
" Display Tibco Cloud Metadata agent status.

Number of Applications

Note

Widgets are added to the end of your home page. Once it is added, you can move to the
desired location. You can only add a widget that is not already on your home page.
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Add/Update/Remove a widget created by you

Use the steps in the previous section, but select the My widgets tab in the Add widget dialog box.

Select widget

Library My widget
e Test form
Bl
test form
—+1 Top rated assets
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CHAPTER 68

Custom views

This chapter contains the following topics:
1. Overview
2. Tabular views

3. Hierarchical views

68.1 Overview

You can customize views in the EBX® Metadata Management application based on the requirements
of target users. You can create the following types of views:

« Tabular: A table view to sort and filter the displayed records.

« Hierarchical view: A tree view that links data in different tables based on their relationships.

68.2 Tabular views

In the table view mode, select the View button on the top right corner. The menu that displays allows
you to:

« Apply an existing view by clicking on the view’s name.
« Manage existing views, if you have sufficient permission.

« Create a new view.
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Creating a new view

To create a new view, select View, then Create a new view.

1-400f 40 - T

.'v'lll.".-'. =
¢ Data elements [DataElementDefaultTableView]

Data elements hierachical view [DataElementDefaultHierarchyView]

1siness
Edit
tc [Default view]
Views management
100ds

Return to recommended view

cantra Manage recommended views

Create a new view

1 which
Manage views »

iely ide  [see details]

In the dialog box that displays, you can:
+ Set the name
+ Set the owner
+ Set profile/user to share the view with
+ Set the view mode

To create a new tabular view, set the view mode to Simple tabular view. If you want to share your
view with other users you can:

« Set the profile (identified by [profile-name]): the view is shared with all users included in the
profile.

« Set the user: the view is shared with only the specified user.
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Click on the Next button to continue the creation process. You are presented with the options shown
in the following image and described below.

Displayed columns

@ ldentifier

Label .

Description

Displayed Displayable

Documentation
Data element type
Parent data element
Loen

Use data model ordering

Ak

Mo fixed columns

Sorted columns

Sorted Sortable
Identifier ~ & Label
Description
Data element type
Status
Critical data
Personal data category

Reeular Fxnression

Filter

ap

All criteria match

Add a criterion

{ Back Cancel Create

In the next view you can:
« Select columns you want to display.
+ Set columns order.
« Add afilter.
« Set the pagination (number of records per page).

» Enable grid edit and set a toolbar. A toolbar corresponds to a list of available actions on the top
of the table. You can set:

« Light generic toolbar for the table view.
« Generic toolbar for the table view.

Finally, save your new view or select Save and apply to save it and return to the table view with
your new view applied.
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Applying an existing view

To apply an existing view, open the View menu and select the view you want to see.

 wuio- v [~

Views

v Data elements [DataElementDefaultTableView]
Data elements hierachical view [DataElementDefaultHierarchyView]

Edit

55

[Default view]

Views management

5 .
Return to recommended view

ra Manage recommended views
Create a new view

ch
Manage views r

Ao [can datailcl

68.3 Hierarchical views

Creating new hierarchical view

To create a new hierarchical view, follow the steps above to create a tabular view. However, in the
step to select the view mode, select Hierarchical view.

View mode - Simple tabular view
* Hierarchical view

Advanced properties
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Select Next to define the hierarchy’s dimensions and other options. The following image and list
highlight some options:

Dimensior

= # Data elements

D Asset (52 Assets)
@  Consent date
b @ Person (= Persons)

b D Processing activity (= Processing activities)

Display records in a new window * Yes ® No
Prune hierarchy " Yes ® No
Display orphans " * Yes Mo
Display root node - * Yes No
Root node labe = English (United States)

French (France)
Toolbar on top of hierarchy [not defined] -

Advanced properties

+ Display records in a new window: If Yes, a new window will be opened with the record. Otherwise,
it will be displayed in a new page of the same window.

Prune hierarchy: If Yes, hierarchy nodes that have no children and do not belong to the target
table will not be displayed.

Display orphans: If Yes, hierarchy nodes without a parent will be displayed.

Display root node: If No, the root node of the hierarchy will not be displayed in the view.

Root node label: Localized label of the hierarchy root node.
+ Toolbar on top of hierarchy: Allows you to set the toolbar on top of the hierarchy.

+ Display non-matching children: In a recursive case, when a search filter is applied, allows the
display of non-matching children of a matching node during a search.

« Remove recursive root leaves: In a recursive case, when a search filter is applied or if the mode
is pruned, removes from the display the root leaves.

« Detect cycle: Allow cycle detection and display in a recursive case; the oldest node record will
be chosen as the cycle root. Note that this does not work in search or pruned mode.
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Select Next to define how you want to display each node of your hierarchy.

/ © Data elements

Labels English (United States) [ %[./id} - §{./person] - §[./consentDate} ] o

French (France) %(./id} - $[./person] - $[./consentDate} ~

-k

Filter All eriteria match

4k

Add a criterion

Add a logical block Removwe all criteria

In this view you can:
« Switch to node by clicking on the node name.
+ Define label.
« Add a filter.

Finally, select Create to create your view or Create and apply to apply it after creation.
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CHAPTER 69

Advanced data services overview

Advanced data services allow you to connect to the TIBCO® Data Virtualization (TDV) tool to harvest
metadata from the data sources that already exist in your system or to create aggregated views in TDV
using EBX® metadata assets. To use this functionality you must have a TIBCO® Metadata agent
installed and configured on your system and registered.

If you have administrative access, see Installing the TIBCO® Metadata Agent [p 755] for more details.
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cHAPTER 70

Metadata harvesting

This chapter contains the following topics:
1. Overview
Start harvesting service

Harvesting main view

Create a new configuration

Run configuration

Use an existing configuration

Schedule a harvesting

Create data source from instance

Specific Cases

£ LN e WD

70.1 Overview

Metadata harvesting is the process of gathering metadata from a data source that exists in your system
and is supported by TDV and store it as an EBX® Metadata Management application asset.

You can run harvesting for data sources that are already configured in the TDV or for the new sources
defined in the EBX® Metadata Management application.

If you start the Harvesting service from an asset or a selection of assets, please, make sure that all
assets were previously harvested by the Metadata agent.

If you start the Harvesting service from an instance or a selection of instances, you can create a data
source in TDV for any that do not yet exist. See Create data source from instance [p 365] for more
information.

The Harvesting service cannot be run on disabled assets or instances.
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70.2 Start harvesting service

On the asset hierarchical view or instance view, select one or more assets or instances for which you
want to harvest metadata. Select the cloud icon to begin harvesting. The harvesting main view displays.

o B §

¥ ) usda
(%) public

= O al= n More =

70.3 Harvesting main view

The harvesting main view displays your current selection and existing configurations.
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An existing configuration is a harvesting that was already executed for one or several elements related
to your current selection. If no existing configuration is available you will see a main view similar
to the one in the screenshot below:

Existing configurations relating to current selection

Harvesting configurations might already exist for your selection.
A configuration will be proposed here as soon as it shares at least one asset with a selected element.

Your current selection :

= Instances (0) ~

Py Assets (1) v

No existing configuration found for your current selection

If you have an existing configuration, you will see something like the screenshot below:

Existing configurations relating to current selection

Harvesting configurations might already exist for your selection.
A configuration will be proposed here as soon as it shares at least one asset with a selected element.

Your current selection :

= Instances (1) ~

H Assets (0] v

Existing configuration related to your current selection :

Mavie DB 0 0 Created . - . : | = R - T

Close MNew configuration
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From an existing configuration, you can perform the following actions:
 Run
+ Schedule
» Configure
« Duplicate
» Extend with current selection

See Use an existing configuration [p 362] for more information.

70.4 Create a new configuration

From the main view, click on the bottom right New Configuration button. The new configuration
screen displays.

MNew configuration

Options :

O Include data sampling O Force sampling

[0 Automatic classification suggestions [ Force refresh of classification suggestions
[0 Classify assets automatically O Include lineage

O Include profiling

Select item(s) you want to harvest :

U = rows per page

: » public
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In this screen, start by adding a configuration name. This is necessary for displaying more actions.

MNew configuration

My configuration

Options :

D Automatic classification suggestions

Select item(s) you want to harvest :

b public

Back

On the top of this screen, you can see options:

[0 Force sampling
:| Force refresh of classification suggestions
O Include

Save and Run

+ Include data sampling: for the assets eligible for sampling harvesting will retrieve data samples
from the source system, if available. See Asset sampling [p 3691 for more details regarding

supported types.

« Force sampling (activates Include data sampling automatically): force data sampling on your

assets (overwrite existing samples).

+ Automatic classification suggestion: the harvesting will also start the classification of your assets.

+ Force refresh of classification suggestion (activates Automatic classification suggestion): if your
asset already has a classification suggestion, this option will force the harvesting to update it.

» Classify assets automatically (activate Automatic classification suggestion): Apply the
classification suggestion to your asset instead of giving you a list of potential matches.

« Include lineage: if your harvesting contains assets of type TDV Published View, the lineage will
be extracted and stored for them. As lineage can be quite complicated and concern a large number
of resources, it is recommended to activate this option only for scheduled runs, not for immediate

harvesting executions.

« Include profiling: for eligible assets (DB tables, CSV files, Excel worksheets) cardinality statistics
and other profiling information will be included in the harvesting results. As queries for statistics
can be time consuming on large data sources, it is recommended to activate this option only for
scheduled runs, not for immediate harvesting executions.
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In the hierarchical view, you can perform multiple actions:

Select item(s) you want to harvest :

QO 0=0 [

1) This action allows you to unselect all children and keep the
parent node selected. This is only available if the node has
children.

2) Select or unselect the node for harvesting. If the node has

children, this action will also select/unselect all children.

3) Expand more or expand fewer children. Clicking on this
icon will display children if they exist, if not you will see
No data message. If you have connection issues with TDV,
you may see an error here.

- i public

This is not an action but the name of the instance/asset with the logo. The subtitle contains the
following storage information: - New: this is a new instance/asset - Stored: instance/asset is already
in the EBX® Metadata Management application.

Once you give your configuration a name and if at least one element is selected for harvesting, you
will see Save and Save and Run buttons on the bottom:

« Save: Only saves your configuration. After saving it, you can schedule it if needed. See Schedule
a harvesting [p 363] for more information.

+ Save and Run: Save your configuration and run the harvesting. This action will display the Run
screen of the harvesting

Data profiling

Data profiling is available for following asset types:
« DB table and its columns
« CSV file and its columns
» Excel Worksheet and its columns

If one of such assets is present in the scope of your harvesting (as a root asset or as a descendant),
you can activate data profiling for it.
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Please, note that data profiling can take time to be gathered from the physical data source, so we
recommend to only activate this option for scheduled configurations and do not use it with direct
running.

Following information can be retrieved from the data source:
» Completeness rate: shows the part of non-null values in total values.
« Uniqueness rate: shows the part of unique values in total values.
« Most frequent values: lists top 5 values that are most common in this column.
« Minimal value: shows the minimum value in this column.

« Maximal value: shows the maximum value in this column.

9 By <0 Geh=EgE
false false g
numeric 1 0.72
22.00 14.95 215,99
129.99

70.5 Run configuration

If you select Save and Run from the configuration view, you will start the harvesting. First the
application needs to communicate with TDYV, that’s why you will see the progress view.
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After that, the progress table displays.

Gathering harvested metadata

You can see the progression of your job during the harvesting.
At the end, you can preview results before validation.

1ceb1268-4372-456a- fshared/examples/movieDatabase/public w Sreview
97e1-7042dd68sefe h Accept
results

Back Validate and return to main view

This table is auto-updated to display the status of the harvesting. You have multiple available actions:

 Inthe Instances or Assets column, you can select the ... to display the full list of instances/assets.
The list displays in a pop-up. Click outside the popup to close it.

« In the Results column, once the status is Success, you can select Preview to display harvesting
results. If the status is Failed or In progress, this button is not available.

 If results are correct for you, you can check the Accept results checkbox to approve them. This
checkbox is checked by default.

« Select Validate and return to main view to:

+ Accepts results and add them in the asset table if Accept results is checked. You will be
redirect to the main view.

+ Reject results if Accept results is not checked. You will be redirected to the main view.

« Click on the Back button to go back to the main view. From the main view, you will be able to
return to this progress view if your harvesting is not validate yet.

Once you validate results, you will see on the main view that your configuration status is updated.

70.6 Use an existing configuration

From the main harvesting view, if you have existing configurations, the following actions are
available:
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1) Run the configuration. You will see the progress view, then
the progress table.

2) Schedule the configuration.

3) Configure the current configuration. You will see the
configuration screen.

4) Extend the configuration with current selection. The
configuration screen displays and the harvesting scope is
merged with your current selection.

5) Duplicate the current configuration. A copy of this
configuration displays on the configurations list.

©

See the progress table view. This option is only available if the configuration status is Pending for
approval.

Selecting Configure displays the configuration screen. This screen is similar to the one evoked in
the Create a new configuration [p 358] section but the instance/asset hierarchy, configuration name,
configuration options are pre-populated. You will be able to change them and save it.

70.7 Schedule a harvesting

You can schedule one or several executions of an existing harvesting configuration. There are two
ways to do so:

« From the configuration view, after saving the configuration, by selecting Schedule on the bottom.

« From the main view by selecting Calendar.

> o
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Clicking on the button displays a dialog box where you can configure the scheduling.

Please fill the form below to create your scheduled task

— Date
ji/mm/aaaa --:-- m|
Date is empty
Interval Unit
0 Minutes v
Repeat”
0 [] Infinite

To save the scheduling you have to insert the date. Date This field is mandatory Insert the date and time
here. You can use the arrow on the right to display the calendar. Interval between multiple scheduling
if repeat is set. Unit of the interval. By default, it is in minutes but you can change it to hours or days.
Repeat Number of repeats for the scheduling. To repeat this harvesting to infinite, check the Infinite
checkbox.

Example: You want to schedule the harvesting every month. The date is 01/01/current year, interval
28 days and repeat is 12.

If you want to cancel harvesting, you have to be sure that the configuration is already scheduled.
You can see it from the main view, the configuration will have the status Scheduled and the next
execution date.

Existing configuration relates to your current selection :

USDA harvesting 0 78 Scheduled 2020-04-07 12:38:38.313 2020-04-07 13:25:34.052 2020-04-07 20:30
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By selecting the calendar icon near the configuration, the schedule dialog box will display a Remove
schedule button. Click on it to cancel scheduling.

Please fill the form below to create your scheduled task

Date
07/04/2020 20:30

Intery ! t
0] Minutes -

Clase Remowve Schedule m

70.8 Create data source from instance

If you wish to harvest metadata for a data source that is not yet configured in TDV, you can configure
it directly from the EBX® Metadata Management application.

Prerequisites

To do so, first you need to check that all necessary information is provided in the instance’s attributes
and that the instance type is supported for creation by the EBX® Metadata Management application.

Currently, you can create:
« relational data sources;
« file-based data sources, such as Excel, XML, WSDL or CSV;
« SOAP data sources;

« REST data sources (for these data sources, manual creation of the operations is required in TDV
after creating the data source).

A complete list of supported adapters is available in the Administration - Datasource Types table
with attribute Creatable? = Yes.

An instance that you want to use to create a data source in TDV must provide necessary properties
to connect to the physical data source from TDV. Below is the list of mandatory attributes depending
on the type of the data source.

Create and harvest

Start creation of the new harvesting configuration for your instance as described in Create a new
configuration [p 358] section.
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Click to expand children of the instance and the Create datasource button displays.

Select item(s) you want to harvest :

@ = excelForDoc

No datasource configured

Create datasource

Click on it to show the list of available Metadata Agents. Click on the agent that you wish to use for
data source creation to launch the process.

Agent selection

Agent selection

'O' Localhost test agent
tdv host : tabula.orchestranetworks.com

Cancel
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Wait for the process to complete. In case the creation was successful you will see a message Done in
green. Finalize the process by selecting Finish.

Agent selection

Agent selection

& Done

This should reload the harvesting screen and allow you to see the direct children of the instance.

Select item(s) you want to harvest :

: v = excelForDoc

MDM_Customizations_20190729.xlsx
new

TestExcel_empty.xlsx
new

You can now continue with harvesting configuration as described in previous sections.

70.9 Specific Cases
Harvesting REST Resources

The EBX® Metadata Management application supports harvesting of REST resources documented
manually in TDV. This comes with a specific behavior due to the way resources are documented in
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TDV. Indeed, the EBX® Metadata Management application represents REST resources according to
the RESTful architecture which is not the case in TDV.

Here is the way REST Resources are displayed:

= REST Datasource :
= REST Resource :
« REST Operation
+ REST Request
+ Reqguest elements
+ REST Response
+ Response elements

Harvesting configurations on Assets under Operation in the hierarchy are not possible since these
resources are created by the agent and do not exist in TDV.

During the configuration of a harvesting from a REST Datasource, you will see all the operations
registered in TDV, but no REST Resource asset as they are created by the EBX® Metadata
Management application.
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CHAPTER 71

Asset sampling

This chapter contains the following topics:
1. Overview

2. Asset type available for sampling

3. How to request a sample

4. Wrong asset selection for sampling

5. XML Element sampling

71.1 Overview

Asset sampling allows you to request a sample data in a file to see the content of the asset. By default,

the sample contains the 100 top rows from the target source.

From the asset view, you can request a sample file if the asset is available for sampling.

71.2 Asset type available for sampling

You can request a sample on the following asset types:
« DB Table (database table)
« EXCEL worksheet
« CSV file
« TDYV published view
« XML Element (which is marked as object root)

Sampling cannot be run on disabled assets.

Sampling can only be run for the assets that were created using the Metadata harvesting [p 355] service.

71.3 How to request a sample

Start by displaying the asset’s view by selecting Assets in the perspective menu.
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On the hierarchical view, select one or more assets for which you want a sample file. Once it’s done,
select the eye icon on the top to request sample.

o BEn =EEme0 o|le|® More-

v @ imdb

1
il

public

v [ % name_basics

[ % title_akas

I % title_basics

[ % title_crew

B % title_episode
I % title_principals

I % title_ratings

You will see a progress message and a success message when finished.
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You can close the service and go back to your asset to download the sample file. On the asset view,
locate the Sample file field, hover your mouse cursor on the file. A tooltip displays a download button.

name_basics

Disanen

false

Masoarosy

TABLESPACE

@ @

EncrvpTion

]

I 1302?2_nzmc_buicl_5lrrmle_cw|
a
-
Oy CREATOR Caex D& LIPDATE: DATE
Close
You can finally open the file.
180272_name_basics_Sample
birthYear deathYear knownForTities ‘nconst ns soundex primaryName  primaryProfession s soundex sn_soundex

1889 1087 | DOS0419.0072308,0053137,0043044 1 FE323 Fred Astaire soundirack actonmiscelansous AZIB AZ3E
1824 2014 | 0038355,0117057,0071B77,0037382 | 2| Les1z2 Lauren Bacall actress soundirack B24 | B2e85
1834 | rull 'mﬂmmsemwsm . 3. Bé2 .Bﬂgmﬁuﬂm .mmndndim . B3 [ BE3E
1949 1982 | 0077075.0080455,0072562,0078723 | 4| w8142 John Belushi | actorwritersoundtrack |Baz | pazs
1018 2007 | DOS00BE.D050076,0060467, 0083022 5| 15256 Ingmar Bergman writer director. actor BE25. BB252
1915 1982 | 0038787,0077711,0036855,0088109 | 6| 15263 Ingrid Bergman actress soundirack produces BE2S. | Beasz
1866 1857 | D043265,0033870,0034563,0037382 | 7 Hste1 .Hll'npl'lw Bogart .mmdtradi.plm 263 | Bas3s
1624 m'mmmrmmm.mm . B. MiG451 Marion Brando actorsoundirack, director . BES3 [ B6535
1825 1984 | DOSO749.0061184,0087B03,0057877 0| R2631 Richard Burton actor.producer soundirack BB BE3ISE
1659 1986 mwsr.ooesa?o.wzwmssrs' 10| J525 James Cagney actorsoundirack, director c25 -CZ'SZE
1801 1961 | DOZ795E,0044706, 0035896, 0034167 | 11 Gs218 .Guycmpor actorsoundtrack produces ‘s |cisz8
1908 1989 | 0042192,0035140,0056887,0031210 12| B3tz | Betto Davis actress soundirack make_up_department D1z | D123
1822 ms-m1n_mm1r,MM|m' 13| De23 .Dnrbﬂuy soundirack, aciress.producer o | pas2
1016 | rull D031381,0041452,0029843,0040806 14 04131 Olivia de Havilland | actress soundirack il D1453
1831 1955 D04B028 0043228 0049261, 0048545 15 | J5235 James Dean actor,miscellansous D5 D5252
1925 Im'w1mmsrm' ‘IB.GEEM l&ﬂgﬁl}ﬂm composersoundtrack music_department lD-l-S 'm
1801 1asz-ms1|_m51m$,m11nm1 ' 17| Ma4s3  Marlene Dietrich soundirack, actress,music_department | p3e2 | p3625
1916 | rwll 043328 0052 365,00807 360054331 18 | KE232 Hirk Douglas BCHOF, PROCUCER, SOUNATBCK D242 D2a26
1820 1993 | DOSB801,0050783,0053779,0071129 19| F3621 Fedenica Fellini writer.director, assistant_director F45 F4513
1905 1m'mmwnmssl . EOl H5815 'stch\dl .m.mmmmck . F53 [ F5356
187 2013 | 0032676,0039504,0040536,0034248 | 21 8183 [ doan Fontaine [FPP——————— | Fs3s | Fsasz
1801 1960 | D031381.0026752,0025316,0052278 22 | C4621 Clark Gable actor.soundirack produces G4 G1424
1822 1969 | D037059,0055031,0032138,0047522 23| Jaze4 Judy Gartand soundirack, actress rull Ga453
1004 2000 | DOE2031,0117631,0045043 007167 T 24 J5242 John Gielgud actor,writerdirsctor G423 G4232
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71.4 Wrong asset selection for sampling

If you have selected an asset which is not available for sampling, you will get an error message.

Type 'DB Schema’ of asset "public’ is not supported. (Supported types are DB_TABLE, EXCEL_WORKSHEET, CSV_FILE and TDV_PUBLISHED _VIEW)

71.5 XML Element sampling

For XML structures it is possible to obtain a sample in XML format based on an asset of type XML
ELEMENT.

As XML document structure is open and can be analyzed under different angles, you can define for
which object in your XML you wish to sample.

To accomplish this, open the corresponding asset for editing, scroll down to the Object root property
and set it to Yes:

< 0O O o=@

Main Referenced assets References Incoming flows Outgoing flows
AWWTIET [FIL LETIrIeEu
Instance * DemoXml
Data element [not defined]

[No suggestions]

Data element automatically assigned * ® Yes MNo
Classification Ratio 0%
Obiject root @ Yes No

Save the asset to apply changes.

Now you can request sampling for this asset in the harvesting process [p 355].
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CHAPTER 72

Asset classification

This chapter contains the following topics:
1. Overview

2. Manual classification

3. Using classification console

72.1 Overview

You can match assets with data elements. It’s the main feature that explains how a business object is
linked to a technical object.

It’s possible to define this link on your own but it could take time on many assets. The classification
feature helps you to find the match between an asset (technical) and a data element ( business).

72.2 Manual classification

On the asset view, click on the edit icon on the top left corner.

@ <9 a*n

name_basics &

name_basics OB TABLE PUBLIC Eﬁ

IMCB false ]
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Then select the data element in data element list.

Main Incoming flows Qutgoing flows Datasets
Documentation [not defined]
¢ Edit & Upload
Parent asset public - 4
Owner @ [not defined]
Instance * imdb - A
Data element [ [not deﬁnedj| -

[No suggestions]

Data element automatically assigned ® Yes ® No

Is disabled ? * 03 Yes '® No
Mandatory Yes Mo
Comment

You can search by entering the data element name. Do not forget to save your update.

72.3 Using classification console

Instead of searching and selecting the data element by yourself, you can use the Classification
Console to give you some suggestions on the right data element to link to the current asset.
This option is using a predefined algorithm and needs data to get more efficiency.

« From the hierarchical view, select one or more assets that you want to classify then select the
Classify icon:

i
A

(0] & =|h

o B §
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« From a single asset view, select the classify icon:

9 ER <0 oo

A new screen displays and shows the current selected asset and its children if they exist.

Classification Console

b " narme_basics v} Diata element v
primaryhame
primaryPrafession Data clement -
birtHvear Dt element v
deathivear Data element -
nConst Diata slement v
5_sounde

knawnForTithes Diata element -

On this screen you can:

1. Expand or collapse the hierarchy (only available for asset with children).
Click on the asset name to see details.
See asset classification ratio (if asset and its children are classified).
Search and select the data element to link with the asset.

Lock or unlock the data element for automatic classification.

O e

Access extra options like running automatic classification.

On the bottom bar you can:
» Save your current modification.
« Save and close the classification console.
« Revert the current modification.

+ Close the classification console (which will display a confirmation pop-up if you have current
unsaved modifications).

Save Save and close Revert Close

Search and select a data Element
Select the data element box to view:

« Data element suggestion list if one exists.
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« Data element list.

You can search a data element by entering text. You can see data element details by clicking on the

preview icon.
Data element
| -

Data elements

N

Customer

N

Customer identifier

N

Current bills

Employee [
Prototype 4
Employee ID 24
Product ID

i

Data element
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If a data element select box contains suggestions you will see a notification near it. By clicking on the
box, you will see the suggestions and all data element.

Data element

Suggestions

Hazards Data Distribution 99
System (HDDS) Explorer %

Data elements

Customer [/ &
Customer identifier (4
Current bills [ o)

A suggestion displays the matched result in percentage and information about the classification
configuration used.

If you have done modifications, you will see a blue exclamation point on the left side of the data
element select box.

By hovering your mouse over it, you can see current modification details (data element change, asset
locked or unlocked).

Run automatic classification

To access extra options, click on the vertical menu button on the right side of lock option. Select Run
classification. A pop-up displays and allows you to:

 Select the classification configuration.

» Force arefresh of classification suggestions.
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+ Classify assets automatically (this will select the best matching data element for you. If you have
unsaved changes, a warning message will inform you that you may lose modifications if you
don’t save them before processing).

Process classification

Configuration

Default

[] Force refresh of classification suggestions

El Classify assets automatically

Click on process icon to start classification. While the classification is running, you cannot run a new
one on the current asset and its children.

Do not forget to save modifications after leaving the classification console.

Lock an asset

If there is an existing data element linked to an asset, you can lock it by clicking on the lock button
on the right side of the data element select box. A locked asset is ignored if you run the classification
process with the Classify assets automatically option. An unlocked asset without data element can’t
be locked.
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CHAPTER 73

Lineage

This chapter contains the following topics:
1. Overview

2. Display the lineage

3. Browse the lineage

73.1 Overview

You can display the asset or instance lineage. It’s a main feature that explains how an asset or instance
is composed and linked to other assets and instances.

73.2 Display the lineage
From the asset view

You can start the lineage by selecting an asset in the hierarchical view or the table view. You just have
to click on the lineage icon on the top of the view.
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From the hierarchical view:

o B w

€ Allocine

H < O

* @ imdb
- public

> fga name_basics
B % title_akas
v fgg title_basics
b % title_crew
v fgm title_episode
ke % title_principals
v Fga title_ratings

* € The movie database

b € usda

o @

—_ More =
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From the table view:

Assets
© =01 ma<o oen[E] M-
= Label Description Asset type Parent asset
v public DB Schema [7
name_basics DB Table L public [
primaryName DB Column [ name_basics [T
primaryProfession DB Column [ name_basics [T

You can also start the lineage while you are reading the asset view form. Click on the lineage icon
on the top of the asset view form:

public

9 B <0 &=

4L Assets

% DescripTioN
public &

Name ASSET TYPE

public DB SCHEMA
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From the instance view

You can start the lineage by selecting an instance in the hierarchical view or the table view. You just
have to click on the lineage icon on the top of the view.

From the hierarchical view:

Instance hierarchical view

o By m@m<o @alzl Mor-

b ) Db2 z/05
¥ © TIBCO Data Virtualization

@ © TDV (Advanced Data Services)
» €9 Undefined

b @ [ System unset ]

From the table view:

Instances

© e =a<0 oalE] M-
= Label Description E
Salesforce mobile application APM hosted in our corporate Mobile Device Management Sys
Salesforce.com (TEST) Test instance of Salesforce available on the cloud.
E TDV (Advanced Data Services) This instance has been registered automatically when the ager
usda
TestExcel
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You can also start the lineage while you are reading the instance view form. Click on the lineage icon

on the top of the instance view form:

TDV (Advanced Data Services)

9 F <0 a|=
&8 Instances
o DescriPTION

(|
TDV (Advanced

Data Services)

This instance has been registered automatically w

MNanme SvsTEM

TDV TIBCO DATA

73.3 Browse the lineage

Once you have started the lineage service you will see:

« The asset or instance you previously selected: if your selection is an asset, you will see it with

its instance.
« Direct children of the instance or asset.

« Action buttons.
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« The overview toolbox for helping you browsing the lineage graph.

Overview toobox —3>

o= imdb -

Selected asset —== punid - = = ] o Action buttons

y name_basics + =

Asset direct children ~\

N

p title_akas +

y title_basics +
L litle_crew 4+

Ly litle_episode +
g title_principals +

Ly litle_ratings |+

Overview toolbox

The overview toolbox helps you to scroll the lineage graph when this one is big because of multiple
nodes and links. You can drag the overview box to any location in the lineage view.
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Expand/Collapse a node

By clicking on the + button near the node name, you will expand it to display its children. The +
button is only available if children exist.

= imdb =

public [+ 2| | =

= imdh —

i public =] =

name_basics + =
title_akas +
title_basics +
title_crew |+
title_episode +
title_principals +

title_ratings 4+

When a node is expanded, you can collapse it by clicking on the - button near the node name.

Display node links

If a node contains links to display, you will see the link icon near the node name (icon with two arrows).
By clicking on this button, you will display:

» node incoming links

+ node outgoing links
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If all links of the node are displayed, the link icon is highlighted.

om = TDV -
= ds_bikestores - = imdb -

I, imdb =

| sales '+ =/ [©|@——H0o0 8 ——> | public = = :.:.—-\.—.
" public + 2 =

fiy name_basics + = =

[, title_akas |+ \

Incoming £, title_basics + Outgoing
[y title_crew |+
[y title_episode +

[y title_principals +

[y title_ratings +

If the lineage is too complex with lot of links, you can click on a node to highlight its links.

- = TOV -
&= ds_bikestores - = imdb -

\ ) - ] L imdb =
! sales +| = (% @——ousr——F ¢ public = = (& .__\—,_ :

= " o public + = ©
‘ name_basics + = =

Cy title_akas +

"y title_basics +
/ o title_crew +

Current selected % tile_episode '+

node L
'y title_principals +

"y title_ratings +

Click anywhere else on the lineage graph to remove link highlighting.
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Display full lineage for a node

The first lineage view helps you to browse the lineage step by step (by clicking manually on each link
button). This graph is called: Browsable lineage If you want to display the full lineage of the selected
node, click on the focus icon near the node. This button is only available if the node contains links.

&= Imdb -

| public = =] =

"= hame_basics + =

- - title_akas +
title_basics +
title_crew +

. title_episode +

. title_principals +

o title_ratings +

TIBCO EBX® Product Documentation 6.2.0 387



Documentation > User Guide > EBX® Metadata Management > Advanced data services > Lineage

By clicking on this icon, a new lineage graph view will be displayed. This graph is called: Asset
lineage This view contains the currently selected node and its children. It also displays all links for
the node, children nodes, and other nodes recursively.

" ds_bikestores >sales - —

T———» ¢ imdb>public — » " TDV > public -
» customers
. name_basics » [y name_basics
» order_items
litle_akas 'y litle_akas
, orders
title_basics ., title_basics
. staffs
o title_crew g litle_crew
. stores
., litle_episode ', fitle_episode
, title_principals 'y fitle_principals
title_ratings . title_ratings

The node from where you have clicked on the focus icon is displayed with a purple background.

In this graph, every node head title contains the instance name. The template is Instance Name >
Node name.

Click on a node to highlight links if they exist.

° ds_bikestores > sales — \
-__-—‘“——a» * imdb > public - » " TDV > public =
customers
|y name_basics » |y name_basics
» order_items
\p f